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Preface
Introduction

Desktop Administrator is a “container” program. This program allows you to access 
various other applications used to administer Cisco Agent Desktop, Cisco Agent 
Desktop—Browser Edition, Cisco Supervisor Desktop, and Cisco IP Phone Agent from 
within one interface. 

NOTE:  Desktop Administrator is not supported if installed on a virtual 
private network (VPN) desktop.

What’s New in This Release

Cisco Desktop Administrator 7.5 includes the following new features:

■ Integration of Cisco Unified Presence

■ Administration of integrated Unified Presence features through a new 
browser-based interface named Cisco Desktop Presence Administrator

■ Additional localization in French Canadian and Norwegian

■ Support for automated updates with Windows Vista

■ Enhanced accessibility through shortcut keys

Desktop Administrator Feature Levels

There are three feature levels of Cisco Desktop Administrator: Standard, Enhanced, 
and Premium.
11
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The following table lists the features that are available in each feature level of Desktop 
Administrator. Features that are not listed here are in all three feature levels.

Related CAD Documentation

The following documents contain additional information about CAD 7.5:

■ Cisco CAD Installation Guide

■ Cisco Agent Desktop User Guide

■ Cisco Agent Desktop—Browser Edition User Guide

■ Cisco Supervisor Desktop User Guide

■ Cisco IP Phone Agent User Guide

■ Mobile Agent Guide for Cisco Unified CC Enterprise

■ Cisco CAD Service Information

■ Integrating CAD with Citrix Presentation Server or Microsoft Terminal Services

Intended Audience

This document is written for contact center administrators who use Desktop 
Administrator.

Table 1. Desktop Administrator features 

Feature Standard Enhanced Premium

Cisco Unified Presence integration ● ● ●

Configuration of Agent Desktop integrated 
browser

●

Configuration of Agent Desktop, IP Phone Agent, 
and CAD-BE interfaces

● ●

Configuration of CAD-BE integrated browser ● ●

Configuration of work flows ● ●

HTTP Get work flow action for CAD-BE ● ●

HTTP Post and Get work flow actions for 
Agent Desktop

●

IPC Receive action event ●

Time of day event and data condition ●

Timer action ● ●
12 January 16, 2013



January 16, 2013
1
Getting Started
Introduction

Desktop Administrator comes with 4 licenses, one for each node in the navigation 
tree. There can be only one user at a time working in each node. If someone is using a 
node that you must access, an error message appears that identifies the IP address of 
the computer accessing that particular node. 

NOTE:  If the Cisco Licensing and Resource Manager (LRM) Service is 
down, the error message will only tell you that another user is using 
the node. The IP address will not be available.

For this reason, it is important that you close Desktop Administrator completely when 
you are done using it. As long as the application is running, a license is being used and 
others are blocked from accessing the node selected in your instance of the 
application.
13
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Starting Desktop Administrator

To start Desktop Administrator:

1. Click Start > Programs > Cisco > Desktop > Admin. Desktop Administrator 
starts.

2. Click the Call Center 1 node to expand the navigation tree. By default, 
Desktop Administrator is not password-protected and the tree will expand. If a 
password is configured, Desktop Administrator will prompt you for it now.

For more information about passwords, see "Configuring Passwords" on 
page 19.
14 January 16, 2013



Automated Updates

January 16, 2013 15

Automated Updates

CAD can be configured during installation so that every time you start Desktop 
Administrator, the software checks to see if there is an updated version available. If 
there is, the software automatically runs the update process. 

When the update process runs, a dialog box appears, stating that your copy of 
Desktop Administrator will be updated. Click OK and then follow the instructions in the 
series of dialog boxes that follows. After the update finishes, a final dialog box 
appears, stating that your update is complete. Click OK, and restart Desktop 
Administrator.

NOTE:  To ensure that automated updates function correctly, you 
must configure Internet Explorer so that it checks for newer versions 
of stored pages. To configure this setting, launch Internet Explorer 
and choose Tools > Internet Options. In the Browsing history section 
on the General tab, click Settings. Select the option labeled Every 
time I visit the webpage.
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The Desktop Administrator Interface

The Desktop Administrator interface has two panes. The left pane is a navigation tree 
similar to that found in Windows Explorer. The right pane displays the application that 
you choose in the left pane. Figure 1 shows the Desktop Administrator interface with 
the Dial Strings node selected in the left pane and the corresponding information 
displayed in the right pane.

The root of the navigation tree is Locations. Underneath Locations is the logical 
contact center set up in your system. Underneath the logical contact center are the 
applications that administer Agent Desktop, CAD-BE, and IP Phone Agent.

Toolbars and Menu Bars

When you select a node on the navigation tree, the Desktop Administrator menu bar 
and toolbar change to reflect the functionality of that node. 

Figure 1. Desktop Administrator interface
16 January 16, 2013



The Desktop Administrator Interface
The toolbar buttons you see are among those listed in Table 2. 

Navigation Tree Pane

Use the following mouse actions to navigate the left pane.

■ Double-click an icon/application name to expand or collapse the tree.

■ Click the plus sign (+) to expand the tree.

■ Click the minus sign (–) to collapse the tree.

■ Right-click to delete a node (not available for all nodes).

Use the following keyboard actions to navigate the left pane. With a node selected:

■ Press the up and down arrow keys to move from one node to the next.

■ Press the left arrow key to collapse the tree.

■ Press the right arrow key to expand the tree.

Display Pane Navigation

The applications displayed in the right pane are designed to use shortcut keys and the 
tab key as alternatives to using the mouse to navigate around a window. The shortcut 
keys that apply to a specific node are discussed in the section devoted to that node’s 
functions.

Table 2. Desktop Administrator toolbar buttons.

Icon Name Description

About Display copyright and version information.

Delete Remove the selected work flow group.

Remove VoIP,
Recording/
Playback
Services

Remove unneeded services from Directory Services.

Help Access Help files.

New Add a new work flow group.

Properties Display the URL of the selected subnode under the 
Unified CCE Configuration node.

Web Open a browser window and access the Cisco website.
January 16, 2013 17
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User Privileges in Microsoft Windows

Because Desktop Administrator users must be able to update registry settings, they 
must have Administrator or Power User privileges on Microsoft Windows XP 
Professional and Microsoft Windows Vista platforms. 

Only a person with Administrator privileges can change the user privileges on the 
Administrator PC if it is necessary to upgrade those user privileges.



Configuring Passwords
Configuring Passwords

You can use a password to protect both Desktop Administrator and Desktop Presence 
Administrator. If you set a password in either application, that password applies to 
both applications. By default, no password is required for either application.

If you do not want Desktop Administrator to be password-protected, you must not set 
up a password in Desktop Presence Administrator. If you do change the Desktop 
Presence Administrator password, you are automatically adding password protection 
to Desktop Administrator using the new password.

Configuring a Password in Desktop Administrator

A password is optional for Desktop Administrator. If a password is configured, when 
you select the logical contact center node you will be prompted to provide the 
password before you can access any of the subnodes. 

NOTE:  Any password you set in Desktop Administrator is also the 
password for Desktop Presence Administrator.

To set up password protection for Desktop Administrator:

1. In the navigation pane, select the Call Center 1 node.

2. Choose Setup > Change Password. The Administrator Password dialog box 
appears (Figure 2).

Figure 2. Administrator Password dialog box
January 16, 2013 19
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3. Leave the Old password field blank. Type a password in the New password 
and Confirm new password fields, then click OK. Desktop Administrator is now 
password protected. You must restart the application to make the change go 
into effect.

NOTE:  Passwords are case sensitive and must consist of 1 to 32 
alphanumeric characters. 

To change your password for Desktop Administrator:

1. In the left pane, select the Call Center 1 node.

2. Choose Setup > Change Password. The Change Password dialog box appears 
(Figure 2).

3. Type your current password in the Old password field. Type a new password in 
the New password and Confirm new password fields, then click OK. Your 
Desktop Administrator password is now changed. You must restart the 
application for the change to go into effect.

To remove password protection from Desktop Administrator:
When you remove password protection from Desktop Administrator, you automatically 
remove password protection from Desktop Presence Administrator as well.

1. In the left pane, select the Call Center 1 node.

2. Choose Setup > Change Password. The Change Password dialog box appears 
(Figure 2).

3. Type your current password in the Old password field. Leave the New 
password and Confirm password fields blank, then click OK.

4. You are asked to confirm that you want to leave Desktop Administrator 
unprotected. Click Yes. The Desktop Administrator password is removed. You 
must restart the application for the change to go into effect.

Client Applications

User IDs, login names, and passwords are administered in Unified ICM for the 
following applications:

■ Agent Desktop

■ CAD-BE

■ IP Phone Agent

■ Supervisor Desktop

A user’s password is verified on the CTI server when the user starts an application.
20 January 16, 2013
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Agent Desktop, CAD-BE, and IP Phone Agent User ID, Login Name, and Password

Agent Desktop, CAD-BE, and IP Phone Agent user IDs, login names, and passwords 
are set up in Unified ICM and can be administered only through Unified ICM. Use 
Unified ICM to change a user’s Agent Desktop password if necessary.

Supervisor Desktop User ID, Login Name, and Password

A user’s Supervisor Desktop user ID and login name are the same as the user’s Agent 
Desktop user ID and login name, and are set up in Unified ICM. 

The first time Supervisor Desktop is started, the password is blank. It is up to the 
supervisor to create a password using the Change Password functionality within 
Supervisor Desktop. 

The Supervisor Desktop password can be changed from within Supervisor Desktop or 
from the Personnel node in Desktop Administrator (for more information, see 
“Supervisors” in the Cisco CAD Installation Guide.
January 16, 2013 21
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CAD Configuration Setup Utility

Use the CAD Configuration Setup utility to configure the CAD services. CAD 
Configuration Setup consists of a series of data entry windows. You must complete all 
of the windows in the utility to install and run CAD services successfully.

CAD Configuration Setup has two modes: initial mode and update mode. The utility is 
launched automatically in initial mode after the CAD service installation finishes. You 
can run the utility again later in update mode to change your configuration settings. To 
run the utility in update mode, use one of the following methods:

■ In Desktop Administrator, choose Setup > Configure Systems.

■ On any CAD computer, run postinstall.exe, located in the folder 
C:\Program Files\Cisco\Desktop\bin.

The windows that appear when you run this utility depend on the following factors:

■ The host computer on which you launched CAD Configuration Setup

■ The mode in which CAD Configuration Setup is running

■ The services and applications that are running on the computer on which you 
launched CAD Configuration Setup

Table 3 lists all of the windows that are part of CAD Configuration Setup in 
alphabetical order. For each window, the table indicates whether that window appears 
when CAD Configuration Setup is run on the computer that hosts the named 
application or service. If you need to change a configuration setting, use the table to 
determine the computer on which you must run CAD Configuration Setup. 

The table has the following columns:

■ Window title: The name of the window

■ Mode: The mode in which the window appears (Update or Both initial/update)

■ Base: The computer on which the CAD base services run

■ VoIP: The computer on which the VoIP Monitor service runs

■ Rec: The computer on which the Recording and Statistics service runs

■ CAD/CSD: The computer on which Agent Desktop and Supervisor Desktop run

■ CDA: The computer on which Desktop Administrator runs

Table 3. CAD Configuration Setup windows

Window Title Mode Base VoIP Rec
CAD
CSD CDA

CAD-BE Servers (page 29) Update ×

Unified Communications Manager (page 31) Both × × ×
January 16, 2013 23
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Unified CM SOAP AXL Access (page 33) Both × × ×

CTI OS (page 34) Both × ×

CTI OS Security Setup (page 35) Both ×

CTI Server (Unified CM) (page 36) Both × ×

ICM Admin Workstation Database (page 38) Both ×

ICM Admin Workstation Distributor (page 40) Both ×

Recording and Statistics Service Database (page 42) Both ×

Replication Setup (page 45) Both ×

Restore Backup Data (page 46) Both ×

Services Configuration (page 47) Update × × ×

SNMP Configuration (page 50) Update × × ×

Terminal Services (page 51) Both ×

VoIP Monitor Service (page 52) Update × × ×

Table 3. CAD Configuration Setup windows

Window Title Mode Base VoIP Rec
CAD
CSD CDA
24 January 16, 2013
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Entering Configuration Data in Initial Mode 

After the desktop services are installed, CAD Configuration Setup starts automatically 
and displays the CAD Directory Services dialog box.

You can set up Directory Services replication between two installations of the base 
services, which includes Directory Services. To do this, you install the base services on 
the primary server and complete the CAD Configuration Setup windows, then do the 
same on the secondary server, at that time identifying the computer that hosts the 
primary Directory Services. 

If your system does not include Directory Services replication, follow the procedure for 
entering configuration data on the primary base services computer only.

NOTE:  Directory Services replication can be set up at a later time by 
running CAD Configuration Setup in update mode on the secondary 
base services computer and entering information in the Replication 
Setup window.

Configuring a Single or Primary Server in a Replicated System

Complete the following procedure if you are running CAD Configuration Setup in initial 
mode on a single server system or on the primary server in a replicated system.

To enter configuration data in initial mode on the primary base services computer:

1. Configuration Setup starts automatically and displays the CAD Directory 
Services dialog box (Figure 3).

2. Enter the IP address of the primary Directory Services and then click OK. 

Figure 3. CAD Directory Services dialog box
January 16, 2013 25
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3. If Configuration Setup does not detect that it is installed in a Unified System 
Contact Center (Unified SCC) Environment, a dialog box appears, prompting 
you to indicate whether this is a Unified SCC installation. 

■ If you answer Yes, then default peripheral IDs are set to 1000, and agents 
and supervisor login by name becomes the only login option (login by 
login ID is disabled).

■ If you answer No, then peripheral IDs are set to 5000 and agents and 
supervisors can log in by login name or login ID. This option is configured 
later in Desktop Administrator.

The Configuration Setup tool appears, with the Unified Communications 
Manager node selected.

4. Complete the fields in each window, using the right arrow on the toolbar to 
move forward to the next window. 

■ You cannot move forward until all required information is entered. 

■ You cannot skip a window.

■ You can go backwards at any time to revisit a previous window. 

■ The Save button is not enabled until all windows are completed.

5. When you have completed all windows in the tool, click Save on the toolbar or 
choose File > Save.

When the data is successfully saved, the program ends automatically. 

NOTE:  The save process can take several minutes.

Configuring a Secondary Server in a Replicated System

Complete the following procedure if you are running CAD Configuration Setup in initial 
mode on the secondary server in a replicated system.

To enter configuration data in initial mode on the secondary base services computer:

1. Configuration Setup starts automatically and displays the CAD Directory 
Services dialog box (Figure 3). 

2. Enter the IP address of the primary Directory Services and then click OK. A 
dialog box appears, asking you if you want to set up Directory Services 
replication.
26 January 16, 2013
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3. Click Yes. The Secondary Directory Services dialog box appears (Figure 4).

4. Enter the IP address of the secondary Directory Services, and then click OK. A 
confirmation dialog box appears, prompting you to indicate whether the 
primary and secondary IP addresses are correct.

5. Click Yes to set up replication. When replication is done, CAD Configuration 
Setup launches, with the Unified CM node selected.

6. Complete the fields in each window, using the right arrow on the toolbar to 
move forward to the next window. 

■ You cannot move forward until all required information is entered. 

■ You cannot skip a window.

■ You can go backwards at any time to revisit a previous window. 

■ The Save button is not enabled until all windows are completed.

7. When you have completed all windows in the tool, click Save on the toolbar or 
choose File > Save. When the data is successfully saved, the program ends 
automatically.

NOTE:  The save process might take several minutes.

Figure 4. Secondary Directory Services dialog box
January 16, 2013 27
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Entering Configuration Data in Update Mode 

To modify CAD configuration settings:

1. Start CAD Configuration Setup. CAD Configuration Setup starts and displays 
the CAD Directory Services dialog box.

■ In Desktop Administrator, select the logical contact center node in the left 
pane and then choose Setup > Configure Systems from the menu bar.

■ On another CAD host computer, navigate to the folder 
…\Program Files\Cisco\Desktop\bin and double-click postinstall.exe.

2. Verify that the primary (and optional secondary) IP addresses for Directory 
Services are correct, then click OK. CAD Configuration Setup launches with 
the Unified CM node selected.

NOTE:  To switch between the left and right pane, press F6. To move 
up and down the left pane, use the up and down arrows.

3. Select the node you want to modify from the left pane, enter the new data in 
the right pane, then click Apply.

■ You can display the nodes in any order you wish.

■ If you modify something in a node, you must click Apply to save your 
changes before you move on to another node.

4. When you are done making your changes, choose File > Exit or click Close. 
CAD Configuration Setup closes.

5. Restart the CAD services and all desktops for the change to go into effect.

Figure 5. CAD Directory Services dialog box
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CAD Configuration Setup Windows

This section describes the CAD Configuration Setup windows in alphabetical order.

CAD-BE Servers

The CAD-BE Servers window only appears in update mode.

In the Primary Location field, type the hostname or IP address of the CAD base 
services server. Tomcat, which is required to run CAD-BE, is installed on this server.

If some of your agents are outside your firewall, use the external hostname/IP address 
that maps to the servers. If all of your agents are inside your firewall, use the internal 
hostname/IP address. 

Figure 6. CAD-BE Servers
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If your configuration includes a second server hosting the CAD base services, and you 
have configured replication between the two servers, type the location of the second 
server in the Secondary Location field.

NOTE:  If you established replication in initial mode, the Secondary 
Location field is filled automatically.

NOTE:  The Secondary Location is not enabled until you configure the 
second CAD base services server and establish replication.
30 January 16, 2013
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Unified Communications Manager

The Unified Communications Manager window has two sections: the Publisher section 
and the Subscriber section. If you have only one Unified CM server, complete the 
Publisher section and leave the Subscriber section blank. If you have a Unified CM 
cluster, which consists of one publisher Unified CM server and one or more subscriber 
Unified CM servers, complete both sections.

To complete the Publisher section, select Hostname or IP Address. Then type the 
location of the Unified CM server (the publisher Unified CM server if you have a 
Unified CM cluster). 

If you have a Unified CM cluster, add the locations of all of the subscriber Unified CM 
servers in the Subscribers section. To add a subscriber location, click Add. The 
Add/Edit Host dialog box appears. Enter the location of the subscriber Unified CM 
server in one of the following ways, then click Apply.

Figure 7. Unified Communications Manager
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■ Select Hostname, then type the hostname of the subscriber Unified CM 
server.

■ Select Hostname, then choose the hostname of the subscriber Unified CM 
server from the drop-down list.

■ Select IP Address, then type the IP address of the subscriber Unified CM 
server.

NOTE:  If you change these settings after initial setup, you must 
restart the Sync service and the VoIP Monitor service to ensure that 
the change is registered with them properly.
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Unified CM SOAP AXL Access

Enter the login ID and password required for the Publisher Unified CM Administration 
to access Unified CM SOAP AXL (Simple Object Access Protocol Administrative XML 
Layer). The login ID and password are the same used to access the Publisher Unified 
CM. Select the Unified CM version from the drop-down list.

NOTE:  If you change these settings after initial setup, you must 
restart the Sync service and the VoIP Monitor service to ensure that 
the change is registered with them properly. 

Figure 8. Unified CM SOAP AXL Access
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CTI OS

Enter the hostname or IP address and port number of the CTI OS (Computer Telephony 
Integration Object Server).

■ If you have only one CTI OS, enter the information in the CTI OS A section.

■ If you are also using a redundant CTI OS in a duplexed environment, enter the 
location of the redundant CTI OS in the CTI OS B section.

If you are running CAD Configuration Setup in upgrade mode, the following question 
appears: “Is the CTI OS Security Setting Enabled.” Select Yes or No. If you choose Yes, 
ensure that CTI OS security is enabled on the CTI OS server. Then follow the 
procedures in “Setting Up CTI OS Security”in the Cisco CAD Installation Guide.

NOTE:  If you are running CAD Configuration Setup in initial mode 
(immediately after installation), the question does not appear.

Figure 9. CTI OS
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CTI OS Security Setup

Click Launch to start the CTI OS Security Setup installation program and install the 
CTI OS Security client on the PC.

This window appears only if CTI OS Security is enabled for your system. For more 
information, see "Setting Up CTI OS Security" in the Cisco CAD Installation Guide.

Figure 10. CTI OS Security Setup
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CTI Server (Unified CM)

Enter the hostname or IP address, port number, and peripheral ID of the Unified ICM 
CTI Server associated with the Unified CM or Unified CM cluster.

■ If the CTI Server is entered with a hostname in Unified ICM, enter a hostname. 
If it is entered as an IP address, enter an IP address. Mixing hostname and IP 
address between Unified ICM and Configuration Setup can result in failing to 
display enterprise data in desktop applications.

■ If you have only one Unified ICM CTI server, enter the information in the Side A 
section.

■ If you are also using a redundant Unified ICM CTI server in a duplexed 
environment, enter the location of the redundant Unified ICM CTI server in the 
Side B section.

Figure 11. CTI Server (Unified CM)
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■ The peripheral ID is used by services to filter information such as agents and 
skills. You can find the peripheral ID by using PG Explorer in the Unified ICM 
Configuration Manager.

NOTE:  If you change the peripheral ID, you must restart the Sync 
service, the Enterprise service, and the BIPPA service to ensure that 
the change is registered with them properly.

NOTE:  If you are running Unified SCC and change the Peripheral ID, 
your system will not work.
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ICM Admin Workstation Database

The ICM Admin Workstation database locations are autofilled based on what you 
entered in the ICM Admin Workstation Distributor window. 

Select the database type, SQL or NT, then type the instance name and a user 
login ID/password. The user must have read privileges for the ICM Admin Workstation 
database.

■ If you select NT, the user must also have an account on the ICM Admin 
Workstation computer. Use the format <domain>\<username> or 
.\<username> for the login ID.

Select the connection type, TCP/IP or Named Pipes.

■ If TCP/IP, type the port number used to connect to the database.

■ If Named Pipes, type the share path in the format \\<path> in the Port field.

Figure 12. ICM Admin Workstation Database
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NOTE:  If you change these settings after initial setup, you must 
restart each Recording and Statistics service and the Sync service to 
ensure that the change is registered with them properly.
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ICM Admin Workstation Distributor

Type the hostname or IP address of the ICM Admin Workstation (AW) Distributor. 

■ If you have only one ICM AW Distributor, complete the Primary section only.

■ If you are using a secondary ICM AW Distributor, type its location in the 
Secondary section.

NOTE:  If you change either location after initial setup, you must 
restart each Recording and Statistics service and the Sync service to 
ensure that the change is registered with them properly. 

The Dynamic Reskilling and Cisco Unified System Contact Center Environment 
sections appear only if you are running CAD Configuration Setup in update mode. 

Figure 13. ICM Admin Workstation Distributor
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In the Dynamic Reskilling section, select the Enabled check box to enable supervisors 
to dynamically re-skill agents on their teams using the Unified Contact Center 
Enterprise Web Administration Agent Re-skilling tool. This tool is a web-based 
application. If it is located on a secured server and requires a secure socket URL 
(https), select the Secured client connection check box. If you leave this box 
unchecked, the URL will use the http prefix.

In the Cisco Unified System Contact Center Environment section, select Yes or No to 
indicate whether or not your configuration is running in a Unified System Contact 
Center (SCC) environment.

NOTE:  If CAD Configuration Setup does not detect that it is installed 
in a Unified SCC environment, a dialog box appears in initial mode, 
prompting you to indicate whether it is a Unified SCC environment.
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Recording and Statistics Service Database

This window appears in both initial and update modes. If you are running CAD 
Configuration Setup on the secondary server in a replicated system, this window does 
not appear, because the information was already entered on the primary system.

NOTE:  If you change these settings after initial setup, you must 
restart each Recording and Statistics service to ensure that the 
change is registered with them properly.

Select a method to set up the Recording and Statistics service database.

■ Select Blank Database (default) if installing one service or a primary service 
in a replicated environment. This option creates the database schema.

Select Restore From if you are restoring a previously backed-up database. If 
you are running CAD in a replicated environment, a message appears, 
reminding you to shut down replication before restoring data. After dismissing 
the dialog box, click Browse to navigate to the backup database created with 
the BackupDB and CDBRTool utilities. When you go to the next window, a 
message appears, reminding you to re-establish replication after the restore. 
For more information, see "Backup and Restore (BARS)" in the Cisco CAD 
Installation Guide.

Figure 14. Recording and Statistics Service Database
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NOTE:  You can restore recording metadata without restoring audio 
files, but you cannot restore audio files without recording metadata. 
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Replication Setup

This window appears only when you run CAD Configuration Setup in update mode on 
the secondary CAD services server.

Use this window to add a secondary Directory Services, a secondary Recording and 
Statistics service, or both, after initial system setup. The primary service then 
replicates data on the secondary service so that they contain identical information.

NOTE:  If you are setting up replication for Directory Services and/or 
the Recording and Statistics service, stop CSA on both computers.

To set up Directory Services replication, select On for Directory Services Replication, 
type the primary and secondary server IP addresses in the fields, then click Apply.

To set up Recording and Statistics replication, select On for Recording and Statistics 
Replication, type the primary and secondary server IP addresses in the fields, then 
click Apply. A dialog box appears, prompting you to type the primary server hostname 
for Recording and Statistics replication. Type the hostname, then click OK. Another 
dialog box appears, prompting you to type the secondary server hostname for 
Recording and Statistics replication. Type the hostname, then click OK.

Figure 15. Replication Setup
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Restore Backup Data

This window appears only when CAD Configuration Setup is run for the first time 
during CAD services installation. 

If you want to restore data that was saved from a previous version of CAD, click Yes. A 
dialog box appears, reminding you to shut down replication before you start restoring 
backup data. 

NOTE:  If you do not shut down replication before restoring your data, 
your database can become corrupted.

Click OK and then enter the path to the backup folder. When you move to the next 
window or click Apply, a dialog box appears, reminding you to re-establish replication 
after you exit CAD Configuration Setup.

The tool used to save data is the CDBRTool utility. For information about using these 
tools, see “Upgrading From a Previous Version” in the Cisco CAD Installation Guide.

Figure 16. Restore Backup Data
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Services Configuration

The Services Configuration window only appears during update mode.

If the computer has more than one IP address, select the IP address of the NIC used 
to connect to the LAN—it must be accessible by the client desktops.

To enable CAD automated updates, select Yes. Automated updates cause Agent 
Desktop, Supervisor Desktop, and Desktop Administrator to look for newer versions 
every time they start. If one is found, the update process is run automatically.

To connect to Unified CM, the BIPPA service must have identical user IDs and 
passwords configured in this window and in Unified CM. You can complete the fields in 
this window before configuring the user in Unified CM. To set up the user ID and 
password, see "Creating a Unified CM User" in the Cisco CAD Installation Guide.

Figure 17. Services Configuration
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NOTE:  If you change any of these settings, you must restart all CAD 
services to ensure that the change is registered with them properly.
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SNMP Configuration

The SNMP Configuration window appears only during the update mode if the 
Microsoft Simple Network Management Protocol (SNMP) service is installed on the 
CAD services server. 

If you select the Enable SNMP Trap Generation check box, INFO and higher error 
messages are sent from the CAD services server to the IP addresses configured in the 
Destination pane. Use the Add, Edit, and Remove buttons to manage the list of 
destination IP addresses.

To install the SNMP service, open the Add or Remove Programs control panel, then 
click Add or Remove Windows Components. Select Management and Monitoring Tools 
from the list of components, then select Simple Network Management Protocol.

SNMP allows you to monitor and manage a network from a single workstation or 
several workstations, called SNMP managers. SNMP is actually a family of 
specifications that provide a means for collecting network management data from the 
devices residing in a network. It also provides a method for those devices to report any 
problems they are experiencing to the management station. For more information on 
using this tool, see Microsoft SNMP documentation.

Figure 18. SNMP Configuration
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Terminal Services

If this installation of CAD is installed in a Microsoft Terminal Services or Citrix 
environment, click Yes. If not, click No.

NOTE:  You must be running CAD Configuration Setup on the PC 
where the Citrix or Microsoft Terminal Services service is hosted in 
order to view this window.

Figure 19. Terminal Services
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VoIP Monitor Service

The VoIP Monitor service window only appears during update mode.

Select the IP address of the network adaptor to which voice packets are sent to be 
sniffed by the VoIP Monitor service (if this is a server box) or the desktop monitor (if 
this is a client desktop). 

■ On a VoIP Monitor service server, it is the IP address of the NIC that is 
connected to the port configured for SPAN. 

■ On a client desktop computer, it is the IP address of the NIC on which the 
computer is daisy-chained to the phone.

NOTE:  If you change these settings after initial setup, you must 
restart the VoIP Monitor service or the client application (depending 
on where you run Configuration Setup) to ensure that the change is 
registered with them properly.

Figure 20. VoIP Monitor Service
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Synchronizing Directory Services

The Directory Services database should be synchronized with the master Unified ICM 
agent database. You can synchronize the agent database between Unified ICM and 
Directory Services with the Synchronize Directory Services command.

By default, the database is synchronized once every 10 minutes. You can change the 
synchronization interval by changing a setting in the DirAccessSynSvr.cfg file or you 
can synchronize the databases manually.

To synchronize the databases manually:

1. In the left pane, select the logical contact center node.

2. Choose Setup > Synchronize Directory Services. When the synchronization is 
complete, a message appears, stating that the synchronization was 
successful.
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Enterprise Configuration
Introduction

Enterprise Configuration enables you to:

■ Set up and modify enterprise data layouts and fields

■ Assign phones to be monitored by a particular Cisco VoIP (Voice over IP) 
Monitor Service

■ Configure devices for desktop monitoring

To use either Enterprise Configuration application, select the Enterprise Data node or 
the VoIP Monitor node in the left navigation pane of Desktop Administrator.
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Enterprise Data

Enterprise data is information that is associated with an incoming call. It is displayed 
in Agent Desktop, CAD-BE, and IP Phone Agent (Figure 21).

Use the Enterprise Data window in Desktop Administrator to specify the information 
that is displayed and how it appears in the agent applications.

NOTE:  The agent applications must be restarted for any enterprise 
data variable or layout changes that you make to go into effect.

Figure 21. Enterprise data: Agent Desktop (top left), CAD-BE (top right), IP Phone Agent (below)
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When you select Enterprise Data in the navigation pane, the display pane displays the 
Field List and Layout List (Figure 22).

Fields

The Field List displays both the predefined fields in Unified ICM and the custom fields 
you create using the Field Editor.

■ Predefined fields have index numbers of 159–255, and cannot be edited.

■ Custom fields have index numbers of 0–158, and can be edited.

■ Fields marked with an asterisk (*) are expanded call context (ECC) variables. 

Figure 22. Enterprise Data window
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To add a custom field to the Field List:

1. In the Field List area, click Add. The Field Editor dialog box appears 
(Figure 23).

2. Choose a field index number from the drop-down list. The field automatically 
shows the next available number.

3. Enter a field name that describes the contents of the field. 

The field name and field value can contain only the following characters:

■ Alphanumeric characters: Aa–Zz, 0–9

■ Underscore: _

■ Period: . 

If you use disallowed characters in the field name or field value, they might 
not display in the IP Phone Agent service.

NOTE:  For Chinese, Japanese, and Korean localized sites, IP Phone 
Agent phones display the field index number, not the field name. This 
is due to phone limitations on displaying multi-byte characters. 

If the field is an ECC variable, the field name must exactly mirror how the field 
is expressed in Unified ICM, but without the “user” prefix. For instance, the 
Unified ICM ECC variable user.Account.Number must be named 
.Account.Number in the custom field list.

NOTE:  ECC variable names cannot be localized with multi-byte 
characters due to a limitation in Unified ICM. 

Figure 23. Field Editor dialog box
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4. If the field is an ECC variable, select the appropriate check box—Scalar or 
Array.

■ A scalar ECC variable is one that stores a single piece of data.

■ An array ECC variable is one that stores multiple pieces of data.

5. If you select Array, specify the number of elements in the array in the number 
field on the right. Entering a number in the number field disables the Field 
Index field. The system automatically assigns the next available indexes to 
each element in the array.

6. Click OK. The Field Editor dialog box closes.

7. In the Enterprise Data window, click Apply to save your changes.

To edit an existing custom field:

1. In the field list, select the field you want to edit, and then click Edit. The Field 
Editor dialog box appears.

2. Make your changes, and then click OK. The Field Editor dialog box closes.

3. In the Enterprise Data window, click Apply to save your changes.

To delete a custom field:

1. In the field list, select the field you want to delete, and then click Delete. You 
can delete only custom fields.

2. In the Enterprise Data window, click Apply to save your changes.

Layouts

The Layout List displays the field layouts available for use on the agent desktop. Each 
layout can contain up to 16 fields chosen from the fields in the Field List. You can 
create up to 15 custom layouts in addition to the default layout, for a maximum 
number of 16 layouts. 

You cannot delete the default layout, but it can be edited to add or remove enterprise 
data fields. 

NOTE:  Cisco Unified CCE Outbound Dialer enterprise data fields 
(fields prefixed with “BA”) display correctly only when added to the 
Default layout. For more information on Outbound Dialer enterprise 
data fields, see "Outbound Dialer Enterprise Data" on page 171. 
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To create a custom layout:

1. In the Layout List area, click Add. The Layout Editor dialog box appears 
(Figure 24).

2. In the Layout Name field, enter a name for your layout. 

3. Select the desired field from the available fields in the right pane, and either 
click the left arrow button or double-click your selection to move it to the left 
pane. You can select up to 16 fields.

4. To rearrange the order in which fields are displayed in the left pane, select a 
field and click the up or down arrow button to move the field up or down in the 
list.

5. When the layout is arranged to your satisfaction, click OK. The Layout Editor 
dialog box closes.

6. In the Enterprise Data window, click Apply to save your changes.

Figure 24. Layout Editor dialog box
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To edit an existing layout:

1. In the Layout List, select the layout you want to edit, and then click Edit. The 
Layout Editor dialog box appears.

2. Make your changes, and then click OK. The Layout Editor dialog box closes.

3. In the Enterprise Data window, click Apply to save your changes.

To delete an existing layout:

1. In the Layout List, select the layout you want to delete, and then click Delete. 
The layout is deleted.

2. In the Enterprise Data window, click Apply to save your changes.

NOTE:  You cannot delete the Default layout.

Custom Layouts

If you want to use a custom layout rather than the default layout, you must first create 
the custom layout and then create a custom Unified ICM script.

To use a custom layout:

1. Create a new ECC scalar variable with Unified ICM Configuration Manager. 
The new variable stores the new layout as set in a Unified ICM script.

2. Delete the existing field with the index number of 252 from the list of 
variables. 

3. Add a new custom field with an index number of 252. (This index number is 
an exception to the rule that fields with indexes between 231 and 255 are 
predefined and not editable.) 

4. Name the new field with the name you gave the new ECC variable you created 
in Step 1, without the “user” prefix. 

The new field must be a scalar variable, not an array variable. 

5. Create a new layout (see the procedure "To create a custom layout:" on 
page 60). 

6. Write a Unified ICM script that assigns the new layout name to the new ECC 
variable. See your Unified ICM documentation for information on creating 
scripts. 
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VoIP Monitor

The VoIP Monitor window (Figure 25) enables you to:

■ Enable desktop monitoring or server monitoring for devices

■ Configure a default VoIP Monitor server for server monitoring

■ Configure devices to be monitored by specific VoIP Monitor servers

■ Configure agent gateways to be monitored by specific VoIP Monitor servers in 
order to monitor and record mobile agents

The default setting is all agents using desktop monitoring. In general, there is no need 
to configure devices for VoIP Monitor server monitoring. For more information, see 
“Cisco VoIP Monitor Service Monitoring” in the Cisco CAD Installation Guide.

Desktop monitoring and server monitoring are two ways of providing CAD-based 
monitoring. If your system configuration uses Cisco Unified Communications 
Manager 6.0 (Unified CM), CAD also supports Unified CM-based monitoring. 

The type of monitoring that is used is determined when the Cisco components of your 
system are installed. CAD uses either Unified CM-based or CAD-based monitoring, not 
both. If your system is configured to use Unified CM-based monitoring, desktop and 
server monitoring are not available.

NOTE:  If your system is configured to use Cisco Unified 
Communications Manager-based (Unified CM-based) silent 
monitoring, no additional configuration is required in Desktop 
Administrator. 

Figure 25. VoIP Monitor window (VoIP Monitor Services tab)
62 January 16, 2013



VoIP Monitor
Desktop Monitoring

A phone is monitored either through desktop monitoring or a VoIP Monitor service—it 
cannot be monitored by both. However, a VoIP Monitor service can be a backup if the 
agent’s desktop monitoring module fails to register with Directory Services when 
Agent Desktop is started. 

By default, desktop monitoring is enabled for all phone devices.

NOTE:  Desktop monitoring does not function with some NIC cards 
that are unable to detect both voice packets and data packets in a 
multiple VLAN environment. For more information on this issue, and 
suggested work-arounds, see the Cisco CAD Installation Guide.

With desktop monitoring enabled, software on the agent’s PC handles recording and 
monitoring requests for that agent. This is possible only on PCs that are physically 
connected to the network through a hard IP phone (see the Cisco CAD Installation 
Guide for a list of supported hard IP phones) or through the Cisco IP Communicator 
soft phone. Desktop Monitoring does not apply to agents using the IP Phone Agent 
service on their IP phone or to CAD-BE agents.

To disable desktop monitoring:

■ On the VoIP Monitor Devices tab, clear the Enable Desktop Monitoring check 
box for the corresponding device.

Cisco VoIP Monitor Service Monitoring

If your system has only one Cisco VoIP Monitor Service, it is not necessary to set a 
default monitor service or to manually assign each device to that single monitor. The 
Cisco VoIP Monitor Service assumes that each device is assigned to it as the only 
available monitor service. 

This does not apply to devices that are configured to use desktop monitoring. The 
default Cisco VoIP Monitor Service does serve as a backup for desktop monitoring if 
no other Cisco VoIP Monitor Service is explicitly defined as the backup.

It is advisable to select a default monitor service to avoid the possibility of having 
devices unassigned to a monitor service. This situation can arise when there is more 
than one Cisco VoIP Monitor Service in the system.

Modifications you make in the VoIP Monitor window are immediately written to LDAP 
and go into effect shortly thereafter.

Agents using the IP Phone Agent service and CAD-BE must be monitored via a Cisco 
VoIP Monitor Service.
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Devices Displayed in the VoIP Monitor Window

The VoIP Monitor Devices tab displays all agent devices set up in the Unified CM.

If a phone is configured for extension mobility, the Extension field displays the 
following information.

■ The extension of the user logged into the phone via the Extension Mobility 
service

■ The static extension assigned to the device’s MAC address, if no user is 
logged into the phone and if a static extension is set up

■ A blank if no static extension is set up

NOTE:  It is recommended that you assign a static extension to an 
extension mobility device to make administration easier.

To set a default Cisco VoIP Monitor Service:

■ On the VoIP Monitor Services tab, choose a Cisco VoIP Monitor Service from 
the Default VoIP Monitor Server field. 

The service you choose is set as the default monitor service for your system. 
Any device not assigned to a specific Cisco VoIP Monitor Service or that has 
desktop monitoring disabled is monitored by the default monitor service.

To assign a device to a specific Cisco VoIP Monitor Service:

1. Select the VoIP Monitor Services tab.

2. Using either the device’s extension or the MAC address, locate the device you 
wish to assign to a specific Cisco VoIP Monitor Service. 

NOTE: You can click a column header to sort the column in ascending or 
descending order to make your search easier.

3. Choose a Cisco VoIP Monitor Service from the Monitor Server drop-down list. 

NOTE: You can right-click anywhere in a device’s row to pop up the Select a 
VoIP Monitor Server dialog box from which to choose a Cisco VoIP Monitor 
Service.

4. Make sure that the device’s Enable Desktop Monitoring check box is cleared. 
The device is now assigned to that Cisco VoIP Monitor Service.

To assign multiple devices to a specific Cisco VoIP Monitor Service:

1. Use standard Windows multiple selection techniques to assign more than one 
device to a specific Cisco VoIP Monitor Service:
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■ Press Shift+Click to select a range of contiguous devices, then right-click 
the selected devices to display the Select a VoIP Monitor Server dialog 
box.

■ Press Ctrl+Click to select non-contiguous devices, then right-click the 
selected devices to display the Select a VoIP Monitor Server dialog box.

2. Choose the Cisco VoIP Monitor Service from the drop-down list. The devices 
you selected are now assigned to that Cisco VoIP Monitor Service.

Mobile Agent Monitoring

Mobile agents can connect to the system through any one of a number of agent 
gateways. The Mobile Agent Monitor tab (Figure 26) enables you to assign one Cisco 
VoIP Monitor Service to each agent gateway. Only one Cisco VoIP Monitor Service per 
agent gateway is supported. One Cisco VoIP Monitor Service can be assigned to 
multiple agent gateways as well as to regular agent phones.

For mobile agent monitoring to work, the caller and agent voice gateways must be 
separate. In addition, the VoIP Monitor server must be located in the network where it 
can see the traffic flowing between the agents and customers. If the customer and 
agent are speaking to each other over the same voice gateway, then that voice stream 
will remain local to the gateway and not be exposed to the Cisco VoIP Monitor Service. 
SPAN will not send those packets to the Cisco VoIP Monitor Service, and the 
conversation will not be heard. For this reason, monitoring and recording of 
Agent-to-Agent calls is not supported.
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One additional limitation of mobile agent monitoring is that if a mobile agent logs in 
while on a call or is on a call during a CAD services or CRI server failover, the agent 
cannot be monitored until the call state changes or the agent makes a new call.

To set up mobile agent monitoring:

1. On the Mobile Agent Monitor tab, double-click or right-click the first available 
field in the Agent Gateway IP Address column.

2. Enter the IP address of the agent gateway to be monitored.

3. In the Monitor Server field, select the Cisco VoIP Monitor Service that will 
monitor the agent gateway from the drop-down list. Your changes go into 
effect immediately.

Figure 26. Mobile Agent Monitor tab
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Effect of Monitoring Options on Devices

Use Table 4 to determine the effect on monitored devices with various combinations 
of desktop monitoring, Cisco VoIP Monitor Service monitoring, and setting a default 
monitor.

If a device is assigned to be monitored by a specific Cisco VoIP Monitor Service, and 
that service fails, there is no failover to the default Cisco VoIP Monitor Service (if one 
is designated). However, if a device has desktop monitoring enabled, and the desktop 
monitoring module is not registered with Directory Services at the time a monitoring or 
recording session is requested, there is failover to a specific Cisco VoIP Monitor 
Service (if designated) or to the default Cisco VoIP Monitor Service (if designated).

Table 4. Effect of Monitoring Options on Devices 

Specific
VoIP

Desktop
Monitor

Default
VoIP Effect on devices

No No No If multiple Cisco VoIP Monitor Services are used, 
monitoring fails. If one Cisco VoIP Monitor Service 
is used, device is monitored by the default Cisco 
VoIP Monitor Service.

Yes No No Monitored by specific Cisco VoIP Monitor Service 
with no backup.

Yes Yes No Monitored by Desktop Monitor and backed up by 
specific Cisco VoIP Monitor Service.

Yes No Yes Monitored by specific Cisco VoIP Monitor Service 
with no backup.

No Yes No Monitored by Desktop Monitor with no backup. If 
only one Cisco VoIP Monitor Service is used, it acts 
as backup.

No Yes Yes Monitored by Desktop Monitor and backed up by 
default Cisco VoIP Monitor Service.

No No Yes Monitored by default Cisco VoIP Monitor Service 
with no backup.

Yes Yes Yes Monitored by Desktop Monitor and backed up by 
the specific Cisco VoIP Monitor Service. If the 
specific service fails, there is no backup.
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Removing the Monitoring or Recording Services from 
Directory Services

You can remove the Cisco VoIP Monitor Service or Cisco Recording & Playback Service 
from Directory Services.

Remove these services only if you intend to uninstall (or already have uninstalled) the 
Cisco VoIP Monitor Service or Cisco Recording & Playback Service permanently. The 
Remove function enables you to clean up Directory Services.

NOTE:  Removing a Cisco VoIP Monitor Service can result in devices 
becoming unmonitored.

To remove the Cisco VoIP Monitor Service or Cisco Recording & Playback Service from 
Directory Services:

1. From the menu bar, choose Edit > Remove Services, or click the Remove VoIP, 
Recording/Playback Services button on the toolbar. The Remove 
VoIP/Recording & Playback Server dialog box is displayed (Figure 27). 

2. From the appropriate drop-down list, select the service you want to remove 
from Directory Services. 

3. Click the Remove button next to the selected service. The selected service is 
removed from Directory Services.

4. Click Close to close the dialog box.

To restore a removed service to Directory Services:

1. Stop and then restart the removed service from the Windows Services dialog 
box.

2. Stop and then restart Desktop Administrator. The service is restored to the list 
of available services.

Figure 27. Remove VoIP/Recording & Playback dialog box
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Work Flow Configuration
Introduction

You can use the Work Flow Configuration application to configure and manage the 
appearance and behavior of Agent Desktop, CAD-BE, and IP Phone Agent. The Work 
Flow Configuration application has the following functions:

■ Dial Strings (page 71)

■ Phone Books (page 82)

■ Reason Codes (page 89)

■ Wrap-up Data (page 93)

■ Record/Monitor Notification (page 98)

■ Work Flow Groups (page 99)
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To use a Work Flow Configuration function, select the corresponding node in the left 
navigation pane in the Desktop Administrator window (Figure 28). The right pane 
displays the options that can be configured for the selected node.

The CAD client applications must be restarted for any configuration changes you make 
to go into effect.

NOTE:  When configuring the name or ID of objects (examples are 
work groups, work flows, agent login names, server names, and 
macro names), do not use the “=”character. This can cause problems 
when backing up and restoring data.

Figure 28. Work Flow Configuration — Dial Strings node
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Dial Strings

Use the Dial Strings function to configure the way desktop applications display and 
dial phone numbers.

NOTE:  CAD-BE dial strings are not configurable.

First, select the appropriate check box at the bottom of the Dial Strings pane to 
choose the dial string format you will use. You must select one check box. The 
following formats are available.

■ North American Dial String Formatting (page 71) 

■ Variable Length Dial String Formatting (page 79) 

Different tabs are available, depending on the check box you select.

North American Dial String Formatting

If you choose North American dial string formatting, the following tabs are available.

■ Telephone Number Display (page 72)

■ Outgoing Calls (page 73)

■ Miscellaneous (page 78)
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Telephone Number Display

Use the Telephone Number Display tab (Figure 29) to configure the format that Agent 
Desktop uses to display phone numbers. The selections you make are illustrated in 
the sample fields, with the exception of the “Remove first ‘n’ digits” and “Remove last 
‘n’ digits” fields. If you type non-zero values in one or both of these fields, the sample 
does not change.)

Table 5 describes the sections on the Telephone Number Display tab.

To configure the telephone number display:

■ Select or clear the check boxes and radio buttons on the Telephone Number 
Display tab as desired, then click Apply to save your changes.

Figure 29. Telephone Number Display tab

Table 5. Telephone Number Display tab — description 

Section Description

External number format The format of the calling number and called number.

Area code/Exchange The separator between area code and exchange.

Exchange/Subscriber code The separator between exchange and subscriber 
code.

Internal number format The number of digits displayed for internal phone 
numbers. You can also add a leading ‘x’ (extension).
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Outgoing Calls

Use the Outgoing Calls tab (Figure 30) to configure local area codes and exchanges.

Table 6 describes the sections and options on the Outgoing Calls tab.

Figure 30. Outgoing Calls tab

Table 6. Outgoing Calls tab — description 

Section/option Description

Local area code The local 3-digit area code. 

NOTE: If you must dial the area code for local calls, 
leave this field blank.

Advanced Dialing… Configure Advanced Internal Dialing and Advanced 
External Dialing.

Prefixes

Local line access code The number needed to access an outside local line.

Long distance line 
access code

The number needed to access an outside long 
distance line.

Ensure a 1 on long 
distance calls

Automatically dial a “1” before dialing a long 
distance phone number.
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To configure outgoing calls:

■ Enter information and select or clear the appropriate check boxes on the 
Outgoing Calls tab as desired, then click Apply to save your changes.

Advanced Internal Dialing

Use the Advanced Internal Dialing tab on the Advanced Dialing Plan window 
(Figure 31) to configure additional internal dialing options. To access this window, 
click Advanced Dialing on the Outgoing Calls tab.

Use area code for toll calls 
within the area code

Automatically dial the local area code before dialing 
any numbers that are not in the local exchange list.

Use area code for local 
calls

Automatically dial the local area code before dialing 
any numbers in the local exchange list.

Local exchanges To create a list of exchanges for which it is NOT 
necessary to dial “1” first, click Add. Alternatively, 
select the All exchanges are local check box. 

Figure 31. Advanced Dialing Plan — Advanced Internal Dialing tab

Table 6. Outgoing Calls tab — description — Continued

Section/option Description
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Table 7 describes the sections on the Advanced Internal Dialing tab.

To configure advanced internal dialing options:

1. Select the maximum number of digits used for internal extensions.

2. If you select 7 or more as the maximum number of digits for internal 
extensions, complete the following steps.

a. Type a number in the Exchange field.

b. Type the first number in the Range of subscriber numbers field.

c. Type the last number in the To field.

d. Click Add.

e. Repeat steps a through d for each additional exchange used.

3. Click OK to save your changes and close the Advanced Dialing Plan window.

Table 7. Advanced Internal Dialing tab — description 

Section Description

Extensions The maximum number of digits in an internal extension 
number, from 1–12. 

NOTE: If you select 7, you must specify the internal 
exchange and the corresponding range of subscriber 
numbers, so that the application can distinguish 
between a 7-digit internal phone number and a 7-digit 
outgoing call.

7-digit extensions: (Available only if you select 7 or more as the maximum 
number of digits for internal extensions.)

Exchange The internal exchange.

Range of subscriber 
numbers

The range of subscriber numbers from low to high that 
correspond to the selected exchange.
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Advanced External Dialing

Use the Advanced External Dialing tab on the Advanced Dialing Plan window to 
configure additional external dialing options (Figure 32). To access this window, click 
Advanced Dialing on the Outgoing Calls tab.

Table 8 describes the sections on the Advanced External Dialing tab.

Figure 32. Advanced External Dialing tab

Table 8. Advanced External Dialing tab — description 

Section Description

Neighboring area 
codes with local 
dialing privileges

The area codes to which you can place toll-free calls.

Exchanges for 
7-digit local 
numbers

The exchanges within a selected area code that do not require 
‘1’ or an area code. Available only if you enter one or more 
neighboring area codes.

Exchanges for 
10-digit local 
numbers

The exchanges within a selected area code that require an 
area code but not ‘1’. Available only if you enter one or more 
neighboring area codes.
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To configure advanced external dialing options:

1. Type a number in the Neighboring area codes field, then click Add.

2. If appropriate, complete one of the following steps.

■ If there are no exchanges within the neighboring area code that you 
entered in step 1 that require ‘1’ or an area code, select the All exchanges 
as 7-digit numbers check box.

■ If all exchanges within the neighboring area code that you entered in 
step 1 require an area code but not ‘1’, select the All exchanges as 
10-digit numbers check box.

3. If the neighboring area code that you entered in step 1 has one or more 
exchanges that do not require ‘1’ or an area code, type the numbers in the 
Exchanges for 7-digit local numbers field, then click Add.

4. If the neighboring area code that you entered in step 1 has one or more 
exchanges that require an area code but not ‘1’, type the numbers in the 
Exchanges for 7-digit local numbers field, then click Add.

5. Repeat step 1 through step 4 for each neighboring area code that you wish to 
configure.

6. Click OK to save your changes and close the Advanced Dialing Plan window.
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Miscellaneous

Use the Miscellaneous tab to set up additional dialing properties (Figure 33).

NOTE:  This tab is the same for North American and variable length 
dial string formatting. 

Table 9 describes the options on the Miscellaneous tab.

To configure the miscellaneous options:

■ Select or clear the appropriate check boxes on the Miscellaneous tab as 
desired, and then click Apply to save your changes.

Figure 33. Miscellaneous tab

Table 9. Miscellaneous tab — description 

Options Description

Use text from the clipboard 
as the phone number when 
pressing the call button

Enable Agent Desktop to use clipboard text as the 
dialed number when the Call button is pressed, as 
long as the clipboard text is a valid text string.

Show the dial pad when 
using text from the 
clipboard for dialing.

Display the dial pad before dialing a number from 
the clipboard. If unselected, Agent Desktop dials the 
number without displaying the dial pad. Available 
only if “Use text from the clipboard…” is selected.

Convert text to digits in 
phone numbers

Converts phone numbers expressed in alphabetic 
characters (for example, 1-800-ANYWORD) to their 
numeric equivalents before dialing.
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Variable Length Dial String Formatting

If you choose variable length dial string formatting, the following tabs are available.

■ Telephone Number Display (page 72)

■ Phone Number Format (page 80)

■ Advanced Internal Dialing (page 74)

Telephone Number Display

Use the Telephone Number Display tab to configure the way Agent Desktop displays 
phone numbers (Figure 34).

The selections you make are illustrated in the sample fields, with the exception of the 
“Remove first ‘n’ digits” and “Remove last ‘n’ digits” fields. If you type non-zero values 
in one or both of these fields, the sample does not change.) 

NOTE:  The number of digits displayed in each section of the sample 
phone number is for illustration only. The samples do not reflect the 
number format you set up on the Phone Number Format tab.

Figure 34. Telephone Number Display tab
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Table 10 describes the sections on the Telephone Number Display tab.

To configure the telephone number display:

■ Enter data and select or clear the appropriate check boxes and radio buttons 
as desired, then click Apply to save your changes.

Phone Number Format

Use the Phone Number Format tab (Figure 35) to configure the format for phone 
numbers that do not use North American dial string formatting. You can also set the 
maximum number of digits in an internal phone extension. You can establish as many 
formats as you want, as long as each format has a unique total length. 

Table 10. Telephone Number Display tab — description 

Section Description

External number format The format of the calling and called numbers.

City/subscriber code The separator between the city and subscriber codes.

Internal number format The number of digits displayed for internal phone 
numbers. You can also add a leading ‘x’ (extension).

Figure 35. Phone Number Format tab
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To add a new phone number format:

1. Click Add. The Add City/Subscriber Code Lengths dialog box appears.

2. Type the number of digits for city codes and subscriber codes, then click OK. 
The numbers you entered are displayed in the phone number format pane, 
with the calculated total length of the format. 

NOTE: You cannot enter another format with the same total length.

3. When you are finished adding formats, click Apply. The new phone number 
format is saved.

To edit a phone number format:

1. Select a number format, then click Edit. The Edit City/Subscriber Code 
Lengths dialog box appears.

2. Make your changes, then click OK.

3. Click Apply to save your changes. The phone number format is changed.

To delete a phone number format:

1. Select a number format, then click Delete.

2. Click Apply to save your changes. The phone number format is deleted.

Miscellaneous

The Miscellaneous tab for variable length dial string formatting is the same as the 
Miscellaneous tab for North American dial string formatting.

See "Miscellaneous" on page 78 for a description of the Miscellaneous tab.

Figure 36. Add City/Subscriber Code Lengths dialog box
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Phone Books

Agents have the following types of phone lists available to them.

■ The Recent Call List, a dynamic list of up to 100 recently called phone 
numbers kept by Agent Desktop

■ A personal phone book with unlimited entries, created and maintained by the 
agent (and enabled/disabled by the administrator)

■ Up to 256 global phone books, each with unlimited entries, created by the 
administrator with the global Phone Book function

■ Work flow group phone books, created by the administrator with the work flow 
group Phone Book function

Global phone books are created and maintained using the Phone Book node under 
the Work Flow Configuration application. 

NOTE:  See Appendix A, "Global Phone Book FAQ" for more 
information on managing global phone books.

Work flow group phone books are created and maintained using the Phone Book node 
under the specific work flow group node (Figure 37).

Figure 37. Global and work flow phone book nodes

Global phone 
book

Work flow 
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Use the global phone book (Figure 38, left) to create and manage the global phone 
books that are shared by all agents. 

Use the work flow group phone book (Figure 38, right) to create and manage the work 
flow group phone books that are shared by agents in specific work flow groups. 

Use the Phone Book Editor to create and manage phone books and phone book 
entries (Figure 38).

Using the Phone Book Filter

You can use the phone book filter to find phone book entries more easily. The filter 
enables you to limit the entries listed in the phone book window. You can use any of 
the four phone book fields to filter the entries.

To use the phone book filter:

1. In the Phone Book window, select the Filter check box.

2. From the Filter drop-down lists, select how you want to filter the entries. In the 
first two drop-down lists, select your filter criteria: the field to filter by, and the 
filter method. In the third field, enter the filter string.

For example, if you want to see all phone book entries for persons whose last 
name begins with “J”, select “Last Name” from the first drop-down list, 
“Begins with” from the second drop-down list, and enter J in the third field. 

The flter operates as soon as you enter your filter string in the third field.

3. To stop filtering the phone book, clear the Filter check box or delete the filter 
string in the third field. The entire phone book will once again be visible.

Figure 38. Phone Book windows — global (left) and work flow group (right)
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Creating Phone Books

To set up a new phone book:

1. In the global or work flow group phone book window, click Edit. The Phone 
Book Editor window appears (Figure 39).

2. Type a name for the new phone book in the Phone Books field, then click Add. 
The new phone book is added to the list of phone books.

3. Click OK. The new phone book is saved and the Phone Book Editor window 
closes.

To add phone book entries:

1. In the Phone Book window, select a phone book from the drop-down list, then 
click Edit. The Phone Book Editor window appears.

2. Enter a name, phone number, and note for a person or company, then click 
Add to add the information to the phone book. The minimum amount of 
information required for a phone book entry is the phone number.

Figure 39. Phone Book Editor window
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The Phone Number field allows only numbers (0-9), letters (aA-zZ), spaces, 
and the characters ‘ ( ) + ; / : . = ?.

If you enter any other character you are advised you used a disallowed 
character. The disallowed character will be replaced by a question mark so 
you can change it to an allowed character.

3. Repeat Step 2 as needed to enter all entries to the phone book. When you are 
done adding entries, click OK. Your entries are saved and the Phone Book 
Editor window closes.

To edit phone book entries:

1. Navigate to the global or work flow group phone book node.

2. Select a phone book from the drop-down list, then click Edit. The Phone Book 
Editor window appears.

3. Select an entry in the phone book, then complete one of the following steps.

■ To modify the entry, click Edit.

■ To delete the entry, click Delete.

4. When you are done editing entries, click OK. Your changes are saved and the 
Phone Book Editor window closes.

Enabling or Disabling Phone Books

Phone books can be enabled or disabled only on the global level.

To disable phone books:

1. Navigate to the global phone book node.

2. If you wish to remove agent access to all global and work flow group phone 
books, select the Disable all phone books check box.

3. If you wish to remove agent access to all personal phone books, select the 
Disable personal phone book check box.

NOTE:  All agents must log out and close Agent Desktop in order for 
the disabling of phone books to take effect.

4. Click Apply.

To enable phone books:

1. Navigate to the global phone book node.

2. If you wish to add agent access to all global and work flow group phone books, 
clear the Disable all phone books check box.
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3. If you wish to add agent access to all personal phone books, clear the Disable 
personal phone book check box.

4. Click Apply.

Importing and Exporting Phone Books

Importing and exporting phone books makes creating and maintaining large phone 
books (up to 3000 entries) easier than with the Phone Book Editor window. Phone 
books can be created and edited in any third-party application that accepts 
comma-separated value (CSV) files, such as a text editor or spreadsheet. Using the 
third-party application, you can edit exported phone books—make bulk changes (for 
example, changing an area code), and adding and deleting phone numbers. The 
updated file can then be imported into Desktop Administrator to replace the previous 
version.

CSV File Format

The phone book CSV file contains the fields shown inTable 11.

An example of a phone book CSV file is shown below.

"First Name","Last Name","Phone Number","Notes"
"Amanda","Cohen","6511234",""
"Nicholas","Knight","612-555-1228","Sales"
"Natalie","Lambert","952-555-9876","Benefits"
"Joseph","Stonetree","651-555-7612","Manager"

A phone book CSV files must conform to this format and include the headers in the 
first line. During import the file is scanned for illegal characters. If any are found, they 
are replaced with question marks. 

NOTE:  Exported CSV files will always show each field enclosed in 
double quotes, as in the example above. This is to ensure that any 
commas or double quotes that are part of the actual field data are 
not mistaken for field delimiters. If your data does not include these 

Table 11. Phone book CSV file details

Field Max Length Permitted Characters
Can Be 
Blank?

First Name 100 Any printable No

Last Name 100 Any printable No

Phone Number 40 0–9, aA–zZ, ‘ ( ) + / : . = ? No

Notes 256 Any printable Yes
86 January 16, 2013



Phone Books
characters, you can omit the double quotes in files you prepare for 
importing. 

To import a phone book:

1. Make sure the phone book CSV file is formatted correctly, as specified in the 
section, "CSV File Format" on page 86.

2. In the Phone Book window, click Edit. The Phone Book Editor window appears 
(Figure 39 on page 84).

3. Click Import. The Import Select dialog box appears (Figure 40).  

Any CSV files located in the default folder C:\Program 
Files\Cisco\Desktop\config are listed. If your file is located somewhere else, 
click Find folder to browse to its location.

4. Select the file you want to import and then click Okay. The phone book is 
imported and is added to the list of available phone books in the Current List 
pane.

The CSV file name (without the CSV suffix) becomes the phone book name. If 
that name is already in use, you will be asked if you want to replace the 
existing phone book with the imported phone book. If you do not want to 
replace the existing phone book, cancel the import, rename the CSV file, and 
try again.

5. Click OK to close the Phone Book Editor window.

Figure 40. Import Select dialog box
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To export a phone book:

1. In the Phone Book window, click Edit. The Phone Book Editor window appears 
(Figure 39 on page 84).

2. In the Current list pane, select the phone book you want to export, and then 
click Export. The Export Phone Book dialog box appears (Figure 41).  

3. The default export location is the C:\Program Files\Cisco\Desktop\config 
folder. If you have imported or exported a phone book previously, the location 
you chose then is shown. If you want to export the phone book to a different 
location, click Browse to a different folder and navigate to that location.

4. Click OK. The phone book is exported to the selected location. The file name 
is the name of the phone book with the CSV file extension.

Figure 41. Export Phone Book dialog box
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Reason Codes

Reason codes describe why an agent has changed to the Not Ready agent state or 
has logged out. 

There is no limit on how many reason codes can be set up for Agent Desktop and 
CAD-BE. IP Phone Agent has a limit of 100 reason codes.

Reason codes are set up and maintained in Unified ICM using the Cisco Unified 
Contact Center Enterprise Web Administration Tool (if you use System IPCC) or 
Unified ICM Configuration Manager (if you use anything other than System IPCC, for 
example, Unified ICM Enterprise/Hosted or Unified CC Enterprise/Hosted). You use 
Desktop Administrator to assign reason codes to agents on both a global and work 
flow group level.

Global reason codes are assigned using the Reason Codes node under the Work Flow 
Configuration node. Work flow group reason codes are assigned using the Reason 
Codes node under the specific work flow group node (Figure 42).

Global reason codes are available for use by all agents. Work flow reason codes are 
available only to those agents in that specific work flow group. 

Figure 42. Global and work flow reason code nodes
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Reserved reason codes are predefined in LDAP and cannot be created or deleted. 
These reason codes are automatically applied to events over which agents have no 
control, such as being logged out by a supervisor or because of a system failure. They 
are not visible to the agent, but appear only in reports and in the global Reason Codes 
window. 

NOTE:  It is recommended that reason codes created in Unified ICM 
do not use the same reason code numbers as the reserved reason 
codes. If there are duplicated reason code numbers, errors in 
reporting and other problems might result.

Table 12 lists the reserved reason codes.

Not Ready and Logout reason codes are enabled or disabled on the work flow group 
level.

Table 12. Reserved reason codes

Reason Code Description

-3 Extension modified while logged in

-2 PG failure

-1 Peripheral restarted

22 Supervisor logout

33 Supervisor not ready

20001 Not Ready for force logout

20002 Force logout

20003 Not Ready for logout

32767 Ring no answer

50001 CTI OS disconnect

50002 CTI OS component disconnect

50003 Device out of service

50004 Agent inactivity

50010 Routed call NOT delivered

50020 Agent Re-skill
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NOTE:  You can configure reason codes within the Cisco Unified 
Contact Center Enterprise Web Administration Tool (if you use System 
IPCC) or the Unified ICM Configuration Manager (if you use anything 
other than System IPCC) so that they are required when logging out or 
going to the Not Ready state. However, Agent Desktop cannot detect 
these settings. It is recommended that the enterprise desk settings 
“Idle reason required” and “Logout reason required” be left 
unselected and that the enabling or disabling of reason codes be 
done within Desktop Administrator.

NOTE:  Agents must restart Agent Desktop, CAD-BE, and IP Phone 
Agent to see any changes you make to reason codes.

NOTE:  For Chinese, Japanese, and Korean localized sites, reason 
codes might not appear correctly in IP Phone Agent due to the phone 
limitations on multi-byte characters.

Assigning Reason Codes

To assign global reason codes:

1. Select the global Reason Codes node in the navigation tree to display the 
Reason Codes window (Figure 43, left).

2. Select the appropriate tab for the type of reason codes you want to assign: 
Logout or Not Ready. 

3. From the Available Reason Codes List, select the reason codes you want 
available to all agents, and then click the right arrow button to move them to 
the Global Reason Codes List. 

Figure 43. Reason Code window — global (left) and work flow group (right)
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4. Click Apply.

To assign work flow reason codes:

1. Select the Reason Codes node under the desired work flow group in the 
navigation pane to display the Reason Codes window (Figure 43, right).

2. Select the appropriate tab for the type of reason codes you want to assign, 
Logout or Not Ready. 

3. From the Available Reason Codes List, select the reason codes you want 
available to agents in that work flow group, and then click the right arrow 
button to move them to the Work Flow Group List. 

4. Select the Enable Logout Reason Codes or Enable Not Ready Reason Codes 
check box to enable that type of reason code for the agents in that work flow 
group. This includes any global reason codes set up.

5. Click Apply.

Enabling or Disabling Reason Codes

Reason codes can be enabled or disabled only on the work flow group level, and must 
be done individually for every work flow group.

To enable or disable reason codes:

1. Select the Reason Codes node under the work flow group whose reason 
codes you want to enable or disable.

2. Select the appropriate tab and then select or clear the Enable Logout Reason 
Codes or Enable Not Ready Reason Codes check box. 

3. Click Apply.
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Wrap-up Data

Wrap-up data descriptions are used by contact centers for purposes such as tracking 
the frequency of different activities and identifying the account to which to charge a 
call, among others. Wrap-up data is set up and maintained, and automated state 
changes are enabled, using the Wrap-up Data window.

There is no limit on how many wrap-up data descriptions can be set up for Agent 
Desktop and CAD-BE. IP Phone Agent has a limit of 100 wrap-up data descriptions.

NOTE:  Agent Desktop and CAD-BE agents must log out, exit, and 
restart the application for changes to take effect.

Global wrap-up data descriptions are created and assigned using the Wrap-up Data 
under the Work Flow Configuration node. Work flow group wrap-up data descriptions 
are created and assigned using the Wrap-up Data node under the specific work flow 
group node (Figure 44).

In Agent Desktop, CAD-BE, and IP Phone Agent, the agent selects the appropriate 
wrap-up data description at the beginning of the wrap-up work time for a call. The 
value that the agent selects appears in the Termination_Call_Detail record for the call 
in the Unified ICM database.

Figure 44. Global and work flow group wrap-up data
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IP Phone Agent is limited to a maximum of 100 wrap-up data descriptions. 

To enable Desktop Administrator to properly manage wrap-up data, you must 
configure the following Enterprise Desk Settings options in Unified ICM Configuration 
Manager as optional:

■ Work mode on Incoming

■ Work mode on Outgoing

Within Unified ICM Configuration Manager, you can configure wrap-up data so that it is 
required when transitioning to the Work Ready or Work Not Ready states. However, 
Agent Desktop cannot detect these settings. Leave the Unified ICM Configuration 
Manager settings as optional and enable or disable wrap-up data within Desktop 
Administrator.

When creating wrap-up data descriptions, follow these guidelines:

■ Descriptions can consist of up to 39 alphanumeric characters. No 
punctuation or other characters are allowed.

NOTE:  For Chinese, Japanese, and Korean localized sites, 
descriptions might not appear correctly in IP Phone Agent due to the 
phone limitations on multi-byte characters. 

■ Duplicate descriptions are not allowed.

Creating Wrap-up Data Descriptions

You can create and modify wrap-up data descriptions on both the global and work flow 
group level. 
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To create a wrap-up data description:

1. Select the global or work flow group Wrap-up Codes node in the navigation 
tree to display the Wrap-up Codes window (Figure 45).

2. Click Modify List to display the Wrap-up Data Editor dialog box (Figure 46).

3. Type the new wrap-up data description in the Description field, then click Add. 
The wrap-up data description is added to the Wrap-up Data list.

4. Click OK close the dialog box, then click Apply to save your changes.

Figure 45. Wrap-up Data window — global (left) and work flow group (right)

 

Figure 46. Wrap-up Data Editor dialog box
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To edit a wrap-up data description:

1. Select the global or work flow group Wrap-up Data node in the navigation tree 
to display the Wrap-up Data window (Figure 45).

2. Click Modify List to display the Wrap-up Data Editor dialog box (Figure 46).

3. Double-click the wrap-up data description you want to edit.

4. In the popup dialog box, edit the description as desired and then click OK.

5. Click OK to close the Wrap-up Data Editor dialog box, then click Apply to save 
your changes.

To delete a wrap-up data description:

1. Select the global or work flow group Wrap-up Data node in the navigation tree 
to display the Wrap-up Data window (Figure 45).

2. Click Modify List to display the Wrap-up Data Editor dialog box (Figure 46).

3. Select the wrap-up data description you want to delete, then click Delete.

4. Click OK to close the dialog box, then click Apply to save your changes.

Assigning Wrap-up Data Descriptions

Wrap-up data descriptions can be assigned at the global and at the work flow group 
level. Global wrap-up data descriptions are available to all agents. Work flow group 
level wrap-up data descriptions are available only to the agents in that specific work 
flow group.

To assign global wrap-up data descriptions:

1. Select the global Wrap-up Data node in the navigation tree to display the 
Wrap-up Data window (Figure 45, left).

2. From the Available Wrap-up Descriptions list, select the descriptions you want 
available to all agents, then click the right arrow button to move them to the 
Global Wrap-up Descriptions list. 

3. Click Apply.

To assign work flow wrap-up data descriptions:

1. Select the Wrap-up Data node under the desired work flow group in the 
navigation pane to display the Wrap-up Data window (Figure 45, right).

2. From the Available Wrap-up Data list, select the descriptions you want 
available to agents in that work flow group, and then click the right arrow 
button to move them to the Work Flow Wrap-up Data list. 
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3. Select the Enable Wrap-up Data check box to enable wrap-up data for the 
agents in that work flow group. This includes any global wrap-up data 
descriptions set up.

4. Click Apply.

Enabling or Disabling Wrap-up Data

Wrap-up data can be enabled or disabled only on the work flow group level.

To enable or disable wrap-up data:

1. Select the Wrap-up Data node under the work flow group whose wrap-up data 
descriptions you want to enable or disable.

2. Select or clear the Enable Wrap-up Data check box. 

3. Click Apply.

Automatic State Changes

If automatic state changes are enabled, agents are automatically changed from the 
Work Not Ready state to the Not Ready state, and from the Work Ready state to the 
Ready state, when they enter wrap-up data. 

Automatic state changes can be enabled or disabled only on the work flow group level.

NOTE:  It is possible to set a timer in Unified ICM that will override the 
automatic state change. If an agent doesn’t enter wrap-up data within 
the time set by the timer, the system will change the agent’s state to 
the next state (Not Ready or Ready) and close the Wrap-up Data 
dialog box without anything being entered. 

To enable or disable automatic state changes:

1. Select the Wrap-up Data node under the work flow group whose automatic 
state changes you want to enable or disable.

2. Select or clear the Enable Automatic State Change check box. 

3. Click Apply.
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Record/Monitor Notification

The Record/Monitor Notification window is used at the global level to enable or 
disable messages to agents that they are being recorded or monitored, or both. 

To enable or disable notification:

1. Select the Record/Monitor Notification node in the navigation tree.

2. In the Record/Monitor Notification window, select or clear the Notify 
Monitoring and/or Notify Recording check boxes, then click Apply.

You can also enable/disable monitoring and recording from the menu bar. 

1. Select the Work Flow Configuration node or any of its subnodes in the 
navigation tree.

2. From the menu bar, choose Monitoring.

3. Choose Notify Monitoring and/or Notify Recording from the menu. A check 
mark appears next to the option when it is enabled. 

Figure 47. Record/Monitor Notification window

  

Figure 48. Notify Monitoring
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Work Flow Groups

Use the Work Flow Groups function to create and configure agent work flow groups. 

Under the Work Flow Groups node are individual work flow groups. Initially there is a 
default work group, which can be edited, renamed, or deleted. You can also create 
additional work flow groups.

When you click on a work flow group, the elements that make up that work flow group 
appear as subnodes:

■ Enterprise Data. Configure enterprise data on the agent desktop for the 
selected work flow group.

■ Reason Codes. Assign reason codes for the selected work flow group.

■ Wrap-up Data. Create and edit wrap-up data for the selected work flow group. 

■ Phone Book. Create and edit phone books for the selected work flow group.

■ CAD Agent. Configure the user interface, voice contact work flows, and agent 
management work flows for agents who use Agent Desktop.

■ CAD-BE Agent. Configure the user interface and voice contact work flows for 
agents who use CAD-BE.

■ IP Phone Agent. Enable agent-initiated recording for agents who use the 
IP Phone Agent service.

Figure 49. Accessing Work Flow Group functions in the navigation tree
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Maintaining Work Flow Groups

You can add, delete, or edit work flow groups under the Work Flow Groups node.

NOTE:  If you choose to delete the default work flow group, make sure 
that all agents are assigned to a custom work flow group you have set 
up. If an agent is not assigned to a work flow group, and there is no 
default work flow group, that agent will not be able to start Agent 
Desktop. 

To add a new work flow group:

1. In the Navigation tree, select the Work Flow Groups node.

2. Choose File > New, or click New on the toolbar. The Work Flow Group Name 
Editor dialog box appears.

3. Enter a new work flow group name. If you want to copy an existing work flow 
group, select the Copy the following work flow group check box and choose a 
work flow group from the drop-down list.

4. Click OK. The new work flow group appears in the Navigation pane under the 
Agents node.

To delete an existing work flow group:

1. In the Navigation pane, select the work flow group you want to delete.

2. Choose File > Delete, or click Delete on the toolbar. A message appears, 
stating that all agents who belong to the work flow group you want to delete 
must be reassigned to other work flow groups. Click Yes to confirm the 
deletion, or No to cancel it. If you do not reassign the agents, you will not be 
able to delete the work flow group.

3. Click OK to close the dialog box.

Figure 50. Work Flow Group Name Editor dialog box
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You cannot rename an existing work flow group directly. Instead, you must set up a 
new work flow group and copy the existing work flow group’s settings to the new work 
flow group.

To rename a work flow group:

1. Add a new work flow group, giving it the name you want to change the existing 
work flow group’s name to.

2. Select the Copy the following work flow group check box and select the 
existing work flow group from the drop-down list, and then click OK. The copy 
process can take some time.

3. Delete the old work flow group.
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Enterprise Data

The Enterprise Data window enables you to complete the following tasks.

■ Configure Agent Desktop so that so that agents in the selected work flow 
group can edit enterprise data

■ Set thresholds for call duration at a particular type of device while a call is in 
the contact center

Data

The Data tab controls whether or not an agent in the work flow group is allowed to edit 
the enterprise data displayed in Agent Desktop (Figure 51).

To enable enterprise data editing:

■ Select the Allow agent to edit Enterprise Data check box, and then click Apply.

Figure 51. Data tab
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Call Activity

The Call Activity tab (Figure 52) enables you to set the thresholds for the selected work 
flow group for call duration at a particular type of device (Route Point and Agent) while 
a call is in the contact center.

If a call remains at a device longer than the defined Caution or Warning threshold, a 
Caution or Warning icon is displayed next to the device name in the Agent Desktop call 
activity pane.

To set up call activity thresholds:

1. On the Call Activity tab, enter the threshold times as desired. The maximum 
value for Warning is 59 minutes, 59 seconds. The maximum value for Caution 
is 59 minutes, 58 seconds.

NOTE:  Enter values in the Warning fields before entering values in the 
Caution fields. Desktop Administrator will not accept data entered in 
the Caution fields if no data appears in the Warning fields.

Figure 52. Call Activity tab
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NOTE:  The Warning threshold value must be greater than the Caution 
threshold value. If you enter a greater value in the Caution field, 
Desktop Administrator automatically changes it so that it is one 
second less than the Warning value.

2. Click Apply to save your changes.
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CAD, CAD-BE, and IP Phone Agent Nodes

The CAD Agent, CAD-BE Agent, and IP Phone Agent nodes enable you to configure 
various functions for each type of agent within the selected work flow group.

CAD Agent Node

You can configure the following elements for agents who use Agent Desktop.

■ User Interface (page 106)

■ Voice Contact Work Flows (page 119)

■ Agent Management Work Flows (page 127)

CAD-BE Agent Node

You can configure the following elements for agents who use CAD-BE.

■ User Interface (page 106)

■ Voice Contact Work Flows (page 119)

IP Phone Agent Node

The Recording node under the IP Phone Agent node enables agent-initiated recording 
for agents who use the IP Phone Agent service.

NOTE:  If your CAD system is configured to use Cisco Unified 
Communications Manager-based monitoring, the IP Phone Agent 
node is not available.

When enabled, the IP Phone Agent service has soft key options for starting and 
stopping recording. The IPPA agent can then record his or her own phone 
conversations, and these recordings can be reviewed by the supervisor using 
Supervisor Record Viewer.

See the Cisco IP Phone Agent User Guide and the Cisco Supervisor Desktop User 
Guide for more information.

To enable IPPA agent-initiated recording:

1. Select the Enable IPPA Recording check box.

2. Click Apply to save your changes.
January 16, 2013 105



Cisco Desktop Administrator User Guide
User Interface

The User Interface window enables you to configure the appearance and behavior of 
Agent Desktop (when accessed under the CAD Agent node) and CAD-BE (when 
accessed under the CAD-BE Agent node).

NOTE:  The User Interface windows for the CAD Agent and CAD-BE 
Agent nodes are slightly different to allow for the differences in the 
two applications. The following section discusses the CAD Agent node 
and notes differences for the CAD-BE Agent node.

Toolbar

The Toolbar tab (Figure 53) enables you to complete the following tasks.

■ Adding and Removing Toolbar Buttons (page 107)

■ Associating Actions with Task Buttons (page 107)

■ Changing a Task Button’s Hint (page 108)

■ Customizing Button Icons (page 108)

■ Show Data Fields (page 110)

Figure 53. Toolbar tab — CAD Agent node (left) and CAD-BE Agent node (right)
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Adding and Removing Toolbar Buttons

The pane on the left of the Toolbar tab displays the buttons that are available to be 
used on the Agent Desktop or CAD-BE toolbar. Buttons that are assigned show an icon 
next to them; unassigned buttons do not show an icon. 

You cannot change the hint or the shortcut key combination on any of the standard 
buttons, or assign an additional action to them. You can, however, customize the icon 
displayed on the button (see "Customizing Button Icons" on page 108).

To add a button to the toolbar:

1. In the list of buttons, select the available button you want to add.

2. Select the Visible check box, and then click Apply.

Removing a button from the toolbar:

1. In the list of buttons, select the button you want to remove.

2. Clear the Visible check box, and then click Apply.

Adding the Cisco Unified Outbound Dialer Toolbar

The Cisco Unified Outbound Dialer feature is available only for Agent Desktop users. 
You cannot add the Outbound Dialer toolbar to CAD-BE.

For more information, see "Cisco Unified Outbound Dialer" on page 167.

To add the Outbound Dialer toolbar to Agent Desktop:

■ In the Outbound Dialer Mode section, check the type of dialing mode your 
calling campaign will use, and then click Apply. You can select more than one 
dialing mode check box. The appropriate buttons for that type of calling 
campaign are added to the Agent Desktop toolbar.

NOTE:  The Outbound Dialer Mode section appears on the Toolbar tab 
only if Outbound Dialer is enabled in Unified ICM. If it is not enabled, 
this section is blank.

Associating Actions with Task Buttons

You can associate as many actions with a task button as you wish. The actions are 
executed sequentially in the order they are listed in the Actions window. 

NOTE:  Consider the length of time it takes to execute actions. A 
maximum of two or three actions per task button is recommended.
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The default task buttons display icons of the numbers 1 through 10. You can 
customize these icons if you wish.

To associate an action with a task button:

1. Select a task button from the list of available buttons. 

2. Select the Visible check box. The Actions pane and associated buttons are 
enabled.

3. Under the Actions pane, Click Add. The Select Action window appears. 

4. Select the action you want to associate with the button. You can select an 
existing action or set up a new action. For more information on setting up new 
actions, see "Creating Actions" on page 131.

5. Click OK. The Toolbar tab is displayed.

6. Type a short description of the action in the Hint field. You can replace only 
the hint; you cannot change the shortcut key combination.

7. Repeat Steps 3–6 if you want to add other actions to the same task button. 

8. Click Apply to save your changes.

Changing a Task Button’s Hint

You can change the hint (the text an agent sees when the mouse hovers over a button) 
associated with a task button. You cannot change the hint associated with a standard 
button, or change the shortcut key combination of any button.

To change a task button’s hint:

1. Select the button whose hint you want to change.

2. In the Hint field, type the hint you want displayed to the agent.

3. Click Apply to save your changes.

Customizing Button Icons

Buttons can be customized by applying different icons to them. A library of available 
icons is supplied with Desktop Administrator, or you can use icons of your own.

If you use your own icons, when an icon file is applied to a button it is written to 
Directory Services so that it is available to all instances of Agent Desktop and CAD-BE. 

Custom icons must meet the following specifications.

■ ICO format

■ 16 × 16 pixels or 32 × 32 pixels

■ Up to 256 colors

■ File size no more than 50,000 bytes
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To customize a button icon:

1. Select the button that has an icon you want to customize.

2. Click Customize Icon. The Choose Icon dialog box appears (Figure 54).

3. Select an icon. The icon is displayed in the Preview area. You can also click 
Browse to navigate to another folder if you want to use your own icon. 

4. Click OK. The new icon is displayed in the button list.

5. When you are finished, click Apply to save your changes.

To reset a button icon:

1. Select the button that has the icon that you previously customized. The Reset 
button becomes enabled.

2. Click Reset. The original icon is displayed in the button list.

3. When you are finished, click Apply to save your changes.

Figure 54. Choose Icon dialog box
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Show Data Fields

The Show Data Fields tab (Figure 55) allows you to rename and configure the data 
fields that appear in the contact appearance pane in Agent Desktop and CAD-BE, and 
enable/disable incrementing duration fields in CAD-BE.

NOTE:  CAD-BE agents must log out, exit CAD-BE, and log in again for 
changes to take effect.

Configuring and Renaming Data Fields

The left pane displays the fields that appear in Agent Desktop and CAD-BE. The right 
pane displays the available fields. 

NOTE:  The left pane must contain at least one field.

To configure the data fields that appear:

1. Use the left and right arrows to move the available fields between the left and 
right panes, and the up and down arrows to set the left-to-right order in which 
the fields will appear.

2. Click Apply to save your changes.

Figure 55. Show Data Fields tab — CAD Agent (left) and CAD-BE Agent (right)
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To rename a data field:

1. Double-click the field you want to rename. The Rename dialog box appears 
(Figure 56).

2. Enter a new name, then click OK.

Show Duration

For CAD-BE agents, select the Show Duration check box to enable the Duration field in 
CAD-BE to increment during a call. By default this option is enabled. However, a 
continually changing field can cause difficulties for screen readers, so this field might 
be disabled for agents who are visually impaired. 

For Agent Desktop, the Show Duration feature is enabled/disabled on the Accessibility 
Options tab in the Preferences window.

Figure 56. Rename dialog box
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Miscellaneous

Use the Miscellaneous tab (Figure 57) to configure other user interface options. 
Select or check your desired settings, and then click Apply to save your changes.

Table 13 describes the options on the Miscellaneous tab.

Figure 57. Miscellaneous tab — CAD Agent (left) and CAD-BE Agent (right)

Table 13. Miscellaneous tab options 

Option Description

Window Behavior The behavior of the Agent Desktop window. Only the last 
option, which is the default, allows the agent to choose. 

NOTE: If you select one of the first four options, Agent 
Desktop does not display the Preferences tab on the 
Desktop Preferences dialog box.

• Normal. The window appears when calls are present 
and minimizes when idle.

• Keep Open. The window is always visible, but might be 
hidden by other open applications.

• Always on Top. The window is always visible and on top 
of other open applications.

• Stealth. The window appears as an icon in the system 
tray.

• Agent Choice. The agent can choose the window 
behavior.
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Browser Setup

Use the Browser Setup tab (Figure 58) to configure the Integrated Browser portion of 
Agent Desktop. On this tab you can:

■ Enable/disable the integrated browser window

■ Set the default web page displayed by the browser

■ Enable up to 5 browser tabs

■ Enable/disable agents’ access to other websites 

■ Add work sites (or “favorites”) so agents can quickly access frequently-used 
websites

Macro Hot Key The key you want to use to pause macro recording and 
display the Suspend Macro Recording dialog. The default 
is F2.

Rules and Actions 
only apply to the first 
call appearance

If selected, rules processing is invoked only for the oldest 
(top) call appearance. If not selected, rules processing is 
invoked for all inbound calls.

Report Window is 
always on top

Configures the Agent Desktop Reports window to stay on 
top of any other application whenever it is opened.

Table 13. Miscellaneous tab options — Continued

Option Description

Figure 58. Browser Setup tab — CAD Agent (left) and CAD-BE Agent (right)
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Enabling the Integrated Browser

Enable or disable the integrated browser in Agent Desktop/CAD-BE by selecting or 
clearing the Enable Integrated Browser check box.

Enabling Access to Other Websites

Enable or disable an agent’s access to other websites by selecting or clearing the 
Allow Address Editing check box. When selected, the Address field appears in the 
integrated browser window, and agents can enter the URL of a website they wish to 
view. When deselected, the Address field does not appear in the integrated browser 
window.

Configuring the Number of Browser Tabs

Choose 0 to 5 in the Number of Workflow Browsers field to set how many browser tabs 
appear in Agent Desktop (this feature is not available in CAD-BE). If you choose 0, only 
the supervisor push page tab appears—it is always enabled. If you choose 1 to 5, that 
many tabs in addition to the supervisor push page tab appear. 

Work flow HTTP actions can be set up to display web pages in a specific browser tab. 
See "Creating HTTP Actions" on page 142 for more information.

Setting Up the Home Page

A home page is the website that appears in an integrated browser tab when Agent 
Desktop is started. The default home page is www.cisco.com. If no home page is 
configured (the default is deleted), the integrated browser tab is blank.

Each browser tab can have its own home page. 

To configure a home page:

1. From the Browser Tab drop-down list, select the tab on which you want the 
home page to appear.

2. In the Home Page field, type the web address (URL) of the website you want to 
appear by default in the integrated browser.

3. Click Update.

4. Repeat steps 1 through 3 for each tab as desired.

5. Click Apply to save your changes. The home page is set. 

Setting Up Work Sites

A work site is a website that is frequently accessed by agents to assist them in their 
jobs. They are similar to the “favorites” you can set up in a web browser. 

Work sites you set up appear in a drop-down list in the agent’s integrated browser, and 
are available no matter which tab is displayed. When the agent selects a work site 
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from the list, it appears in the integrated browser window. This gives the agent quick 
access to the site without having to type its address in the (optional) Address field.

To add a work site:

1. In the Site Name field, type the name of the website you wish to add as a work 
site.

2. In the URL field, enter the web address of the website.

3. Click Add. The work site is added to the list in the Work Sites pane.

4. Click Apply to save your changes.

To update a work site:

1. In the Work Sites field, select the work site you wish to update. The 
information for the website appears in the Site Name and URL fields.

2. Edit the information as needed, and then click Update. The updated 
information appears in the Work Sites pane.

3. Click Apply to save your changes.

To delete a work site:

1. In the Work Sites pane, select the work site you wish to delete. The 
information for the website appears in the Site Name and URL fields.

2. Click Delete. The work site is deleted from the Work Sites pane.

3. Click Apply to save your changes.

Remote Access

The Remote Access tab (Figure 59) is used to enable the IPC Receive Event feature 
and configure the port used by the feature. This action is available to agents using 
Agent Desktop at the Premium level only.

NOTE:  The Remote Access feature is not available for CAD-BE.

An IPC Receive Event occurs when a third party application sends a message to Agent 
Desktop over a UDP socket. All attributes that IPC Receive Event actions require in 
order to execute are a part of the IPC Receive Event message content. These 
messages must adhere to a predefined XML schema (see examples below) and 
cannot exceed 4000 bytes. Unlike work flow actions, IPC Receive Event actions do not 
require configuration or setup in Desktop Administrator. 

When Agent Desktop receives an IPC Receive Event message, it does not send a reply 
back. IPC Receive Events are queued so no messages are lost.
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By default, IPC Receive Events are disabled. The default port number is Port 58000. 

NOTE:  The Remote Access action provides for receiving an 
asynchronous event. Even if the event is solicited by an IPC Action 
request being sent out, the request might never be delivered, and 
there is no assurance that a response will arrive because of the 
nature of UDP.

Five actions are supported by the IPC Receive Event:

■ IPC Make Call Action (page 116)

■ IPC High Priority Chat Action (page 117)

■ IPC Record Action (page 117)

■ IPC Agent Notification Action (page 118)

■ IPC Set Variable Action (page 118)

IPC Make Call Action

For the IPC Make Call action to be successful:

■ The agent must be in the Not Ready state

■ There can be no call appearance present in Agent Desktop

■ The Make Call dialog box must be closed (if it is open, the action will close it)

Figure 59. Remote Access tab
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The message sent to Agent Desktop must conform to this XML format. Bold text 
indicates a variable that must be replaced with your own values.

<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
     <IPCMakeCallAction>
          <ActionName>IPC Make Call Action</ActionName>
          <PhoneNumber>2961</PhoneNumber>
          <DisplayError>true</DisplayError>
     </IPCMakeCallAction>
</IPCActions>

IPC High Priority Chat Action

For the IPC High Priority Chat action to be successful, the agent must be logged in.

The message sent to Agent Desktop must conform to this XML format. Bold text 
indicates a variable that must be replaced with your own values.

<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
     <IPCHighPriorityChatAction>
          <ActionName>IPC High Priority Chat Action</ActionName>
          <MessageText>Need help from supervisor</MessageText>
     </IPCHighPriorityChatAction>
</IPCActions>

IPC Record Action

For the IPC Record action to be successful:

■ A call appearance must be present in Agent Desktop

■ The call must be connected, on hold, or conferenced

■ The call must be the first call appearance listed in Agent Desktop

The message sent to Agent Desktop must conform to this XML format. The action 
supports two commands: start and stop. 

<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
     <IPCRecordAction>
          <ActionName>IPC Record Action</ActionName>
          <Command>start</Command>
          <DisplayError>true</DisplayError>
     </IPCRecordAction>
</IPCActions>
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IPC Agent Notification Action

For the IPC Agent Notification action to be successful, the agent must be logged in.

The message sent to Agent Desktop must conform to this XML format. Bold text 
indicates a variable that must be replaced with your own values.

<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
     <IPCAgentNotificationAction>
          <ActionName>IPC Agent Notification Action</ActionName>
          <MessageText>Go to Not Ready state!</MessageText>
     </IPCAgentNotificationAction>
</IPCActions>

IPC Set Variable Action

For the IPC Set Variable action to be successful, the agent must be logged in. 

The IPC Set Variable action receives data values (for example, Cisco Outbound Dialer 
variables prefixed with “BA”) from a third party application in UDP format. The action 
sends these data values to the CTI server.

All variables (ECC variables, call variables, and Outbound Dialer variables) can be set 
with this action.

The message sent to Agent Desktop must conform to this XML format. Bold text 
indicates a variable that must be replaced with your own values.

<?xml version="1.0"?>
<!-- IPC Receive Event Message -->
<IPCActions>
     <IPCSetVariableAction>
          <ActionName>IPC Set Variable Action</ActionName>
          <Variable>BAResponse</Variable>
          <DataValue>03/05/2009 05:45</DataValue>
     </IPCSetVariableAction>
</IPCActions>
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Voice Contact Work Flows

Voice contact work flows manage agent activity based on voice call events. Once a call 
is classified it is further filtered according to events, rules, and actions. Voice contact 
work flows are available to agents who use Agent Desktop and CAD-BE.

For example, a voice contact work flow could be set up as follows:

1. A call comes into the contact center and is routed to an agent in the Ready 
state.

2. The Voice Contact Classification filter determines which work flow to select. It 
examines the inbound call’s enterprise data (original dialed number) and 
determines that it is a call for Product A technical support and thus meets the 
data conditions of Work Flow 1. The call is now subject to the second layer of 
filtering set up in Work Flow 1.

Figure 60. Voice Contact Work Flows flow chart
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3. Work Flow 1 says that any ringing event on the Product A support line triggers 
an HTTP action. This action takes the customer-entered account information 
from the IVR (part of the call’s enterprise data) and pops a web page in the 
Agent Desktop or CAD-BE integrated browser that displays the customer’s 
account information to the agent. 

4. The agent answers the phone call and is ready to assist the customer.

Creating a Voice Contact Work Flow

The general procedure for creating a voice contact work flow is as follows:

1. Set up a new voice contact classification filter:

a. Select the type of call the work flow applies to—inbound, outbound, or all 
calls.

NOTE: Depending on which Outbound Dialer dialing mode you are using, a 
customer call can appear as inbound or outbound. Therefore, when creating 
an Outbound Dialer work flow, select “all calls” as your voice classification 
filter.

b. If required, further classify the call by specifying it must meet various data 
field conditions.

2. Set up the second level of filtering: 

a. Select the call or agent state event—Ringing, Answered, Dropped, Work 
Ready, or Work Not Ready.

b. If required, set up one or more rules with data field conditions that the 
call must meet.

c. Set up one or more actions that will take place if the call or agent event 
meets the rules’ data field conditions.

3. Set up as many second level filters as needed for calls selected by the first 
level filter. You can set up rules and actions for each of the filtered call’s call 
or agent events.

NOTE:  It is possible to set rules and conditions that are contradictory 
so that a work flow cannot function. Desktop Administrator does not 
check a work flow’s logic and validity. If a work flow fails to operate as 
expected, make sure that the rules and conditions you set up are 
logically valid.
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Setting Up a New Voice Contact Classification

When you select the Voice Contact Work Flow node in the navigation tree, the Voice 
Contact Work Flow List window is displayed. This window shows all the existing voice 
contact work flows, and enables you to edit them or to set up new ones.

The Voice Contact Classification is the first level of filtering in a voice contact work 
flow.

To set up a new voice contact classification:

1. In the Voice Contact Work Flow List window, click Add. The New Work Flow 
Name dialog box is displayed.

2. Enter a name for your new voice contact work flow, and then click OK. The Edit 
Voice Contact Classification dialog box appears with the work flow name you 
just created (Figure 61).

3. Set up the criteria for the first level filter in this dialog box. 

a. Select the type of call you want the filter to apply to from the drop-down 
list: inbound calls, outbound calls, or all calls.

Note that there is also the option to disable the work flow. You can select 
this option later on if and when you want to disable the work flow, but 
want to keep the work flow on file for enabling at a later date.

b. Apply up to three data field conditions. Click Edit to display the Data Field 
Condition dialog box. For information on setting up a data field condition, 
see "Data Field Conditions" on page 123.

Figure 61. Edit Voice Contact Classification dialog box
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c. Select if you want the filter to apply when ALL conditions are true, or if 
ANY conditions are true. 

4. Click OK to complete setting up the first level filter in the new voice contact 
work flow.

Setting Up a New Work Flow

After a new voice contact classification is created, Desktop Administrator takes you to 
the Voice Contact Work Flow window (Figure 62). In this window you set up the second 
level of filtering, consisting of events and rules, and the resulting actions for your new 
voice contact work flow.

When an event occurs, the rules associated with the event are evaluated in the order 
they are listed in the Rules pane. When a rule is met, the actions associated with that 
rule are executed in the order they are listed in the Actions pane. Subsequent rules 
are not evaluated.

Figure 62. Voice Contact Work Flow window
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If no rules are met, the default rule governs, and all actions associated with the 
default rule are executed. Default rules cannot be changed or deleted. The default 
action might be <no action>. 

To set up a new work flow:

1. Select the event that triggers the work flow from the Event pane. The available 
events are:

— Ringing. The agent’s phone rings.

— Answered. The agent answers the phone.

— Dropped. The call terminates.

— Work Ready. The agent transitions to the Work Ready agent state.

— Work Not Ready. The agent transitions to the Work Not Ready agent state.

2. Under the Rules pane, click New to set up a new rule. The New Rule Name 
dialog box appears. 

3. Enter the name of the new rule, and then click OK. The fields in the Current 
Rule Conditions section of the window are enabled.

4. Add up to 3 data field conditions (see "Data Field Conditions" on page 123 for 
more information) and specify when the actions should be executed—when 
any one of the data field conditions is met, or when all of the data field 
conditions are met. When a data field condition is established, the Enable 
Rule check box is automatically selected.

NOTE: You cannot use a route point phone number when configuring a rule for 
inbound ACD calls. 

5. Under the Actions pane, click Add to choose one or more actions to run when 
the event occurs and the rules are met. You can select an existing action, or 
create a new action. 

NOTE: If the action you select cannot be associated with the event, you will 
receive an error message. See "Creating Actions" on page 131 for more 
information. 

6. Repeat steps 1 through 5 for as many events as desired. 

7. When you are finished associating events with rules and actions, click Apply 
to save the new voice contact work flow.

Data Field Conditions

Data field conditions are criteria that a call’s selected enterprise data fields must 
meet in order for a work flow rule or a voice contact classification filter to be enforced. 

You can configure up to 3 data field conditions for a work flow rule and for a voice 
contact classification filter. You specify if all the data field conditions must be met (an 
AND statement) or if any of the data field conditions must be met (an OR statement). 
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To configure data field conditions for a work flow rule, use the Current Rule Conditions 
section of the Voice Contact Work Flow window. To configure data field conditions for a 
voice contact classification, use the Data Field Condition dialog box (Figure 63).

To set up data field conditions:

1. In the Voice Contact Classification dialog box, click Edit. In the Voice Contact 
Work Flow window, add a new rule and then click Edit in the Current Rule 
Conditions section of the window. 

2. Select a data field from the Data Field drop-down list.

The Data Field lists all the enterprise data fields used in your system. 

Not all data fields are available for all events, for instance, Calling# and 
Called# are not available for the Ringing event.

3. Specify one of the data field filters:

— Is Empty. The data field is empty.

— Is Not Empty. The data field is not empty.

— Is In the List. The data field is compared to the list you set up in the List 
pane to determine if it is in that list. Click Add to add an item to the list of 
strings. Strings are not case sensitive. You can use wild cards (* and ?) to 

Figure 63. Data Field Condition dialog box
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simplify your list. See "Wild Card Searches" on page 125. 

— Is Not in the List. The data field is compared to the list you set up in the 
List pane to determine if it is not in that list. Click Add to add an item to 
the list of strings. Strings are not case sensitive. You can use wild cards 
(* and ?) to simplify your list. See "Wild Card Searches" on page 125.

— Length of Data. The length of the data field is between a minimum and 
maximum number of characters that you set. 

4. Ensure that the Enable Condition check box is selected, then click OK.

Wild Card Searches

You can use wild cards when entering strings in the data field conditions list pane. 
This enables you to avoid having to enter many strings if the strings you want to list 
have common elements. 

Wild card characters used are the asterisk (*) and the question mark (?). 

An asterisk in a string replaces any quantity of characters, as long as the other 
characters in the string match. For instance, ABC* matches strings that begin with 
ABC but end in any quantity of any characters.

A question mark in a string replaces any character, but the length of the string must 
be exactly as represented. For instance, ABC?? matches strings that begin with ABC 
and end in two other characters.

Double quotes around a string searches for the exact characters within the double 
quotes, including the wild card characters (*) and (?). For instance, “123*ABC” 
matches only the string 123*ABC, and does not allow the asterisk to act as a wild 
card.

Modifying a Voice Contact Work Flow

You can modify the default work flow and any custom work flows you create.

NOTE:  The classification filter for the Default work flow is Inbound 
Calls. This cannot be changed. 

To modify a voice contact work flow:

1. From the Voice Contact Work Flow List, select the work flow you want to 
modify, and then click Edit. 

■ If you selected a custom work flow, the Edit Voice Contact Classification 
dialog box appears. 
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■ If you select the default work flow, the Voice Contact Work Flow window 
appears. The default work flow does not classify voice contacts, and so 
bypasses the Edit Voice contact Classification dialog box.

2. Modify the voice contact classification if desired, and then click OK to proceed 
to the Voice Contact Work Flow window.

3. Modify the work flow as desired, and then click Apply to save your changes.

Deleting a Voice Contact Work Flow

You can delete any custom work flow you create. You cannot delete the default work 
flow.

To delete a voice contact work flow:

1. From the Voice Contact Work Flow List, select the work flow you want to 
delete, and then click Delete. A popup window appears asking you to confirm 
you want to delete the work flow.

2. Click OK to confirm the deletion.
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Agent Management Work Flows

Agent management work flows manage agent activity based on Agent Desktop and 
CAD-BE activity, agent ACD states, and time of day. The work flows follow the event—
rule—action behavior used by voice contact work flows. One important difference is 
that there is no initial filtering similar to the voice contact classification applied to 
voice contacts.

For example, agent management work flows could be set up as follows:

■ Every work day at 4:30, agents receive a popup message reminding them to 
complete their time cards.

■ Whenever Agent Desktop starts up, Notepad is launched on the agent’s 
desktop.

■ Whenever an agent logs in, the customer database is launched.

Creating an Agent Management Work Flow

The general procedure for creating an agent management work flow is as follows:

1. Select the event that triggers the work flow.

Figure 64. Agent Management Work Flows flow chart
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2. If the event is time of day, set up a rule with one or more data conditions that 
the event must meet.

NOTE: It is possible to set rules and conditions that are contradictory so that a 
work flow cannot function. Desktop Administrator does not check a work 
flow’s logic and validity. If a work flow fails to operate as expected, make sure 
that the rules and conditions you set up are logically valid.

3. Set up one or more actions that will take place whenever the event occurs, or, 
if a time of day event, whenever the rule is met. 

When you select the Agent Management Work Flow node, the Work Flow window 
appears (Figure 65).

Unlike rules in voice contact work flows, rules in agent management work flows can be 
applied only to a time of day event, not to all events.

Not all actions are available for agent management work flows. See "Action 
Availability" on page 132 for more information.

Figure 65. Work Flow window
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To set up a CAD Agent activity or agent state work flow:

1. Select the event that triggers the work flow from the Event pane. The available 
events are:

— Startup. Agent Desktop/CAD-BE starts.

— Shutdown. Agent Desktop/CAD-BE closes.

— Logged in. The agent logs into Agent Desktop/CAD-BE.

— Logged out. The agent logs out of Agent Desktop/CAD-BE.

— Ready. The agent transitions to the Ready state.

— Not Ready. The agent transitions to the Not Ready state.

2. Under the Actions pane, click Add to choose one or more actions to run when 
the selected event occurs. You can select an existing action, or create a new 
action. See "Creating Actions" on page 131 for more information.

3. Repeat steps 1 and 2 for as many events as desired. 

4. When you are finished associating events with actions, click Apply to save the 
agent management work flow.

To set up a time of day work flow:

1. Select the Time of day event from the Event pane. 

2. Under the Rules pane, click New to set up a new rule. The New Rule Name 
dialog box appears. 

3. Enter the name of the new rule, then click OK. The fields in the Current Rule 
Conditions section of the window are enabled, and the Time of Day Condition 
dialog box appears (Figure 66).

Figure 66. Time of Day Conditions — Days of the week (left) and Date (right)
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4. Set up the day or date conditions for the rule, then click OK. The condition you 
set up is automatically entered in the first Data Field Conditions line in the 
Current Rule Conditions section of the Work Flow window, and the Enable 
Rule check box is automatically selected.

a. To specify that an action takes place every week on certain days or at a 
certain time, select Day(s) of the week and then check the desired days. 
You must specify a time of day as well.

b. To specify that an action takes place on a specific date, select Date, and 
then select the desired date from the calendar. Today’s date is circled in 
red. You must specify a time of day as well.

5. Click Edit next to the 2 remaining Data Field Conditions fields to further define 
the rule, if desired: 

■ Specify if the agent is on hook or off hook

■ Specify if the agent state is or is not equal to Ready or Not Ready

6. Under the Actions pane, click Add to choose one or more actions to run when 
the event occurs and the rules are met. 

You can select an existing action, or create a new action. See "Creating 
Actions" on page 131 for more information.

7. Click Apply to save the new time of day work flow.

Figure 67. State Condition dialog box
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Creating Actions

Actions are stored independently of events and rules. You can use an action in more 
than one event, and you can assign actions to more than one task button in Agent 
Desktop and CAD-BE.

While actions are processed, events are queued. It is generally a good idea to avoid 
long actions. Table 14 summarizes the availability of each action for agents who use 
Agent Desktop and agents who use CAD-BE. The symbol “×” indicates the action is 
available, and the symbol “—” indicates the action is not available. 

Table 14. Actions and their availability to agents who use Agent Desktop and CAD-BE 

Action Type and Description
Agent

Desktop CAD-BE

Importing and Exporting Actions (page 134). Displays a popup 
message on the agent’s desktop.

× —

Creating Agent State Actions (page 139). Sets an agent state. × —

Creating Call Control Actions (page 141). Answers, drops, 
conferences, transfers, or makes a call, or inputs touch tones 
during a call.

× —

Creating Delay Actions (page 142). Adds delay time between 
actions in a series of actions.

× —

Creating HTTP Actions (page 142). Enables the Agent 
Desktop integrated browser to interact with a web 
application. 

× ×

Creating IPC Actions (page 149). Passes enterprise data or 
user-defined data from the agent desktop to a custom 
third-party application.

× —

Creating Launch External Application Actions (page 151). 
Starts a third-party application.

× —

Creating Run Macro Actions (page 153). Plays back a 
recorded sequence of keystrokes.

× —

Creating Set Enterprise Data Actions (page 161). 
Automatically changes an enterprise data field in Agent 
Desktop to a selected desktop variable or static text.

× —

Creating Timer Actions (page 163). Triggers actions after a 
specified time has elapsed.

× —
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Action Availability

Not all actions are available for all events or for all types of agents. Table 15 shows 
which actions are available for the three types of work flows and for each type of agent 
(Agent Desktop agents and CAD-BE agents). The symbol “×” indicates the action is 
available, and the symbol “—” indicates the action is not available. 

Utility Action (page 164). Run a utility, such as start and stop 
recording or sending a predefined, high-priority chat message 
to a supervisor.

× ×

Table 14. Actions and their availability to agents who use Agent Desktop and CAD-BE — 

Action Type and Description
Agent

Desktop CAD-BE

Table 15. Action availability per work flow type and agent type 

Action Type

Voice Contact Agent Mgmt Time of Day

Agent
Desktop CAD-BE

Agent
Desktop CAD-BE

Agent
Desktop CAD-BE

Agent Notification × — × — × —

Agent State × — — — × —

Call Control × — — — — —

Delay × — × — — —

HTTP × × × — × —

IPC × — × — — —

Launch External 
Application

× — × — — —

Run Macro × — × — — —

Set Enterprise 
Data

× — — — — —

Timer × — — — — —

Utility × × — — — —
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Adding a New Action

To add a new action:

1. Access the Voice Contact Work Flow or Agent Management Work Flow window.

2. Select the event to be associated with the new action.

3. Under the Actions pane, click Add. The Select Action dialog box appears 
(Figure 68).

4. Choose the tab for the type of action you want to associate with the event. 

5. If the action already exists, select it, then click OK. If the action does not yet 
exist, click New, then follow the instructions for setting up that type of action 
as outlined below.

6. Click OK. The Select Action dialog box closes and you return to the Work Flow 
window. The new action is listed in the Actions pane.

Figure 68. Select Action dialog box
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Editing an Action

To edit an action:

1. In the Work Flow window, select the appropriate event, and then select the 
action you want to edit from the Actions pane. 

2. Click Edit. The edit dialog box for that action appears.

3. Make your changes, and then click OK. The action is now changed.

Deleting an Action

To permanently delete an action, you must first delete it from any event it is 
associated with, and then delete the action itself. 

To permanently delete an action:

1. In the Work Flow window, select an event.

2. If the action you want to delete is associated with the event, select the action 
in the Action pane, then click Delete to remove the action from the event. 

3. Repeat steps 1 and 2 for all of the other events. The action is now removed 
from all events.

4. Under the Actions pane, click Add. The Select Actions window appears.

5. Choose the appropriate tab, and then select the action you want to delete.

6. Click Delete. The action is deleted.

7. Click Cancel. The Select Action window closes, returning you to the Work Flow 
window.

Importing and Exporting Actions

You can export actions associated with a specific work flow group and import them to 
other work flow groups. The actions are exported to any location you choose, locally or 
on a network drive. 

NOTE:  If you export actions to the default location on your PC, which 
is C:\Program Files\Cisco\Desktop\config\Action, the actions will be 
lost if a client desktop is reinstalled. To avoid this issue, export 
actions to a folder that is not in the CAD installation directory (which is 
C:\Program Files\Cisco\Desktop).

The actions you export can be imported by other instances of Desktop Administrator, 
belonging to your system or any other system, as long as those instances are the 
same version of Desktop Administrator and can access the file storage folder.
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Types of actions that can be exported and imported are:

■ Run Macro action

■ HTTP action

■ IPC action

■ Launch External Application action

The rules and events associated with the actions are not part of this function and 
cannot be exported or imported. 

You can export only one action at a time. For example, if there are five actions you 
want to export from a work flow group, you must export each action individually. 

You can add a description (limited to 255 characters) to the exported action for easier 
identification when importing to another work flow group. 

If an imported action has the same name as an action already present in the work 
flow group, you will be prompted to rename the imported action.

To export a work flow action:

1. Select the work flow group whose action you want to export. The Import Export 
Work Flow Actions window appears (Figure 69). The Import and/or Export 
buttons are enabled only if there are actions available for import/export.

Figure 69. Import Export Work Flow Actions window
January 16, 2013 135



Cisco Desktop Administrator User Guide
2. Click Export. The Export Action dialog box appears (Figure 70).

3. Select the action you want to export from the Action List, then complete the 
fields in the dialog box.

■ Folder Path. Select the default path shown or browse to any other local or 
network folder location.

■ Description (optional). Enter a description of the action. Maximum length 
of the description is 255 characters.

4. Click OK.

Figure 70. Export Action dialog box
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To import a work flow action:

1. Select the work flow group to which you want to import an action. The Import 
Export Work Flow Actions window appears (Figure 69). 

2. Click Import. The Import Select dialog box appears (Figure 71).

3. Navigate to the folder where actions are stored. The field is autofilled with the 
default path.

4. From the Action Names list, select the action you want to import to the work 
flow group. You can import only one action at a time. 

5. Click OK.

Figure 71. Import Select dialog box
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Creating Agent Notification Actions

An Agent Notification action displays a custom message popup window on the agent’s 
desktop when a certain event occurs. For instance, when an agent logs out, a popup 
window reminding the agent to complete his time card could pop up on his desktop.

To set up an Agent Notification action:

1. Set up a new action. (For instructions, see "Adding a New Action" on 
page 133.) The Select Action window appears.

2. Select the Agent Notification tab, and then click New. The Agent Notification 
Action Setup dialog box appears (Figure 72).

3. Type an action name, select an icon for the popup window, type a message, 
then click Preview (Figure 73). A preview of your popup window appears.

NOTE: The title bar on the actual popup window might contain truncated text, 
because Windows automatically adds “Cisco Agent Desktop” to the beginning 
of the title bar text and the popup window does not resize.

4. Click OK.

Figure 72. Agent Notification Action Setup dialog box

Figure 73. Preview of an Agent Notification popup window
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Creating Agent State Actions

An Agent State action enables you to select an agent state to associate with an event. 
Agent State actions can be associated only with Answered and Dropped events. The 
only valid agent states are Ready, Not Ready, Work Ready, and Work Not Ready.

NOTE:  You can associate agent states with the Dropped event, but 
any agent state transitions configured in Unified ICM will probably 
take precedence over the agent state action you configure here. 

To set up an Agent State action:

1. Set up a new action. See "Adding a New Action" on page 133. The Select 
Action window appears.

2. Select the Agent State tab, then click New. The Agent State Action Setup box 
appears (Figure 74).

3. Enter a name for the action, select the agent state control from the drop-down 
list, then click OK.

Automated Reason Codes for Agent State Changes

You can enable automated reason codes when you set up an agent state action for 
transitioning to Logout or Not Ready. 

If you enable automated reason codes, the agent does not have to choose the 
appropriate reason code when an agent state action to transition to Logout or Not 
Ready is triggered.

To enable automated reason codes

1. Set up a new Agent State action ("Creating Agent State Actions" on page 139) 
or edit an existing Agent State action ("Editing an Action" on page 134). 

Figure 74. Agent State Action Setup dialog box
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2. In the Agent State Action Setup dialog box, type a name for the action and 
select AgentNotReady or AgentLogout from the Agent State Control drop-down 
list. The Automate Reason button appears in the dialog box (Figure 75). 

3. Click Automate Reason. The Select Reason dialog box appears (Figure 76).

4. Select a reason code to be entered automatically when the action is triggered, 
then click OK. The Select Reason window closes and the Agent State Action 
Setup window displays the number of the selected reason code next to the 
Automate Reason button.

NOTE: Selecting “Agent will choose” forces the agent to enter a reason code.

5. Click OK. 

Figure 75. Agent State Action dialog box with Automate Reason button

Figure 76. Select Reason dialog box
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Creating Call Control Actions

You can associate an event or a task button with a call control action, such as blind 
transferring a call to an agent’s supervisor. Call control actions include:

■ Blind conference

■ Blind transfer (includes a configurable delay time)

■ Supervised conference

■ Supervised transfer

■ Call

■ Drop

■ Touch tones

■ Answer

NOTE:  A work flow to answer calls on a Ringing event cannot be used 
by mobile agents in Call-by-Call mode, as they answer calls manually.

The blind conference action requires one or more rules that define when the action 
should be executed (for example, incoming calls from a route point). If the action does 
not have any rules, it will be executed every time the event with which it is associated 
occurs. For example, if you create a blind conference action on an answered event 
without any rules, the action will be executed for every answered call.

To set up a Call Control action:

1. Set up a new action (see page 133). The Select Action window appears.

2. Select the Call Control tab, then click New. The Call Control Action Setup 
window appears (Figure 77).

Figure 77. Call Control Action Setup window
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3. Type a name for the call control action, select an action from the Call Control 
drop-down list, then type a phone number, if required. For example, for a Blind 
Transfer, type a phone number to which the call is transferred.

4. Click OK.

Creating Delay Actions

Delay actions are used to add delay time between actions in a series of actions. For 
example, you can add a delay action between two macros in a work flow. 

To set up a Delay action:

1. Set up a new action (see page 133). The Select Action window appears.

2. Select the Delay Action tab, then click New. The Delay Action Setup window 
appears (Figure 78).

3. Type a name for the delay action and the length of delay time in milliseconds. 
If you want events to be processed in the background during the delay, select 
the Process Events During Delay check box. Click OK.

Creating HTTP Actions

HTTP actions enable an agent to use call-based data to interact with a website or a 
web application in the Integrated Browser window. For example, an HTTP action can 
be set up so the enterprise data of an incoming call is used to retrieve a customer 
record and display it in the Integrated Browser. 

NOTE:  For more information about HTTP requests and the HTTP 
protocol, see the World Wide Web Consortium website, www.w3.org.

Figure 78. Delay Action Setup window
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The Post and Get HTTP actions are available to agents who use Agent Desktop at the 
Premium level. The Get HTTP action is available to agents who use CAD-BE at the 
Enhanced and Premium levels.

NOTE:  A URL with arguments is limited by the HTTP service to a 
maximum of 2075 characters. If you create an HTTP action that 
results in a longer URL, the action will not work correctly. 

To set up an HTTP action:

1. Set up a new action (see page 133). The Select Action window appears.

2. Select the HTTP Action tab, then click New. The HTTP Actions Setup window 
appears (Figure 79).

Figure 79. HTTP Action Setup window
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3. Complete the HTTP Actions Setup dialog box as follows:

4. Click Add to display the HTTP Request Data dialog box (Figure 80).

The fields added with this dialog box make up the query or post data portion 
of the request. The fields are optional and are blank by default.

Field Description

Action Name The new action name.

Protocol The protocol to be used: http (default) or https.

Method The http method to be used: GET (default, Agent Desktop 
and CAD-BE) or POST (available in Agent Desktop only).

Host The website host name or IP address. Omit the protocol.

Port The port (0–65535) that the host is listening on. The 
default for http is 80. The default is 443 for https.

Path Optional. The path portion of the URL. Default is blank. Do 
not include a leading slash.

Browser Tab The browser tab in which you want the action results to be 
displayed. If the tab you select is removed later, the action 
will be displayed in the first tab (ordinarily reserved for 
supervisor page push). This field is not present In CAD-BE, 
since CAD-BE only has 1 tab. 

Figure 80. HTTP Request Data dialog box
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5. Complete the HTTP Request Data dialog box as follows:

6. Continue to build your request using the Add, Edit, and Delete buttons.

7. When you have completed building the request, click Preview to view the 
request. Note that Desktop Administrator has added the special characters 
needed for a valid HTTP request. Supported formats are as follows:

■ If a path is specified and there is request data, there will be a “/” after the 
port and a “?” after the path.

Example: http://www.site.com:80/index.jsp?name=value

■ If a path is not specified, there is request data, and the first request data 
is not DataFieldOnly, there will be a “?” after the port and no “/”.

Example: http://site.com:80?name=value

■ If a path is not specified, there is request data, and the first request data 
is DataFieldOnly, there will be a “/” after the port and no “?”.

Example: http://www.site.com:80/value

■ If a path is not specified, there are several request data, and the first 
request data is DataFieldOnly, there will be a “/” after the port and no “?”.

Example: http://www.site.com:80/value&value&value…

8. When you are satisfied your request is correctly formatted, click Test to test it 
using the test data you entered when adding the request data.

Field Description

Value Name Enter the name of the field in the web application.

Value Type One of the following:

• DataField: An enterprise data variable is the source of 
the data. Uses the format <name>=<value>.

• UserDefined: A specific string entered in the Value field. 
Uses the format <name>=<value>.

• DataFieldOnly: Any value from the Value drop-down list. 
Does not use the format <name>=<value>.

Value If Value Type is UserDefined, the actual value. If Value Type 
is DataField or DataFieldOnly, the enterprise data variable. 

Test Data A string to simulate DataField or DataFieldOnly data. 
Enabled only if Value Type is DataField or DataFieldOnly.
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Reserved Characters

Table 16 lists the reserved characters. Reserved characters must not be used in an 
HTTP request.

Table 16. Reserved characters

Symbol Name Symbol Name Symbol Name

& Ampersand “ Double quote # Pound sign

@ At sign = Equal sign ? Question mark

\ Back slash ! Exclamation 
point

> Right angle 
bracket

^ Carat < Left angle 
bracket

] Right square 
bracket

: Colon [ Left square 
bracket

; Semi-colon

, Comma % Percent ‘ Single quote

$ Dollar sign + Plus / Slash
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Example of an HTTP Request

The following procedure shows how to create an HTTP request using Google search 
engine to search for “Cisco Systems.”

To learn what value names and values go into the Google search:

1. Open your web browser and navigate to www.google.com.

2. Type Cisco Systems in the search field, then click Google Search. The address 
bar shows the HTTP request that we will create (Figure 81).

3. The Address bar displays the following string, containing the host and path, 
then a question mark, then the request data, separated by ampersands (&). 
The request data and values are user defined. The value name is on the left 
side of the equal sign, and the value is on the right side of the equal sign.

www.google.com/search?ie=UTF-8&oe=UTF-8&sourceid=gd&q=Cisco+
Systems&wxob=0

Figure 81. Google Search results page

Name Value

Host www.google.com

Path search

Browser Tab HTTP Web Browser Tab 1

Request Data ie=UTF-8
oe=UTF-8
sourceid=gd
q=Cisco+Systems
wxob=0
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To create the HTTP request:

1. Complete the HTTP Actions Setup dialog box with the information you 
gathered from the manual Google search (Figure 81). 

NOTE: Google inserted a plus sign (+) between the words “Cisco” and 
“Systems” in the request string. When you enter the request data, you can 
omit that character. Desktop Administrator will automatically add the 
characters that indicate a space.

2. After you enter the request data, click Preview to view the resulting string. It 
should be identical to the string displayed in the Google search results 
address bar. If you typed a plus sign between the words Cisco and Systems, 
the string will contain “%2B” instead of a plus sign. If you typed a space, the 
string will contain “%20”. Both strings indicate a space and are acceptable 
substitutes for the plus sign.

3. Click Test to test your HTTP request. The request should open your browser, 
navigate to the Google Search page, and run a search for “Cisco Systems”.

Figure 82. Google Search HTTP Action Setup dialog box
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Creating IPC Actions

This action is available to agents using Agent Desktop at the Premium level.

IPC actions pass information in the form of UDP (user datagram protocol) messages 
from Agent Desktop to a third-party application using IPC (interprocess 
communication) methods. The third-party application can be located on the agent’s 
PC or anywhere on the network.

NOTE:  The third-party application must be coded specifically to listen 
for data sent to a specific IP address and port.

An IPC action is one-way—that is, when Agent Desktop sends data using an IPC action, 
it does not receive a response or any acknowledgement that the message was 
received by the recipient third-party application.

The data sent is enterprise data or user-defined data. It is sent in the format:

valuename=value&name=value&name=value…

To set up an IPC action:

1. Set up a new action (see page 133). The Select Action window appears.

2. Select the IPC Action tab, then click New. The IPC Action Setup window 
appears (Figure 83).

Figure 83. IPC Action Setup window
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3. Complete the fields in the IPC Action Setup window as follows:

4. Click Add to display the IPC Request Data dialog box (Figure 84). The fields 
added with this dialog box make up the query portion of the request. 

5. Complete the IPC Request Data dialog box as follows:

6. Continue to build your request using Add, Edit, and Delete as needed.

7. When you have completed building the request, click OK.

Field Description

Action Name The name for the new action.

Protocol The default (and only) protocol is UDP.

IP Address The IP address of the third-party application that listens.

Port The port on which the third-party application listens.

Figure 84. IPC Request Data dialog box

Field Description

Value Name The name of the field.

Value Type The source of the data. DataField indicates an enterprise 
data variable. UserDefined indicates a specific string 
entered in the Value field.

Value If the Value Type is DataField, the enterprise data variable. 
If the Value Type is UserDefined, the value to be used.
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Creating Launch External Application Actions

Launch External Application actions start a third-party application in a new window. 

To ensure applications are running before macros attempt to use them, start them 
with launch actions assigned to the Startup event.

NOTE:  An application started by a launch action must use the same 
path on the agent’s PC as it does on the administrator’s PC or it must 
be on a network drive, or the launch action will not be successful.

When using launch actions, Agent Desktop can pass parameters such as command 
line arguments in two ways. 

The first method is to add parameters after the application path name. For example, 
the command to start Microsoft Excel and open a spreadsheet named mrmtest.xls is:

“c:\program files\excel.exe” “c:\my documents\mrmtest.xls”

NOTE:  Program names and command line arguments that contain 
spaces must be in quotes so that they appear as one argument rather 
than as multiple arguments.

The second method involves passing data fields as arguments. You can pass any valid 
data field while launching an application. 

NOTE:  If a launch action takes place on the Startup event, call data 
might not be present. Empty data fields will contain the string 
<NULL>.
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To set up a Launch External Application action:

1. Set up a new action (see page 133). The Select Action window appears.

2. Select the Launch External Application Action tab, then click New. The 
Launching External Application Action Setup window appears (Figure 85).

3. Type an action name and the path to the location of the desired application. 
Ensure that the application is in a location that is available to Agent Desktop 
at runtime.

4. Add any arguments you wish to pass to the application. Choose the desired 
argument in the Available Arguments list, and use the left arrow to add it to 
the Argument list. Use the up and down arrows to reorder the Argument list.

5. When you have finished entering information, click OK. 

For more examples of setting up this type of action, see "Setting Up a Launch External 
Application Action" on page 236.

Figure 85. Launching External Application Action Setup window
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Creating Run Macro Actions

A macro is a shortcut for a sequence of keystrokes. For example, you might record a 
macro that performs the following tasks with each incoming call:

1. Copy the ANI (Automatic Number Identification) from Agent Desktop to 
Microsoft Outlook.

2. Open a contact list.

3. Find the ANI in a database or spreadsheet.

4. Display a screen containing the caller’s account information.

NOTE:  Do not use a Run Macro action for tasks that can be done with 
another action type. For example, use a Call Control action to transfer 
a call, and an Agent State action to change agent states.

NOTE:  Run Macro actions do not work correctly when using Chinese 
and Korean characters (and potentially any multi-byte characters). 

For examples of creating macros, see Appendix C, "Tutorials" on page 217.

Macro Recording Tips

If your macro accesses a third-party application, make sure that the application is 
open. If the macro enters text into the third-party application, make sure that 
application has Windows focus. 

Keystroke macros play back to the top level window they were recorded in. If you are 
running a keystroke macro to a Terminal Services window, you must make sure that 
the appropriate application in that Terminal Services window always has focus, 
otherwise the keystrokes will be sent to the wrong application.

Before you begin to record the macro, make a test run with the third-party application, 
writing down all of the keystrokes required for the tasks you wish to perform.

Use keyboard shortcut keys to perform actions in the application. Avoid using the 
following actions in a macro.

■ Tab or arrow keys, because the cursor might not be in the same place every 
time a window opens

■ Mouse clicks and movements, because they are not recorded

NOTE:  The execution of a macro can be affected by the client PC 
keyboard settings. Ensure that keyboard settings, such as Caps Lock, 
are not inadvertently left on. Warn agents not to enter keystrokes 
while a macro is running, since that can affect the macro.
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Shortcut keys are indicated by an underlined letter in the button name, field name, or 
description. To perform the action, press Alt, Ctrl, or Shift plus the underlined letter. 
Pressing Alt+E clicks the Edit button (Figure 86).

The exact keystrokes for a keyboard shortcut are listed in the application’s menu. For 
instance, in Microsoft Word, to find out what the shortcut is to save a document, 
choose File from the menu bar. On the drop-down menu the Save option is followed by 
its shortcut, Ctrl+S.

Table 17 lists common Windows shortcuts.

A macro can include keystrokes for multiple applications. For example, one macro can 
include keystrokes for word processing, spreadsheet, and database applications. To 
switch between applications when recording a macro, use the mouse to select the 
application. Do not press Alt+Tab. If you do, these keystrokes are recorded and might 
not select the correct application when you play back the macro.

NOTE:  Do not press Ctrl+Esc to click the Microsoft Windows Start 
button, or the Macro Recorder stops recording without providing a 
message showing that recording has stopped. All keystrokes recorded 
up to this point are deleted. To click Start without causing an error or 
stopping recording, use your mouse.

Figure 86. Letter E is the shortcut key for Edit.

Table 17. Windows shortcuts 

Shortcut Description

Esc Cancels an action.

Enter Clicks OK or the default button in a dialog box. (Default buttons are 
surrounded by a heavier border.)

Ctrl+A Selects all text.

Ctrl+C Copies selected text to the clipboard.

Ctrl+P Prints the document.

Ctrl+S Saves the document.

Ctrl+V Pastes text into the window at the cursor position.

Ctrl+X Cuts selected text to the clipboard.
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Allowed Macro Keystrokes

Table 18 lists the keystrokes that are allowed in macros.

Table 18. Allowed Macro Keystrokes—Keys 

Key Type Key Macro Notation

Character 0 1 2 3 4 5 6 7 8 9

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

* + ; = , - . / ` [ \ ] '

Non-Character Tab [TAB]

Backspace [BACKSPACE]

Enter/Return [ENTER]

Shift [SHIFT]

Control/Ctrl [CONTROL]

Alt [ALT]

Pause/Break [PAUSE]

Caps Lock [CAPSLOCK]

Esc [ESC]

Space/Space Bar [SPACE]

Page Up/PgUp [PAGE-UP]

Page Down/PgDn [PAGE-DOWN]

End [END]

Home [HOME]

Left Arrow [LEFT-ARROW]

Up Arrow [UP-ARROW]

Right Arrow [RIGHT-ARROW]

Down Arrow [DOWN-ARROW]

Print Scrn [PRINTSCREEN]

Insert [INSERT]

Delete [DELETE]

F1 through F24 [F1] … [F24]
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Table 19 lists the special commands that are allowed in macros.

Recording Macros

To record a macro:

1. Start and minimize any third-party applications you want in the macro.

2. Set up a new action. For instructions, see "Adding a New Action" on page 133. 
The Select Action window appears.

3. Select the Run Macro tab, then click New. The New Macro dialog box appears.

4. Enter a name, then click OK. The Macro Editor window appears. Figure 87 
shows the Macro Editor window with a macro named “Ringing Macro.”

Table 19. Allowed Macro Special Commands

Special Command Description

[ENTERPRISE FIELD:] Inserts an Enterprise Data field.

[DATA FIELD:] Inserts data from Agent Desktop.

[SYSTEM FIELD:] Inserts data from Agent Desktop system fields.

[APPLICATION:=] Changes focus to an application window. The equals sign 
(=) separates the application name and window title. If 
either the application name or window title is missing, 
Agent Desktop attempts to find the correct application and 
window to play the macro to, based on the parameters.

[DELAY] Time, in milliseconds, to wait before performing the next 
macro command. For example: [DELAY] 1000 delays the 
next macro key or command by 1 second.

Figure 87. Macro Editor window
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5. Click Record. The Macro Editor window minimizes and the macro recorder 
starts. Anything you type from now on is entered in the new macro.

6. Maximize the third-party application and begin typing.

7. If you want to insert a data field, press the Pause Macro hot key (the default 
is F2). The Macro Recorder Suspended dialog box appears (Figure 88). 

NOTE: Do not change the focus from the third-party application to the macro 
recorder before pressing the Pause Macro hot key. If you do, an error message 
will appear, interrupting your macro recording.

8. Click Insert Data. The Select a Data Field dialog box appears (Figure 89). For 
more information, see "Data Fields" on page 158.

Figure 88. Macro Recorder Suspended dialog box

Figure 89. Select a Data Field dialog box
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9. Choose the desired data field from the list, enter test data if desired, then 
click OK. The test data you enter is displayed in the application only when the 
macro is tested using the Playback function. The Macro Recording Suspended 
dialog box appears.

10. Click Resume Recording to continue recording the macro.

11. Once you have finished recording the macro, press the macro hot key. The 
Macro Recording Suspended dialog box appears.

12. Click End Recording. You are returned to the Macro Editor window. 

13. You can take any of the following actions:

■ To save the macro as recorded, click OK.

— If the macro has no errors, the macro is saved and you are returned to 
the Select Action dialog box. 

— If the macro has errors, the macro editor displays the line and 
highlights the text in question. Correct it and click OK again. 

■ To test the macro, click Playback.

— If the macro has errors, the macro editor displays the line and 
highlights the text in question. Correct it and click Playback again.

— If the macro has no errors, the macro is played back. If it works as you 
intend, click OK to save it and return to the Select Action dialog box.

■ To change test data, choose Data > Change Test Data in the macro editor 
and enter new test data.

■ To cancel the macro, click Cancel. The macro is canceled and the Select 
Action dialog box appears.

Data Fields

The Select a Data Field dialog box (Figure 89) enables you to select and insert a Agent 
Desktop data field into a macro. Access this dialog box either through the Suspend 
Macro Recording dialog box or from the Data menu in the Macro Editor window.

There are three types of data fields, which can be included in the Run Macro and 
Launch External Application work flow actions.

■ Standard. Data from the switch.

■ System. For example, the date and time. Enclosed in square brackets [ ].

■ Enterprise. From the Enterprise service. Marked with an asterisk (*).

NOTE:  Not every data field is available for every event. For example, 
the calling number is not available during a startup event. If a macro 
uses an unavailable field to pop an application, the application 
displays <N/A>.
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Table 20 lists the available data fields.

Table 20. Enterprise Data Fields 

Data Field Description

*Account Number Customer’s account number.

*Alerting Number Number of ringing device.

*ANI Number of the phone that made a call.

*Application Data ISDN user-to-user information element.

*BAAccountNumber Outbound Dialer: Customer’s account number.

*BABuddyName Outbound Dialer: Customer's first and last name, 
separated by a comma.

*BACampaign Outbound Dialer: Name of campaign to which the call 
belongs.

*BADialedListID Outbound Dialer: Unique key identifying a specific 
customer record in the Dialing_List table in the BA 
private database.

*BAResponse Outbound Dialer: Multi-purpose variable that sends 
data from Agent Desktop to the BA Dialer. Variable 
responds to the reservation call, schedule and cancel 
callbacks, and changes to the callback number.

*BAStatus Outbound Dialer: Two characters indicating mode and 
direction of the BA Dialer-initiated call. The first 
character identifies the call mode:

• R: Reservation call, Predictive or Progressive 
mode

• P: Reservation call, Preview mode

• C: Customer call

• A: Reservation call, personal callback

During a reservation call, the first character is P, R, or 
A. When a customer call is transferred to an agent, 
the first character is C.

The second character of BAStatus indicates call 
direction:

• O: Outbound

• I: Inbound

• B: Blended
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*BATimeZone Outbound Dialer: Indicates the GMT offset, in 
minutes, for the customer’s time zone and obtains 
the customer’s local time. The format is either a 
positive or negative sign, followed by 5 digits 
(+/-#####). For example:

• If customer is one hour behind GMT:

BATimeZone = -00060

• If customer is two hours ahead of GMT:

BATimeZone = +00120

*Call Duration Difference between the call’s end time and start time. 
The time is read from the Enterprise server clock.

*cisco.com.Category Reserved for future use.

*cisco.com.MessageKey Reserved for future use.

*cisco.com.Priority Reserved for future use.

*Collected Digits Digits entered by the caller in response to IVR 
prompting.

*DNIS Number of the phone that received a call.

*ICM Call Variable 1…
*ICM Call Variable 10

Call-related variable data. Ten variables are available.

*Last Called Number Last number dialed.

*Last Calling Number Last device that made a call.

*Last Connected Number Last monitored device that joined the call.

*Last Queued Time Time spent in queue the last time the call was 
queued. Time is read from the Enterprise server 
clock.

*Last Redirection Number Last number from which the call was redirected.

*Layout Name of the enterprise data layout.

*Trunk ID Device ID of the trunk.

*UCID Not applicable.

[AGENT_ID] Agent’s identification.

Table 20. Enterprise Data Fields — Continued

Data Field Description
160 January 16, 2013



Creating Actions
Creating Set Enterprise Data Actions

This action enables you to set an enterprise data field variable in the Agent Desktop 
enterprise data pane to a desktop variable or static text of your choosing. 

The action is available only for the Ringing and Answered events. 

NOTE:  Do not include a Set Enterprise Data action in the same work 
flow as the following Call Control actions: supervised transfer, blind 
transfer, conference, or blind conference. This can cause a critical 
race condition that results in the enterprise data not being available.

[CALL_DURATION] Difference between the call’s end time and start time. 
The time is read from the agent’s PC’s clock.

[CALL_END_TIME] End time of the current call. If the call has not yet 
ended, it is the current time. The time is read from the 
agent’s PC clock.

[CALL_START_TIME] Start time of the current call. If no call exists, this field 
is empty. The time is read from the agent’s PC clock.

[COMPUTER_NAME] Name of computer the agent is currently logged on to.

{LOCAL_PHONE_EXT] Agent’s extension.

Alerting# Number of the ringing phone.

Called# Number of the phone that received a call.

Calling# Number of the phone that made a call.

Original Called# Original number that received a call.

Original Calling# Original number that made a call.

Table 20. Enterprise Data Fields — Continued

Data Field Description
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To set up a Set Enterprise Data action:

1. Set up a new action (see page 133). The Select Action window appears.

2. Select the Set Enterprise Data tab, then click New. The Set Enterprise Data 
Action Setup Editor window appears (Figure 90).

3. Complete the fields as follows:

4. Click OK.

Figure 90. Set Enterprise Data Action Editor window

Field Description

Action Name Name for the new action.

Enterprise Data 
Field to Set

Enterprise variable that you want to set. Only 
Unified ICM call variables and user-created ECC 
variables are available for selection from the 
drop-down list. 

Source for the Data (choose one)

Desktop Variable Name of desktop variable to use for the value of the 
enterprise data field. Choices are Agent ID, System 
Name, System Time, and Skill Group.

Static Text Static text to use for the value of the enterprise data 
field. Maximum length is 210 characters. 
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Creating Timer Actions

The timer action triggers Agent State, HTTP, Agent Notification, or Set Enterprise Data 
actions after a given amount of time has elapsed under certain circumstances. For 
instance, you can configure the Timer action to change an agent’s state to Ready if 
the agent’s state has been Work Ready state for 3 minutes. This action is available to 
agents using Agent Desktop at the Enhanced and Premium levels. 

To set up a timer action:

1. Set up a new action (see page 133). The Select Action window appears.

2. Select the Timer Action tab, then click New. The Timer Action Setup window 
appears (Figure 91).

3. Complete the Timer Action Setup window as follows:

Figure 91. Timer Action Setup window

Field Description

Action Name Name for the new action.
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4. Click Add to select the actions to be executed when the timer has expired.

5. When you are finished configuring the Timer Expiration Work Flow, click OK.

Utility Action

There are three utility actions:

■ Start recording

■ Stop recording

■ Send a predefined, high-priority chat message to the agent’s supervisor

Timer Duration Amount of time the agent must spend in the selected 
agent state before the action executes.

Timer expiration work flow setup

Agent state is Optional. Agent state must be equal to/not equal to 
Ready/Not Ready.

Actions Actions that will execute after timer duration expires.

Field Description
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High Priority Chat Messages

A high priority chat message is a predefined message that appears in a supervisor’s 
Chat window (Figure 92). The message behaves just like a regular chat message that 
is tagged as high priority—it pops up on the supervisor’s screen on top of all other 
windows to attract the supervisor’s attention.

You can configure a task button on the Agent Desktop toolbar to send such a message 
from an agent to the agent’s supervisor(s).

NOTE:  Agents who use CAD-BE can send a high priority chat message 
to their supervisor, but the supervisor cannot reply to the message, 
because CAD-BE does not have chat capability.

Figure 92. Sample high-priority chat message
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To set up a utility action:

1. Set up a new action (see page 133). The Select Action window appears.

2. Select the Utility Action tab, then click New. The Utility Action Setup window 
appears (Figure 93).

3. Type a name for the new action, select an action type from the drop-down list, 
then click OK.

■ If you select Record as the action type, select Start or Stop from the 
Action field. 

■ If you select HighPriorityChat, type the message you want to send as the 
predefined, high-priority chat message in the Message field.

NOTE:  When the dialog box initially opens, only the Action Name and 
Action Type fields are visible. When you choose the Record action 
type, the Action field appears. When you choose the High Priority 
Message action type, the Message field appears.

NOTE:  If a Record action is part of a voice contact work flow, the 
agent being recorded will see a recording icon in the contact 
appearance pane even if notification is turned off. 

Figure 93. Utility Action Setup window
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Cisco Unified Outbound Dialer

Cisco Unified Outbound Dialer is a Unified ICM/Unified Contact Center Enterprise 
feature that enables automated outbound dialing to customers. These outbound calls 
appear as inbound calls to the agent, and information about the call appears in the 
Enterprise Data pane.

NOTE:  Unified Outbound Dialer is available only for Agent Desktop.

NOTE:  Cisco Unified Mobile Agent call-by-call mode does not support 
Outbound Dialer. Nailed mode does support Outbound Dialer.

A supervisor or administrator sets up a calling campaign in Unified ICM that consists 
of various elements that will present calls to agents and provide information so the 
agent can handle the call successfully. (See the Cisco ICM/IP Contact Center 
Enterprise Edition Setup and Configuration Guide for information on setting up calling 
campaigns.)

Outbound Dialer has four modes that determine what type of dialing is done to make 
the outbound calls:

■ Predictive Dialing Mode. In this mode, agents are reserved and a number of 
customers are dialed simultaneously. When a customer is contacted, the call 
is transferred to an available reserved agent. The customer’s data is 
displayed in the agent’s Enterprise Data window. Predictive dialing mode 
optimizes agent usage by calculating the average time an agent waits to 
receive a call and their average call handling time to determine the number of 
lines to dial per agent so that wait time is kept to a minimum.

■ Progressive Dialing Mode. This mode is similar to Predictive Dialing mode, 
except that the system does not calculate the number of lines to dial per 
agent. Rather, the user configures a fixed number of lines to be dialed per 
agent.

■ Preview Dialing Mode. In this mode, an agent is reserved and then presented 
with a call along with customer information in the Enterprise Data window. 
Based on this information, the agent can accept, skip, or reject the call. 

■ Direct Preview Dialing Mode. This mode is similar to Preview Dialing mode, 
except that the agent can categorize the phone call presented as Voice, 
Answering Machine, Invalid, and Fax Modem.

All four dialing modes use the personal callback feature. This features enables an 
agent to reschedule a customer call at the customer’s request for a more convenient 
time. Callbacks can be configured so that, when the call is redialed, the call is directed 
to any agent (regular callback) or the call is directed to the agent who made the 
callback reservation (personal callback). The callback type is configured at the 
campaign level and is not controlled by the agent. 
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Outbound Dialer Actions

Based on the enterprise data information, the agent selects the appropriate Outbound 
Dialer action button on the Outbound Dialer toolbar.

The available Outbound Dialer actions are:

■ Accept. The system dials the customer and connects the call to the agent.

■ Reject. The system rejects the current call and releases the agent from the 
outbound calling reservation. At this point, the system can deliver to the agent 
either another outbound call or a new inbound call.

■ Reject Close. The system rejects the current call and closes the record so the 
customer will not be called again.

■ Skip. The system skips the current call and presents the agent with another 
customer call.

■ Skip Close. The system skips the current call and closes the record so the 
customer will not be called again.

■ Skip Next. The system skips the call and displays a menu of these options: 

— Wrong Number. The agent is informed that the number called is a wrong 
number. After the call terminates, the system calls other customer phone 
numbers.

— Not Home. The agent is informed that the customer is not home. After the 
call terminates, the system calls other customer phone numbers.

■ Callback. Displays the Callback Properties dialog box, which the agent uses to 
set a time and date to call back the customer. This action is enabled only if 
the agent is in the talking or wrap-up agent state. The agent also uses this 
dialog box to cancel a previously-scheduled callback of the current customer. 
This action works only if the agent is in a talking or wrap-up state during a call 
generated by Unified ICM. 

■ Reclassify. Displays a menu that enables the agent to reclassify a customer 
phone number as voice, answering machine, fax/modem, or an invalid 
number.

■ Cancel Reservation. The system releases the agent from the calling campaign 
and places the agent in the Not Ready state. To resume participating in the 
calling campaign, the agent must change the agent state to Ready. 
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Outbound Dialer Toolbar

In order for the Outbound Dialer actions to be available for agents to use, you must 
configure the agent interface to include the Outbound Dialer toolbar. The dialing mode 
used in the calling campaign determines which buttons appear in the toolbar 
(Table 21).

Table 21. Outbound Dialer toolbar buttons and dialing mode in which they appear 

Icon Name Dir. Preview Predictive Preview Progressive

Accept × ×

Reject × ×

Reject Close × ×

Skip × ×

Skip Close × ×

Skip-Next × × × ×

Callback × × × ×

Reclassify ×

Cancel Reservation × × × ×
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To configure the Outbound Dialer toolbar to display in Agent Desktop:

1. In the User Interface window, select the Toolbar tab. 

2. In the Outbound Dialer Mode section, select the check box next to the dialing 
mode used by your calling campaign (Figure 94). The appropriate buttons are 
enabled in the button selection pane. 

3. Click Apply to save your changes. The Outbound Dialer toolbar will now appear 
on the Agent Desktop interface.

Figure 94. Toolbar tab of the User Interface window
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Outbound Dialer Enterprise Data

In order for Outbound Dialer enterprise data to appear in the Enterprise Data window, 
you must edit the Default layout to include some or all Outbound Dialer fields 
(Table 22). All Outbound Dialer fields are prefixed with the letters “BA”.

For information about editing the Default layout, see "Layouts" on page 59. 

Table 22. Cisco Outbound Dialer enterprise data fields 

Variable Comment

BAAccountNumber [200]

BABuddyName [201]

BACampaign [202]

BADialedListID [203] Required for Preview and Direct Preview dialing modes 
in order for the Skip function to work

BAResponse [204]

BAStatus [205] Required for all dialing modes. If this field is not 
included in the layout, no other Outbound Dialer fields 
will be displayed.

If a call is part of a Preview dialing mode campaign, the 
first letter in the BAStatus field entry is a P. If a call is 
part of a Direct Preview dialing mode campaign, the 
first letter is a D.

BATimeZone [206] Required for all dialing modes in order for the Callback 
function to work.
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Unified CCE Configuration
Introduction

The Unified CCE Configuration node enables you to configure the websites that 
supervisors use to dynamically re-skill their agents (Figure 95).

By default, the websites listed under Agent Re-Skilling are not configured. This node 
enables you to specify alternative websites to the default Cisco Unified Contact Center 
Enterprise Web Administration Agent Re-skilling website.

Figure 95. Unified CCE Configuration node
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Alternate Agent Re-Skilling Websites

You can specify two alternative agent re-skilling websites to appear in the Tools menu 
of Cisco Supervisor Desktop (Figure 96).

By default, these menu options both lead to the default Cisco Unified Contact Center 
Enterprise Web Administration Agent Re-skilling website on Unified ICM. 

To set up an alternative agent re-skilling website:

1. Under the Agent Re-skilling node, select Site 1 or Site 2. 

2. In the right pane, clear the Use Cisco’s Re-skilling tool check box. The URL 
field and Apply button are enabled.

3. Type the URL of the site you want supervisors to use, then click Apply.

NOTE:  You cannot change the display name. 

To remove an alternative agent re-skilling website:

1. Under the Agent Re-skilling node, select the site you want to use the default.

2. Select the Use Cisco’s Re-skilling tool check box, then click Apply.

Agent Re-skilling Notes

■ Website changes do not take effect until Supervisor Desktop is restarted.

■ Any URL you enter is not checked by the system for accuracy.

■ You can enter up to 256 characters in the URL field.

■ You can enter any type of URL (for example, http, https, file, or ftp).

Figure 96. Cisco Supervisor Desktop Tools menu
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Personnel Configuration
Introduction

You can use the Personnel Configuration application to view information about 
agents, supervisors, and teams within a logical contact center. You can also use 
Personnel Configuration to change supervisor passwords and to assign agents to 
workflow groups.

NOTE:  Some agent, supervisor, and team properties are configured 
in Cisco Unified Intelligent Contact Management (Unified ICM) and 
are only viewable, not editable, from within Desktop Administrator. 

The Personnel Configuration node has the following functions:

■ Configuring Agent Properties (page 176)

■ Configuring Supervisor Properties (page 180)

■ Viewing Team Information (page 182)
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Configuring Agent Properties

The Agents window (Figure 97) displays a list of all the agents configured in 
Unified ICM. From this window you can complete the following tasks.

■ Changing the Agent Login Method (page 177)

■ Viewing an Agent’s Properties (page 178)

■ Changing an Agent’s Work Flow Group (page 179)

NOTE:  You cannot change an agent’s ID, login name, display name, 
password, or team—that information is administered in Unified ICM.

Figure 97. Agents window
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Changing the Agent Login Method

The method that agents and supervisors use to log in is configured from the Agents 
window. You can set the method either to login by agent ID or login by agent name. 

NOTE:  When using System IPCC, the only option supported is login by 
agent name. If you are not using System IPCC, run CAD Configuration 
Setup and reset this option. For more information, see the Cisco CAD 
Installation Guide.

To change the agent login method:

■ Select either Agent ID or Agent Name to configure the information that agent 
must use to log into Agent Desktop. 

NOTE:  If an agent attempts to log in at the same time you change the 
login method, the agent will receive an error message. The agent 
must restart Agent Desktop and then use the new login method.

Configuring the Mobile Agent Mode

The Agent Desktop Agent Login window contains three fields: login name or ID, 
password, and extension (Figure 98). 

Depending on the CTI OS connection profile configuration, the login window can also 
include the Mobile Agent Mode check box. The registry value ShowFieldBit Mask 
indicates which fields are displayed in the login window. For more information, see 
“Defining Connection Profiles” in the CTI OS Configuration chapter of the CTI OS 
System Manager's Guide for Cisco ICM/IPCC Enterprise & Hosted Editions. 

Figure 98. Agent Login window
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Viewing an Agent’s Properties

To view an agent’s properties:

1. Select an agent from the list, then click Properties. The Agent Properties 
window appears (Figure 99).

2. Click OK to close the window after reviewing the agent’s properties.

Figure 99. Agent Properties window
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Changing an Agent’s Work Flow Group

An agent can belong to only one work flow group at a time. All agents are assigned to 
the Default work flow group until reassigned to another one.

To change an agent’s work flow group:

1. Select the agent from the agent list, then click Properties. The Agent 
Properties dialog box appears (Figure 100).

NOTE: You can also double-click or right-click the agent’s name to display the 
Agent Properties dialog box.

2. Select a work flow group from the drop-down list, then click OK. The agent is 
now assigned to the new work flow group.

Figure 100. Agent Properties dialog box

Field Description

ID Agent’s user ID for Agent Desktop/IP Phone Agent.

Login Name Agent’s login name.

Display Name Agent’s name, as seen in Agent Desktop/Supervisor 
Desktop.

Team Name Team to which the agent is assigned.

Work Flow Group Work flow group assignment that controls the agent’s 
desktop and work flow configurations.
January 16, 2013 179



Cisco Desktop Administrator User Guide
Configuring Supervisor Properties

The Supervisors window (Figure 101) displays a list of all the supervisors configured in 
Unified ICM. From this window you can select and view a supervisor’s properties. You 
can change the supervisor’s password from the properties dialog box. (Supervisors 
can also change their password in Supervisor Desktop.)

NOTE:  You cannot change a supervisor’s ID, login name, display 
name, or team—that information is administered in Unified ICM.

To view supervisor properties:

1. Select the supervisor from the supervisor list, then click Properties. The 
Supervisor Properties dialog box appears (Figure 102).

NOTE: You can also double-click or right-click the supervisor’s name to display 
the Properties dialog box.

2. Click OK to close the window after reviewing the supervisor’s properties.

Figure 101. Supervisor window
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Changing a Supervisor’s Password

Initially, a supervisor’s password is blank. The supervisor can then choose a 
password. If the supervisor forgets the password, you can reset it from the Supervisor 
Properties dialog box. The supervisor can then choose a new password.

To change a supervisor’s password:

1. Select the supervisor from the supervisor list, then click Properties. The 
Supervisor Properties dialog box appears (Figure 102).

2. Enter a new password in the Password field (it will appear as asterisks), then 
click OK. The password is changed.

The fields in the dialog box are described below.

Figure 102. Supervisor Properties dialog box

Field Description

ID Supervisor’s user ID for Supervisor Desktop.

Password Supervisor’s password.

Login Name Supervisor’s login name.

Display name Supervisor’s name as seen in Agent Desktop and 
Supervisor Desktop.

Team/Type pane Team the supervisor is assigned to and supervisor 
type (primary or secondary).
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Viewing Team Information

The Teams window enables you to view the supervisors, agents, and skills for a 
particular team. All of this information is administered through Unified ICM. You can 
only view the information in Personnel Configuration.

Supervisors

The Supervisors tab (Figure 103) displays the primary supervisor, secondary 
supervisors, and available supervisors for the team you selected. 

NOTE:  Each team must have a primary supervisor. If there is no 
primary supervisor, secondary supervisors will not see that team in 
the Team List in Supervisor Desktop. Also, if that team is a secondary 
supervisor’s only team, the supervisor won’t be able to log into 
Supervisor Desktop.

Figure 103. Supervisors tab
182 January 16, 2013



Viewing Team Information
Agents

The Agents tab (Figure 104) displays a list of the agents who belong to the team you 
selected, as well as a list of all available agents. Agents are assigned to teams from 
within Unified ICM.

NOTE:  An agent can belong to only one team in Unified ICM. However, 
the Available Agents pane lists all agents not on the selected team, 
even if they are already assigned to another team.

NOTE:  If you move an agent from one team to another in Unified ICM, 
you must log the agent out of Agent Desktop and then log back in for 
the team change to register within Supervisor Desktop.

Figure 104. Agents tab
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Skills

The Skills tab displays a list of the skill groups that route calls to the selected team, as 
well as a list of all available skill groups. This relationship is set up within Unified ICM.

NOTE:  Unified ICM automatically creates a skill group, known as the 
Cisco Voice Default skill group, and gives it a name that consists 
entirely of numbers, such as 000271607568 (as in Figure 105). All 
agents are assigned to this skill group.

Figure 105. Skill tab
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6
Integrating Cisco Unified Presence 
with CAD
Introduction

Cisco Unified Contact Center Enterprise release 7.5 provides a new browser-based 
administrative tool named Cisco Desktop Presence Administrator, which gives 
administrators the ability to integrate Cisco Unified Presence with CAD. 

Integrating Unified Presence with CAD makes it possible for supervisors using 
Supervisor Desktop and agents using Agent Desktop to view the availability of 
non-agents using Unified Presence Client or Microsoft Office Communications Server 
(MOCS). This feature enables supervisors and agents to initiate chat sessions with 
subject matter experts (SMEs) who can provide information that can help agents 
assist customers more quickly and effectively.

For more information about Cisco Unified Presence, see the description at the 
following URL:

http://www.cisco.com/en/US/products/ps6837/index.html

Integrating a Unified Presence cluster with CAD consists of the following tasks.

■ Configuring the Cisco Unified Presence Cluster (page 191)

■ Configuring Contact Lists (page 193)

■ Configuring External Contacts (page 202)

■ Configuring Workflow Groups (page 207)

Accessing Desktop Presence Administrator

Desktop Presence Administrator is available from a menu in Desktop Administrator.
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To access Desktop Presence Administrator:

1. Start Desktop Administrator. The Cisco Desktop Administrator window 
appears (Figure 106).

Figure 106. Cisco Desktop Administrator
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2. Choose Desktop Presence Administrator > Side A (or Side B). The Cisco 
Desktop Presence Administrator login appears. The default username, admin, 
is autofilled in the Username field (Figure 108).

Figure 107. Cisco Desktop Presence Administrator login
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3. If the application is password-protected, type the password in the Password 
field, then click Login. If the application is not password-protected, leave the 
Password field empty and click Login. The splash screen appears (Figure 108)

NOTE:  If Desktop Presence Administrator is password-protected, it 
will prompt you for the password if you click Login without entering 
anything in the Password field.

Configuring a Password for Desktop Presence 
Administrator

You can use a password to protect both Desktop Presence Administrator and Desktop 
Administrator. If you set a password in either application, that password applies to 
both applications. By default, no password is required for either application.

If you do not want Desktop Presence Administrator to be password-protected, you 
must not set up a password in Desktop Administrator. If you do change the Desktop 
Administrator password, you are automatically adding password protection to Desktop 
Presence Administrator using the new password.

NOTE:  Any password you configure in Desktop Presence 
Administrator is also the password for Desktop Administrator. 

Figure 108. Desktop Presence Administrator splash screen
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To set up password protection for Desktop Presence Administrator:

1. In Desktop Presence Administrator, click Change Password. The Change 
Password window appears (Figure 109).

2. In the New Password and Confirm Password fields, enter your new password, 
then click Save. Desktop Presence Administrator and Desktop Administrator 
are now protected by password. 

NOTE:  You must exit all instances of the browser in which you are 
running the application for the change to go into effect.

To change your password for Desktop Presence Administrator:

1. In Desktop Presence Administrator, click Change Password. The Change 
Password dialog box appears.

2. Type your current password in the Old password field. Type a new password in 
the New password and Confirm new password fields, then click OK. Your 
Desktop Presence Administrator and Desktop Administrator password is now 
changed. 

NOTE:  You must exit all instances of the browser in which you are 
running the application for the change to go into effect.

To remove password protection from Desktop Presence Administrator:
When you remove password protection from Desktop Presence Administrator, you 
automatically remove password protection from Desktop Administrator as well.

1. In Desktop Presence Administrator, click Change Password. The Change 
Password dialog box appears.

Figure 109. Change Password window
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2. Type your current password in the Old password field. Leave the New 
password and Confirm password fields blank, then click OK.

3. You are asked to confirm that you want to leave Desktop Presence 
Administrator unprotected. Click Yes. The Desktop Presence Administrator 
and Desktop Administrator password is removed. 

NOTE:  You must exit all instances of the browser in which you are 
running the application for the change to go into effect.
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Configuring the Cisco Unified Presence 
Cluster

The first task in integrating CAD with a Unified Presence cluster is configuring the 
cluster by specifying the connection information.

NOTE:  It is assumed that all of the agents are managed in one 
Unified Presence cluster.

To configure the Unified Presence cluster:

1. Choose Cisco Unified Presence Settings > Cisco Unified Presence Cluster 
Settings. The Cisco Unified Presence Cluster Settings page appears 
(Figure 110).

2. Complete the fields as described below.

Figure 110. Cisco Unified Presence Cluster Settings

Field Description

Enable Cisco 
Unified Presence
Integration

Status of communication between supervisors and 
agents and non-agents.

Version Version of Cisco Unified Presence.

Publisher
Host/IP Address

Hostname or IP address of Unified Presence server 
(the publisher if you have a Unified Presence cluster).
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3. Click Verify to confirm that the information you entered is correct. Desktop 
Presence Administrator connects to the Unified Presence server using the 
hostname or IP address, login ID, and password you entered.

NOTE:  If the connection information is not correct, Desktop Presence 
Administrator displays an error message, stating that an error 
occurred.

4. Click Save to save your changes.

AXL Login ID ID for a user with Unified Presence server/client 
capabilities. Must have the same LDAP profile that 
agents have.

Password Password for AXL user.

Subscriber Host/IP
Addresses

If you have a Unified Presence cluster, the hostname 
or IP address of the Unified Presence subscriber(s).

Field Description
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Configuring Contact Lists

A contact list consists of the SMEs that you want to make available to agents who use 
Agent Desktop. Agents and supervisors see the SMEs in the Contact Selection window 
after clicking the Chat button when the Presence feature is enabled. An agent only 
sees the SMEs who are assigned to the agent’s workflow group. A supervisor, however, 
sees all of the SMEs in all of the workflow groups that are associated with the 
supervisor’s teams.

NOTE:  Agents and supervisors must restart Agent Desktop and 
Supervisor Desktop to see any changes you make to contact lists.

The maximum number of SMEs in a contact list is configurable in Unified Presence. 
The recommended maximum is 100 SMEs in Unified Presence 6.0 and 200 SMEs in 
Unified Presence 7.0 or higher.

Use the Contact Lists node to complete the following tasks.

■ Creating a Contact List (page 193)

■ Finding a Contact List (page 194)

■ Deleting a Contact List (page 195)

■ Editing a Contact List (page 195)

■ Adding SMEs to a Contact List (page 197)

Creating a Contact List

To create a contact list:

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists 
page appears (Figure 111).

Figure 111. Contacts Lists
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2. Create a new contact list by clicking Add New. The Add New page appears 
(Figure 112).

3. Type a name up to 64 characters long in the Contact List Name field and a 
description in the Contact List Description field.

NOTE:  After you create a contact list, you cannot change its name.

4. Click Save, then click Return to Contact list. The Contact Lists page reappears 
with the new contact list.

Finding a Contact List

You can search for a contact list from any of the following pages.

■ Contact Lists page. Navigate to this page by choosing Cisco Unified Presence 
Settings > Contact Lists.

■ Workflow Group page. Navigate to this page by choosing Cisco Unified 
Presence Settings > Workflow Groups, then selecting a workflow group.

NOTE:  Searches are not case sensitive. For example, if you type a 
lowercase letter “s” in a search field, the results will include all items 
that begin with the lowercase letter “s” and the uppercase letter “S.”

To find a contact list:

1. Select a descriptor from the Search for drop-down list, then type one or more 
characters in the text field.

Figure 112. Add New page
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2. If necessary, complete any of the following actions.

■ If you want to add another condition to the search query, click +. A new 
row containing a field drop-down list, a descriptor drop-down list, and a 
text field appears. Repeat step 1 for the new row.

■ If you want to remove the last condition from the search query, click –. 
The bottom row is deleted. If you click – and the search query only 
contains one condition, no change occurs.

■ If you want to remove all of the conditions from the search query, click 
Clear Filter. All of the rows except the first row are deleted, and the first 
row is reset to the default value.

3. When you are done creating your search query, click Find. A list of contact lists 
that match all of the conditions appears.

Deleting a Contact List

To delete a contact list:

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists 
page appears (Figure 111).

2. If necessary, search for the contact list you want to delete. For instructions, 
see "Finding a Contact List" on page 194.

3. Select the check box that corresponds to the contact list you want to delete, 
then click Delete Selected. The selected contact list is no longer displayed in 
the list of contacts. However, the actual deletion is not performed until you 
click Save.

Editing a Contact List

To edit a contact list:

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists 
page appears (Figure 111).

2. If necessary, search for the contact list you want to edit. For instructions, see 
"Finding a Contact List" on page 194.
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3. Select the contact list by clicking its name. The page for that specific contact 
list appears (Figure 113).

4. To remove one or more SMEs from the contact list, clear the corresponding 
check boxes in the Included column.

5. To modify the description of a contact list, type a new description in the 
Description field.

6. When you are finished making changes, click Save, then click Return to 
Contact list.

Figure 113. Specific contact list
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Adding SMEs to a Contact List

You can add any user as an SME to a contact list in Desktop Presence Administrator, 
as long as the user satisfies one of the following criteria.

■ The user is managed by the Unified Presence LDAP server.

■ The user has been added to Desktop Presence Administrator manually as an 
external contact.

Desktop Presence Administrator retrieves users from the Unified Presence LDAP 
server. Because the LDAP server can manage a large number of users, Desktop 
Presence Administrator might not display all of the users it retrieves. You must search 
for the particular users you want to add as SMEs to contact lists. If there are more 
users retrieved than can be displayed, Desktop Presence Administrator will only 
display the first 500 users. 

NOTE:  If you want to provide access to users in an external 
environment who are not managed by the Unified Presence LDAP 
server, you can add them manually as external contacts. For 
instructions, see "Adding External Contacts" on page 202.

To add SMEs to a contact list:

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists 
page appears (Figure 111).

2. Select a contact list by clicking its name. The page for that specific contact list 
appears. If the contact list you selected does not include any SMEs, the 
Subject Matter Expert List will be empty (Figure 114).

NOTE:  The search condition is initially set to Included = True.

Figure 114. Specific contact list with SMEs
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3. Find one or more users that you want to add to the contact list using the 
Search function. For instructions about finding users, see "Finding Users" on 
page 199. Figure 115 shows the users whose last name begins with the letter 
“s” and also contains the letter “c.”

4. Select the users you want to add to the contact list. 

■ To add all of the users that are displayed, click Select All.

■ To add users individually, select the corresponding check box in the 
Included column.

5. If you want to find and add other users, repeat steps 3 and 4.

6. When you are done adding users, click Save, then click Return to Contact list.

Figure 115. Search results
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Finding Users

NOTE:  Searches are not case sensitive. For example, if you type a 
lowercase letter “s” in a search field, the results will include all items 
that begin with the lowercase letter “s” and the uppercase letter “S.”

NOTE:  Search results include users who are retrieved from the 
Unified Presence LDAP server as well as users who have been added 
manually to Desktop Presence Administrator as external contacts.

NOTE:  You can only search for users from a specific contact list page.

To find users:

1. Choose Cisco Unified Presence Settings > Contact Lists. The Contact Lists 
page appears.

2. Select a contact list by clicking its name. The page for that specific contact list 
appears.

3. If you do not want the search results to include users who are already in the 
current contact list, select Included from the Search for field drop-down list 
and False from the criterion drop-down list, then click +. A new condition with 
default values (Included and True) is added to the search query (Figure 116).

Figure 116. Search query with two conditions (default)
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4. Select either Last Name or First Name from the field drop-down list and a 
descriptor from the drop-down list, then type zero or more characters in the 
search field (Figure 117).

5. If necessary, complete any of the following actions.

■ If you want to add another condition to the search query, click +. A new 
row containing a field drop-down list, a descriptor drop-down list, and a 
text field appears. Repeat step 4 for the new row.

■ If you want to remove the last condition from the search query, click –. 
The bottom row is deleted. If you click – and the search query only 
contains one condition, no change occurs.

■ If you want to remove all of the conditions from the search query, click 
Clear Filter. All of the rows except the first row are deleted, and the first 
row is reset to the default value.

Figure 117. Search query with two conditions
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6. When you are done creating your search query, click Find. A list of users that 
match all of the conditions appears (Figure 118).

Figure 118. Search query with results
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Configuring External Contacts

If you have an external environment with subject matter experts who do not use 
Unified Presence Client but who do use Microsoft Office Communicator, you can use 
the External Contacts feature to provide access to those additional users.

Use the External Contacts node to complete the following tasks.

■ Adding External Contacts (page 202)

■ Finding External Contacts (page 204)

■ Editing an External Contact (page 205)

■ Deleting External Contacts (page 205)

Adding External Contacts

To add an external contact:

1. Choose Cisco Unified Presence Settings > External Contacts. The External 
Contacts page appears (Figure 119).

Figure 119. External Contacts page
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2. Click Add New. The Add New page appears (Figure 120).

3. Complete the fields as described below.

4. Click Save to save your changes. The external contact is added.

NOTE:  After you click Save, you cannot edit the URI field. If you want 
to change the URI of an existing external contact, you must delete the 
external contact and create a new external contact with the new URI.

5. If you want to create additional external contacts who have similar 
information, click Copy, edit the fields as needed, then click Save.

6. When you are finished adding an external contact, click Return to External 
contact list.

Figure 120. Add New page

Field Description

Last Name Optional. Maximum of 128 characters. No restrictions on 
the characters that can be entered.

First Name Optional. Maximum of 128 characters. No restrictions on 
the characters that can be entered.

URI Uniform Resource Indicator. Required. No restrictions on 
the length or characters that can be entered.

Phone
Number

Optional. No restrictions on the length or characters that 
can be entered.
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Finding External Contacts

NOTE:  Searches are not case sensitive. For example, if you type a 
lowercase letter “s” in a search field, the results will include all items 
that begin with the lowercase letter “s” and the uppercase letter “S.”

To find an external contact user:

1. Choose Cisco Unified Presence Settings > External Contacts. The External 
Contacts page appears (Figure 119).

2. Select a field (for instance, Last Name) and a descriptor (for instance, Begins 
With), then type one or more characters in the text field.

3. If necessary, complete any of the following actions.

■ If you want to add another condition to the search query, click +. A new 
row containing a field drop-down list, a descriptor drop-down list, and a 
text field appears. Repeat step 2 for the new condition.

■ If you want to remove the last condition from the search query, click –. 
The bottom row is deleted. If you click – and the search query only 
contains one condition, no change occurs.

■ If you want to remove all of the conditions from the search query, click 
Clear Filter. All of the rows except the first row are deleted, and the first 
row is reset to the default value.

4. When you are done creating your search query, click Find. A list of external 
contacts that match all of the conditions appears (Figure 121).

Figure 121. External Contact— search query and results
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Editing an External Contact

To edit an external contact:

1. Choose Cisco Unified Presence Settings > External Contacts. The External 
Contacts page appears (Figure 119).

2. If you do not see the external contact you want to edit, use the search function 
to find the contact. For instructions, see "Finding External Contacts" on 
page 204.

3. Select an external contact by clicking the user’s last name. The page for the 
specific external contact (Figure 122).

4. Change the user’s last name, first name, or phone number by typing new 
information in the corresponding field.

5. When you are finished making changes, click Save, then click Return to 
External Contacts list.

Deleting External Contacts

To delete an external contact:

1. Choose Cisco Unified Presence Settings > External Contacts. The External 
Contacts page appears (Figure 119).

2. If necessary, search for the external contacts that you want to delete. For 
instructions, see "Finding External Contacts" on page 204.

Figure 122. External Contact page — specific user
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3. Select the check box corresponding to one or more external contacts, then 
click Delete Selected. The selected external contacts are no longer displayed 
in the list of external contacts. However, the actual deletion is not performed 
until you click Save.
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Configuring Workflow Groups

Use the Workflow Groups node to add the contact lists that you create to workflow 
groups. You can assign up to 25 contact lists to a workflow group. Up to 200 SMEs can 
be in a workflow group. For the limits on the number of SMEs in a contact list, see 
"Configuring Contact Lists" on page 193.

NOTE:  You cannot create workflow groups or assign workflow groups 
to agents in Desktop Presence Administrator. You must create and 
assign workflow groups in Desktop Administrator.

Use the Workflow Groups node to complete the following tasks.

■ Finding a Workflow Group (page 207)

■ Adding a Contact List to a Workflow Group (page 208)

■ Selecting Agents to Appear Offline (page 210)

Finding a Workflow Group

NOTE:  Searches are not case sensitive. For example, if you type a 
lowercase letter “s” in a search field, the results will include all items 
that begin with the lowercase letter “s” and the uppercase letter “S.”

To find a workflow group:

1. Choose Cisco Unified Presence Settings > Workflow Groups. The Workflow 
Groups page appears (Figure 123).

Figure 123. Workflow Groups page
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2. Create a search query using one or more conditions as described below.

■ If you want to search for workflow groups by name, select Workflow Group 
from the field drop-down list and any item from the criterion drop-down 
list, then type one or more characters in the text field.

■ If you want to search for workflow groups for which agents appear offline, 
select Agents appear offline from the field drop-down list and True from 
the criterion drop-down list. 

■ If you want to add another condition to the search query, click +. A new 
row containing the field drop-down list, the descriptor drop-down list, and 
the text field appears. Define the new condition as described above.

■ If you want to remove the last condition from the search query, click –. 
The bottom row is deleted. If you click – and the search query only 
contains one condition, no change will occur.

■ If you want to remove all of the conditions from the search query, click 
Clear Filter. All of the rows except the first row are deleted, and the first 
row is reset to the default value.

3. When you are finished creating your search query, click Find. A list of workflow 
groups that match all of the conditions appears.

Adding a Contact List to a Workflow Group

To add a contact list to a workflow group:

1. Choose Cisco Unified Presence Settings > Workflow Groups. The Workflow 
Groups page appears (Figure 123).

2. If necessary, search for the workflow group to which you want to add a contact 
list. For instructions, see "Finding a Workflow Group" on page 207.
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3. Select a workflow group by clicking the name of the group. The page for the 
selected workflow group appears (Figure 124).

4. If necessary, search for the contact lists you want to add to the selected 
workflow group. For instructions, see "Finding a Contact List" on page 194.

5. Add one or more contact lists by selecting the corresponding check boxes in 
the Included column (Figure 125). To select all of the contact lists, click 
Select All.

6. Repeat step 4 and step 5 if you want to find and add additional contact lists to 
the selected workflow group.

7. When you are finished adding contact lists, click Save, then click Return to 
Workflow Group list.

Figure 124. Specific workflow group page

Figure 125. Specific workflow group page — several contact lists selected
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Selecting Agents to Appear Offline

You can configure agents within a workflow group to appear as offline to SMEs in the 
Contact Selection window.

To select agents within a workflow group to appear offline:

1. Choose Cisco Unified Presence Settings > Workflow Groups. The Workflow 
Groups page appears (Figure 123).

2. Select the Agents appear offline check box that corresponds to the workflow 
group that contains the agents you want to appear as offline in the Contact 
Selection window.

3. Click Save when finished.
210 January 16, 2013



January 16, 2013
A
Global Phone Book FAQ
Question Where are global phone books stored?

Answer They are stored in the Directory Services (LDAP) database at 
SpanlinkCommunications > Company > [LCC name] > PhoneBook.

Question How are phone books synchronized between the active and standby Directory 
Services in a redundant system?

Answer Whenever an entry is made in the active Directory Services, it is immediately 
replicated on the standby system so that they remain synchronized. 

Question Which logs should be collected to troubleshoot issues with global phone books?

Answer The Cisco Agent Desktop and Cisco Desktop Administrator logs (agent.log and 
administrator.log) and debug traces, set to the DEBUG level, (agent.dbg and 
administrator.dbg) are used to troubleshoot phone book issues.

Question Where are global phone books configured?

Answer Global phone books are created and populated by the administrator using Cisco 
Desktop Administrator. Agents cannot edit global phone books. They can edit their 
own employee phone books using Cisco Agent Desktop. 

The administrator can enable and disable all phone books, or just employee 
phone books. See "Phone Books" on page 82 for instructions on administering 
phone books.

Question Do phone books run from the Directory Services database?

Answer Earlier versions of CAD loaded phone books from Directory Services every time 
the agent launched the dial pad. The current version of CAD loads phone books 
once and stores them in memory to avoid delays. 
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Question Can global phone books be linked back into the Cisco Unified Communications 
Manager/Unified CallManager LDAP user list so that it is available from the 
IP phone corporate directory? 

Answer No.

Question Are phone books available to agents when they use their non-ACD extension? 

Answer No. 

Question Is there a maximum number of entries that can be put into a phone book?

Answer No, phone book size is limited only by the memory available to the agent’s 
desktop. Phone books have been tested with up to 3,000 entries.

Question Can a global phone book be locked down so that only members of a certain team 
can view it?

No, global phone books are either available to all agents or no agents. However, 
there are work flow group phone books that are available to agents that are 
assigned to that particular work flow group. If a team is assigned to a work flow 
group, and there is a specific phone book for that work flow group, than no other 
teams can view that particular phone book. See "Phone Books" on page 82 for 
more information on the various types of phone books.
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Cisco Desktop Monitoring Console
Overview

The Cisco Desktop Monitoring Console is a Java application that monitors the status 
of the CAD services and Directory Services (LDAP).

The Monitoring Console requires Tomcat to run. Tomcat is automatically installed with 
the CAD base services.

NOTE:  The Monitoring Console is installed automatically when the 
CAD base services are installed. There is some manual setup and 
configuration that is required. See the Cisco CAD Installation Guide 
for more information.

The Monitoring Console application is located on any computer where the CAD base 
services are installed. The URL for a hyperlink to the application is the following, 
where <CAD server> is the IP address for the server on which the CAD base services 
are installed:

http://<CAD server>:8088/smc/monitor.jsp
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Using the Monitoring Console

The Monitoring Console consists of 2 panes. The left pane displays a list of CAD 
servers and the CAD services located on those servers. The right pane displays either 
a summary view or a detail view of service status. 

The summary view is displayed when you select the IP address of a server from the 
left pane (Figure 126). The detail view is displayed when you select a specific service.

Figure 126. Cisco Desktop Monitoring Console, summary view (top) and detail view (bottom)
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Status of the services is indicated also by a colored icon next to each service in the 
left pane. If the service is running, a green circle is displayed; if the service is down, a 
red circle with a white X through it is displayed.

If a server is down, a gray computer with a white X through it is displayed.

NOTE:  Currently, the summary view and the detail view display the 
same information in different ways. In the future, more service details 
will be added to the detail view.

The information displayed, including the server list in the left pane, is refreshed every 
15 seconds. It can also be manually refreshed at any time by clicking the Refresh 
Server List button. 
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Tutorials
Introduction

This chapter shows you how to perform a number of common tasks. The tasks are 
presented as tutorials, and each task includes step-by-step instructions and keystroke 
macro examples. 

The tutorials are based on a fictional company called Rock Coast Products. The 
tutorials are:

■ Setting Up an ANI-Based Screen Pop (page 218) 

■ Using a Terminal Emulator Package (page 222)

■ Setting Up a Task Button to Transfer to a Specified Number (page 226)

■ Setting Up a Task Button for After-Call Work (page 227)

■ Setting Up a Launch External Application Action (page 236)

■ Using Wild Card Data Conditions (page 237)

NOTE:  The macros used in these tutorials might need fine-tuning, 
depending on the PC used and the third-party software accessed.
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Setting Up an ANI-Based Screen Pop

Premise

Rock Coast Products wants to use the ANI as the basis for a screen pop containing 
customer contact information.

Procedure

Set up a macro to search for the ANI in a Microsoft Outlook 2000 contact list.

NOTE:  This example uses Microsoft Outlook 2000 SR-1(9.0.0.3821). 
If you have a different version, your keystrokes might vary.

1. Start Microsoft Outlook.

2. In the Navigation pane of Desktop Administrator, choose 
Work Flow Configuration > Work Flow Groups.

3. Select a work flow group, then select either CAD Agent or CAD-BE Agent.

4. Select Voice Contact Work Flows (Figure 62 on page 122).

5. Create a new work flow, and enable it for all inbound calls.

6. Select Ringing from the Events list, then click New under the Rules list. The 
New Work Flow Rule dialog box appears.

7. Type a name for the rule (for example, CustContact), then click OK. The new 
rule appears in the Rules list.

8. Select the new rule, then click Edit next to the first Data Field Conditions field. 
The Data Field Conditions dialog box appears (Figure 63 on page 124).

9. Select Calling# from the Data Field drop-down list, check the Is Not Empty 
data field filter, then click OK. The Data Field Conditions dialog box closes.

10. Select Any Condition is True.

11. Click Add under the Actions list to create a new action for the event. The 
Select Action dialog box appears.

12. Select the Run Macro tab, then click New. The New Macro dialog box appears.

13. Type a name for the macro (for example, LookUpPhoneNumber) then click 
OK. The macro editor dialog box appears. The name you typed appears in the 
title bar.

14. Click Record. The Macro Editor dialog box minimizes.
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15. Use your mouse to maximize Outlook and begin typing the following macro 
keystrokes; the Macro Recorder records your keystrokes.

16. Click Insert Data. The Select a Data Field dialog box appears.

17. Select the CALLING# data field from the list, and then click OK. The Macro 
Recording Suspended dialog box appears.

18. Click Resume Recording. Enter the remaining macro keystrokes shown below.

19. The macro is now complete. To test it, click Playback. You can make changes 
to the macro in the edit window.

NOTE: You might see multiple [ALT] entries in the macro. These are 
extraneous and can be deleted. If you leave them in the macro, they will not 
cause errors.

20. Once you are satisfied with the macro, click OK to save it and add it to the list 
of available macros that can be selected as actions.

21. Select the new macro and click OK. The Voice Contact Work Flow window 
appears. Notice that the macro now appears in the list of actions for the 
selected rule and event.

Macro keystrokes Action

ALT+V Open the View menu.

G Select Go to…

O Select Contacts

ALT+T Access the Tools menu

D Select Advanced Find

ALT+C Moves the cursor to the Search for the word(s) field

F2
(the macro hot key)

Pause macro recording and bring up the Macro 
Recording Suspended dialog box.

Macro keystrokes Action

ALT+I Selects the In field.

P Toggles to the Phone number fields only option.

ALT+N Clicks the Find Now button.

F2
(the macro hot key)

Pause macro recording and bring up the Macro 
Recording Suspended dialog box.
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Macro Text

The following text appears in the Macro Editor dialog box:

[APPLICATION:RCTRL_RENWND32=INBOX - MICROSOFT OUTLOOK]
[ALT] V
G
O
[ALT] T
D
[APPLICATION:RCTRL_RENWND32=ADVANCED FIND]
[ALT] C
[DATA FIELD:CALLING#]
[ALT] I
P
[ALT] N

Now you must record a second macro to close the Advanced Find dialog box. Make 
sure to keep Outlook and the Advanced Find dialog box open.

1. In the Voice Contact Work Flow window, select Dropped from the Events list.

2. Under the Actions list, click New to create a new action.

3. In the Select Action dialog box, select the Run Macro tab and then click New.

4. In the New Macro dialog box, enter a new macro action name (for example, 
CloseAdvFind) and then click OK.

5. In the Macro Editor dialog box, note that the macro name entered in Step 4 
appears in the title bar. Click Record. The Macro Editor dialog box minimizes.

6. Use your mouse to maximize the Advanced Find dialog box and begin typing 
the following macro keystrokes; the Macro Recorder records your keystrokes.

NOTE:  You must add a delay at the beginning of the macro. See 
“Macro Text” below.

7. Once you have finished recording the macro, press the macro hot key to bring 
up the Macro Recording Suspended dialog box, and then click End Recording.

8. To test your macro, click Playback.

9. Once you are satisfied with the macro, click OK to save it and add it to the list 
of available macros that can be selected as actions.

Macro keystrokes Action

ALT+F Access the File menu.

C Close the Advanced Find dialog box.

F2
(the macro hot key)

Pause macro recording and bring up the Macro 
Recording Suspended dialog box.
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10. Select the new macro and click OK. The Voice Contact Work Flow window 
appears. Notice that the macro has been added to the list of actions for the 
selected rule and event.

Macro Text

The following text appears in the Macro Editor dialog box:

[DELAY] 1500
[APPLICATION:RCTRL_RENWND32=ADVANCED FIND]
[ALT] F
C
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Using a Terminal Emulator Package

Premise

Rock Coast Products would like to use a terminal emulation program to find the 
caller’s name based on the ANI, and then automatically create an email message 
each time a call is received.

Steps

This example uses the following software:

■ Terminal emulation software: HostExplorer for Windows 95/98, file version 
6.1.0.0. from Hummingbird Communications, Ltd.

■ email program: Microsoft Outlook 98 (8.5.5104.6)

Use two macros since each can potentially be reused with other actions. It is easier to 
create and debug small macros and then run them as two actions in a sequence to do 
larger tasks. 

■ The first macro accesses the terminal emulation program and copies the 
caller’s name to the clipboard.

■ The second macro copies the number from the clipboard and uses it in an 
email message.

NOTE:  Terminal emulation packages can be unpredictable when 
used with macros. The keyboard/terminal emulation must be correct 
for the macros to record and play back correctly. Some terminal 
emulation packages do not have a provision for highlighting and 
copying text from a screen.

Make sure both programs are running before recording the macros. Also make sure 
that the terminal program is logged in to a server, and open a text file using Vi (a Unix 
editor). The text file layout is shown below:

Phone Number  Name
612-555-2000  Spanlink Communications
612-555-1234  John Smith
612-555-0000  Mary Nelson
612-555-5555  Ned Marvin

Set up the Vi macro:

1. Open Vi, log into the server, and open the text file.

2. Start Desktop Administrator, click Voice Contact Work Flow, and add a new 
action for the Ringing event.

3. In the Select Action dialog box, click New in the Run Macro dialog box.

4. Enter a new macro action name (for example, GetNamePutInClipBoard), then 
click OK.
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5. In the Macro Editor dialog box, click Record. The Macro Editor dialog box 
minimizes.

6. Maximize Vi, and begin typing the following macro keystrokes; the macro 
recorder records your keystrokes.

7. In the Macro Recorder Suspended dialog box, click Insert Data. The Select a 
Data Field dialog box appears.

8. Select the data field you wish to insert from the list, then click OK. The Macro 
Recording Suspended dialog box appears.

9. Click Resume Recording. Begin typing the following keystrokes.

Macro keystrokes Action

H Place the cursor in the “home” position.

/ Search.

F2
(the macro hot key)

Pause macro recording and bring up the Macro 
Recorder Suspended dialog box.

Macro keystrokes Action

ENTER Search. Positioned on the Phone Number field.

/ Search.

<SPACE> Search for a space to get to the Name column.

ENTER Search. Positioned after the Phone Number field.

L Move right one character (over the first space).

L Move right one character (over the second space).

[SHIFT] [CONTROL] 
[RIGHT-ARROW]

The next three key stroke combinations select the 
caller’s name.

[SHIFT] [CONTROL] 
[RIGHT-ARROW]

[SHIFT] [CONTROL] 
[RIGHT-ARROW]

[ALT]-E Vi Edit menu.

C Copy the selected text to the clipboard.

Press F2
(the macro hot key)

Pause macro recording and bring up the Macro 
Recorder Suspended dialog box.
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10. After you finish recording the macro, press the macro hot key to bring up the 
Macro Recorder Suspended dialog box, then click End Recording. The Macro 
Editor window appears.

11. To test your macro, click Playback. You can make changes to the macro in the 
Edit window, and you can test the changes by clicking Playback.

12. When you are satisfied with the macro, click OK to save it and add it to the list 
of available macros that can be selected as actions.

13. Select the new macro and click OK. The Voice Contact Work Flow window 
appears. Notice that the macro has been added to the list of actions for the 
selected rule and event.

After you record both macros, they appear in the Actions pane. Ensure that they 
appear in the order shown in Figure 127.

Vi Macro Text

The following text appears in the Macro Editor dialog box:

[APPLICATION:HOSTEXPLORER=1 - DEFAULT (DEACON)]
[SHIFT] H
/
[DATA FIELD:CALLING#]
[ENTER]
/
[SPACE]
[ENTER]
L
L
[SHIFT] [CONTROL] [RIGHT-ARROW]
[SHIFT] [CONTROL] [RIGHT-ARROW]
[SHIFT] [CONTROL] [RIGHT-ARROW]
[ALT] E 
C

Figure 127. Macros in the Actions pane
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Outlook Macro Text

The following text appears in the macro recorder dialog box:

[APPLICATION:RCTRL_RENWND32=INBOX - MICROSOFT OUTLOOK]
[SHIFT] [CONTROL] B
[APPLICATION:ABCLS=ADDRESS BOOK]
[ALT] Y 
[CONTROL] V
[CONTROL] N
[SHIFT] R
E
G
A
R
D
I
N
G
[SPACE]
[SHIFT] Y
O
U
R
[SPACE]
[SHIFT] C
A
L
L
[SPACE]
O
N
[SPACE]
[SYSTEM FIELD:CALL_START_TIME]
[TAB]
[SHIFT] D
E
A
R
[SPACE]
[CONTROL] V
.
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Setting Up a Task Button to Transfer to a 
Specified Number

Premise

Rock Coast Products wants to set up a call control button that will allow agents to 
easily transfer calls to their supervisor.

Steps

1. In Desktop Administrator, choose Desktop Configuration > Work Flow Groups 
> Agents and select a work flow group, then click User Interface. The User 
Interface window appears.

2. On the Toolbar tab, select the task button you want to configure.

3. Select the Visible check box.

4. Type a brief hint to describe the action (for instance “Xfer to Super”) in the 
hint field.

5. Click Add.

6. In the Select Action dialog box, select the Call Control tab, then click New.

7. In the Setup Call Control Action dialog box, enter a name for the action in the 
Action Name field, select the call control type, then enter the supervisor’s 
telephone number in the Phone Number field.

8. Click OK to save the settings. On the Call Control tab, the new action is 
highlighted. 

9. Click OK. On the Toolbar tab, the new action is now associated with the task 
button you are configuring.

10. Click OK to save the changes.
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Setting Up a Task Button for After-Call Work

Premise

Rock Coast Products wants to set up a task button that prepares a Microsoft Outlook 
2000 email message for after-call work.

This example retrieves customer information (email address, name, and amount of 
sale) from an Access 2000 database and pastes that information into an Outlook 
2000 email message. 

Assumptions

■ Agent was viewing the customer’s record in the Access database in form view

■ Outlook is open on the agent’s desktop and is displaying the In Box.

■ The agent reviews the automatically-generated email and sends it manually.

Steps

1. In Desktop Administrator, choose Desktop Configuration > Work Flow Groups 
> Agents, select a work flow group, then click User Interface. The User 
Interface Setup window appears.

2. On the Toolbar tab, select the task button you wish to configure.

3. Select the Visible check box.

4. Type a brief hint to describe the action (for instance “After Call Email”) in the 
hint field.

5. Click Add.

6. In the Select Action dialog box, select the Run Macro tab, then click New. The 
New Macro dialog box appears.

7. In the New Macro dialog box, type a name for the new macro (for instance, 
“AfterCallEmail”), then click OK. The Macro Editor window appears.

8. Click Record to start recording the macro.

9. Use your mouse to maximize Access, then begin typing the following macro 
keystrokes. The macro recorder records your keystrokes.

Macro Keystrokes Action

[HOME] Press Home to position the cursor in the first field in 
the form.

[TAB] Press tab as many times as needed to go to the email 
address field.
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10. Use your mouse to maximize Outlook, then type the following macro 
keystrokes.

[CONTROL] C Copy the email address.

[HOME] Press Home to position the cursor in the first field in 
the form.

Macro Keystrokes Action

[CONTROL] N Open a blank email message.

[CONTROL] V Paste the email address in the To: field in the email 
message.

[TAB] Tab down to the Subject line.

[TAB]

[SHIFT] Y Type “Your Order” in the Subject line.

O

U

R

[SPACE]

[SHIFT] O

R

D

E

R

[TAB] Tab to the body of the message.

[SHIFT] D Type the salutation “Dear ”.

E

A

R

[SPACE]

Macro Keystrokes Action
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11. Use your mouse to maximize Access, then type the following macro 
keystrokes.

12. Use your mouse to maximize Outlook, then type the following macro 
keystrokes.

Macro Keystrokes Action

[TAB] Tab as many times as needed to get to the Name 
field.

[CONTROL] C Copy the customer’s name.

Macro Keystrokes Action

[CONTROL] V Paste the customer’s name after the salutation.

[ENTER] Press the Return key twice to start a new line for the 
body of the message.

[ENTER]

[SHIFT] T Type the message: “Thank you for your order in the 
amount of ”.

H

A

N

K

[SPACE]

Y

O

U

[SPACE]

F

O

R

[SPACE]

Y

O

U
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R

[SPACE]

O

R

D

E

R

[SPACE]

I

N

[SPACE]

T

H

E

[SPACE]

A

M

O

U

N

T

[SPACE]

O

F

[SPACE]

[TAB] Tab as many times as needed to get to the Amount of 
Sale field.

[CONTROL] C Copy the amount of sale.

Macro Keystrokes Action
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13. Use your mouse to maximize Outlook, then type the following macro 
keystrokes.

Macro Keystrokes Action

[CONTROL] V Paste the amount of sale in the body of the message.

. Add a period to the sentence.

[SPACE] Type “Your order is in the mail.” to finish the email 
message.

[SHIFT] Y

O

U

R

[SPACE]

O

R

D

E

R

[SPACE]

I

S

[SPACE]

I

N

[SPACE]

T

H

E

[SPACE]

M

A
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14. After you finish recording the macro, press the macro hot key to display the 
Macro Recording Suspended dialog box, then click End Recording.

15. To test your macro, click Playback. You can make changes to the macro in the 
Macro Editor window and then test them by clicking Playback again.

To slow down the macro so you can watch the steps, insert the command 
[DELAY] 1000 before and after the commands for maximizing Outlook and 
Access. This will help you debug the macro. For instance:

[DELAY] 1000
[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : FORM]
[DELAY]1000

16. Once you are satisfied with the macro, click OK to save it and add it to the list 
of available macros that can be selected as actions.

17. On the Run Macros tab, the new macro is highlighted. Click OK to return to the 
User Interface Setup window.

18. In the User Interface Setup window’s Toolbar tab, the new macro action is 
now associated with the task button you are configuring.

19. Click OK to save the changes.

Sample Macro Text

The following text appears in the macro recorder dialog box:

[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : FORM]
[HOME]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[CONTROL] C
[APPLICATION:RCTRL_RENWND32=INBOX - MICROSOFT OUTLOOK]
[CONTROL] N
[APPLICATION:RCTRL_RENWND32=UNTITLED - MESSAGE (PLAIN TEXT) ]

I

L

.

Macro Keystrokes Action
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[CONTROL] V
[TAB]
[TAB]
[SHIFT] Y
O
U
R
[SPACE]
[SHIFT] O
R
D
E
R
[TAB]
[SHIFT] D
E
A
R
[SPACE]
[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : FORM]
[HOME]
[TAB]
[CONTROL] C
[APPLICATION:RCTRL_RENWND32=YOUR ORDER - MESSAGE (PLAIN TEXT) ]
[CONTROL] V
,
[ENTER]
[ENTER]
[SHIFT] T
H
A
N
K
[SPACE]
Y
O
U
[SPACE]
F
O
R
[SPACE]
Y
O
U
R
[SPACE]
O
R
D
E
R
[SPACE]
I
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N
[SPACE]
T
H
E
[SPACE]
A
M
I
[BACKSPACE]
O
U
N
T
[SPACE]
O
F
[SPACE]
[APPLICATION:OMAIN=MICROSOFT ACCESS - [CUSTOMERS : FORM]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[TAB]
[CONTROL] C
[APPLICATION:RCTRL_RENWND32=YOUR ORDER - MESSAGE (PLAIN TEXT) ]
[CONTROL] V
.
[SPACE]
[SHIFT] Y
O
U
R
[SPACE]
O
R
D
E
R
[SPACE]
I
S
[SPACE]
I
N
[SPACE]
T
H
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E
[SPACE]
M
A
I
L
.
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Setting Up a Launch External Application 
Action

Premise

Rock Coast Products wants to set up a task button that automatically launches a 
third-party application.

Steps

In this example you set up an action that launches Microsoft WordPad and then 
associates the action with a task button on the agent’s toolbar.

1. In Desktop Administrator, choose Desktop Configuration > Work Flow Groups 
> Agents, select a work flow group, then click User Interface. The User 
Interface Setup window appears.

2. On the Toolbar tab, select the task button you want to configure.

3. Select the Visible check box.

4. Type a brief hint to describe the action (for instance, “WordPad”) in the hint 
field.

5. Click Add.

6. In the Select Action dialog box, select the Launch External Application tab, 
then click New.

7. In the Setup Launching External Application Action dialog box, enter a name 
for the action in the Action Name field and browse to the application’s 
executable (Wordpad.exe) in the Application field.

NOTE:  The application should be on a network drive so it is 
accessible to all agents. If you must use an application located on the 
agent’s PC, make sure that the application is accessible by an 
identical path on each agent’s PC.

8. If you want, add any of the available arguments to pass to WordPad. Select 
the arguments from the right Available Arguments pane and use the left and 
right arrows to add or remove them to the left Arguments pane. Use the up 
and down arrows to rearrange the order in which they will appear.

9. Click OK to return to the Launch External Application tab with the new action 
highlighted in the list of actions. 

10. Click OK to return to the User Interface Setup window.

11. In the User Interface Setup window’s Toolbar tab, the new action is now 
associated with the task button you are configuring.

12. Click OK to save the changes.
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Using Wild Card Data Conditions

Premise

Rock Coast Products is located in a city with two neighboring area codes. The east 
metro area code is 651 and the west metro area code is 612. Rock Coast’s Customer 
Service Division has one agent who assists east metro callers and one agent who 
assists west metro callers.

If an east metro caller dials the main Customer Service number, Rock Coast wants 
that call directed automatically to the agent who handles east metro calls.

To separate east metro callers, Rock Coast sets up rules using the data conditions Is 
in the List and Is not in the List. These data conditions return as true only if there is an 
exact string match. 

Entering hundreds or even thousands of telephone numbers into a list is not feasible, 
so Rock Coast uses wild card data conditions. This operation is similar to the function 
of the Find tool in Windows. You can enter part of a string or a whole string to find 
what you’re looking for. See "Wild Card Searches" on page 125 for more information 
on using wild cards.

Procedure

Set up a wild card data condition that will transfer calls from the 651 area code to the 
east metro agent:

1. In Desktop Administrator, click Desktop Configuration > Work Flow Groups > 
Agents, select a work flow group, then click Voice Contact Work Flow. The 
Voice Contact Work Flow window appears.

2. Select the Default voice contact work flow, then click Edit. The Voice Contact 
Work Flow window appears.

3. Select the Ringing event.

4. Under the Rules pane, click New.

5. Create a new rule named East Metro.

6. In the Voice Contact Work Flow window, note that the new rule appears in the 
Rules list. With the new rule highlighted, click Edit next to the first Data Field 
Conditions field.

7. Select Calling# from the Data Field drop-down list.

8. Check Enable Condition.

9. Check Is in the list.

10. Add the wild card data condition 651* to the list.

11. Click OK, then click Apply.
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B
Glossary
This glossary includes information for the following entries:

■ A (page 239)

■ B (page 241)

■ D (page 244)

■ E (page 245)

■ H (page 246)

■ I (page 246)

■ L (page 247)

■ M (page 248)

■ N (page 249)

■ P (page 249)

■ R (page 250)

■ S (page 251)

■ T (page 252)

■ U (page 253)

■ V (page 253)

■ W (page 254)

A

ACD
See automatic call distribution.

action
An occurrence that takes place when a rule is met. More than one action can take 
place as a result of meeting a rule.
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administrator
The person who administers CAD. The administrator defines work flows and 
teams, and the look and feel of the agent’s desktop.

agent
The person who interacts with customers in a contact center. 

Agent Desktop
The Cisco desktop application used by a contact center agent to handle customer 
calls.

agent state
An agent’s current ACD status. Possible statuses are Ready, Not Ready, Work 
Ready, Work Not Ready, Reserved, Hold, Talking, and Logged Out.

Agent State action
An action type that changes an agent’s ACD agent state.

Always on Top mode
A display mode in which the interface is always on top of all other windows and 
does not minimize.

Always Open mode
A display mode in which the interface is always visible, but might be hidden by 
other open applications.

ANI
See automatic number identification. 

area code
A 3-digit code designating a toll center in the United States and Canada.

array variable
A Unified ICM extended call context (ECC) variable that stores multiple pieces of 
data.

automatic call distributor (ACD)
Optional software that resides on the PBX. Its role is to monitor various 
parameters within the system and call center and to intelligently route calls based 
on that information. 

automatic number identification (ANI)
A series of digits at the front of a phone call that delivers the billing number (which 
is not necessarily the phone number) of the caller.
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B

barge-in
A feature in Supervisor Desktop that allows a supervisor to forcibly join an agent’s 
call with a customer. It is a forced conference call.

bridged appearance
A situation in which two devices share the same phone number (for example, a 
secretary whose phone can also answer the supervisor’s phone). 

Browser and IP Phone Agent (BIPPA) Service
See Cisco Browser and IP Phone Agent (BIPPA) Service.

C

CAD-BE
Cisco Agent Desktop—Browser Edition. A Java applet version of Agent Desktop 
that runs in a web browser.

call activity data
The information displayed Agent Desktop documenting the length of time a call is 
at a particular type of device or agent within the call center. 

call center
A location where calls are made and answered. A call center typically has 
numerous agents and an automatic call distributor. 

call control
The action of changing the state of a call, for instance, making, answering, 
transferring, or dropping a call.

Call Control action
An action that performs a call control function triggered by an event meeting a 
rule. Call control actions vary according to switch type.

call history
See call activity data.

call log
The record of calls made and received by a desktop while running Agent Desktop.

call routing
The automatic sending of calls to the desired destination, such as an extension or 
a queue.
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caller input
Touch tone data entered by the caller in response to prompting.

CallManager
A Cisco software-based voice over IP telephone switch.

Chat
A feature of Agent Desktop and Supervisor Desktop that enables agents and 
supervisors to communicate via an instant messaging window.

Chat Service
See Cisco Chat Service.

chat session
A written exchange between agents or between agent and supervisor using the 
Chat application.

Cisco Browser and IP Phone Agent (BIPPA) Service
The service that enables CAD-BE and IP phone agents to log in and out of 
Unified ICM, change agent states, and enter wrap-up data and reason codes 
without having the Agent Desktop software. This service works in conjunction with 
the Services feature of Unified CM and Cisco IP phones.

Cisco Chat Service
A service that acts as a message broker between the Chat clients and Supervisor 
Desktop. It is in constant communication with all agents and supervisor desktops. 

Cisco Enterprise Service
A server program that tracks calls in the system. It is used to attach IVR-collected 
data to a call in order to make real-time call activity data available at the agent 
desktop.

Cisco LDAP Monitor Service
The service that starts Directory Services and then monitors it to ensure that it 
keeps running.

Cisco Licensing and Resource Manager Service
The service that distributes licenses to clients and oversees the health of the CAD 
services. In the event of a service failure, it initiates the failover process.

Cisco Recording & Playback Service
The service that extends the capabilities of the Cisco VoIP Monitor Service by 
allowing supervisors and agents to record and play back calls.
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Cisco Recording and Statistics Service
A service that maintains a 7-day history of agent and team statistics. It also 
manages call recording.

Cisco Sync Service
The service that connects to the Unified ICM logger SQL database via and ODBC 
connection and retrieves agent, supervisor, team, and skill information. It then 
compares the information with the information in Directory Services and adds, 
updates, or deletes entries as needed to stay consistent with the Unified ICM 
configuration.

Cisco Unified Mobile Agent
Cisco Unified Mobile Agent provides the capability to use remote agents when 
staffing contact centers. It provides an encrypted, secure, IT-managed connection 
over broadband to the home. The agents have complete access to all the contact 
center applications. 

Cisco VoIP Monitor Service
A service that enables supervisors to silently monitor agents. The service 
accomplishes this by “sniffing” network traffic for voice packets.

Computer telephony integration (CTI)
The connection of a computer with a telephone switch that allows the computer to 
issue commands and receive event information for calls and agents. 

configuration file
The computer file that stores the settings for an application.

contact center
An expansion of a call center, so that it can make and receive not only phone 
calls, but email, faxes, web chat messages, and so on.

CORBA
Common Object Request Broker Architecture. An architecture and specification 
for creating, distributing, and managing distributed program objects in a network. 
It allows programs at different locations and developed by different vendors to 
communicate in a network through an interface broker.

country code
The 1–3 digit code that, in the world numbering plan, identifies each country or 
integrated numbering plan in the world.

CTI
See computer telephony integration.
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D

data field
A piece of information about a phone call that is available for display in the Agent 
Desktop interface. 

data field condition
A logical statement about call data that evaluates as either true or false.

data router
In networks, a device that connects any number of IP local area networks (LANs).

data switch
In networks, a device that filters and forwards packets between LAN segments.

database
A collection of data structured and organized in a disciplined fashion so that 
information of interest can be accessed quickly.

deflected call
A ringing call that is redirected to another extension without being answered first. 
This typically happens when the call is answered by voice mail.

delimiter
A word or character that marks the beginning or end of a segment of data.

Desktop Administrator
The application used to administer Cisco Agent Desktop.

device
A unit (for example, a telephone) connected to the telephone system. 

Dial Pad
The soft phone screen that enables an agent to dial a number.

dial plan
A description of the dialing arrangements for customer use on a telephone 
network. For example, the local access code, local area code, etc.

dialed number information service (DNIS)
A telephony network feature that provides the number the caller dialed.
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Directory Services 
Also known as LDAP. The service that all other CAD services register with at 
startup. Clients use this service to request information about other CAD 
components.

DNIS
See dialed number information service.

drop
To hang up or disconnect a phone call.

Dropped event
An event which indicates a call is disconnected.

DTMF
See Dual Tone Multi-Frequency.

dual tone multi-frequency (DTMF)
The term for touch tone dialing. In DTMF, when you touch a button on a push 
button pad, it makes a tone which is actually a combination of two tones, one high 
frequency and one low frequency. These are the beeps you hear when you dial a 
phone number.

duplex environment
An operating environment that contains a primary and secondary service. If the 
primary service fails, the secondary service takes over.

E

ECC variable
See expanded call context variable.

enterprise data
A piece of data available to CAD via the Cisco Enterprise Service.

Enterprise Service
See Cisco Enterprise Service.

Ethernet
A local area network standard. Like other LAN technologies, Ethernet is used to 
connect computers, printers, workstations, terminals, servers, and other devices 
within the same building or campus.
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event
An occurrence at the agent desktop. Events include: startup, shutdown, ringing, 
answered, and dropped. 

expanded call context variable
A Unified ICM term for a piece of information about a phone call. It must be 
defined within Unified ICM.

extension
The internal telephone number at the agent desktop.

external application
A software application not belonging to CAD.

H

host
A server connected to a network.

I

ICM
See Unified Intelligent Contact Management.

Install Manager
The program that helps you install CAD on your system.

interactive voice response (IVR)
The use of a computer to interact verbally via a telephone with a caller. The 
computer plays announcements and questions to the caller, and the caller replies 
by entering information via touch tones, a rotary dial, or by speaking. “IVR” and 
“VRU” are often used interchangeably. See voice response unit (VRU).

intercept
An intercept occurs when a supervisor uses the Intercept button to force a 
transfer from an agent to the supervisor. 

Internet protocol (IP)
This protocol specifies the format of packets, also called datagrams, and the 
addressing scheme. Most networks combine IP with a higher-level protocol called 
transport control protocol (TCP), which establishes a virtual connection between a 
destination and a source.
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IP by itself is something like the postal system. It allows you to address a package 
and drop it in the system, but there’s no direct link between you and the recipient. 
TCP/IP, on the other hand, establishes a connection between two hosts so that 
they can send messages back and forth for a period of time.

IP
See Internet protocol.

IP address
The Internet protocol address of a device. 

IP Contact Center (IPCC)
Now known as Cisco Unified Contact Center (CC). A Cisco solution for an IP 
contact center. Its components include IP IVR, Unified CM, and Unified ICM.

IP IVR
Cisco IP IVR is an IP-powered interactive voice response application that provides 
an open and extensible foundation for the creation and delivery of IVR solutions 
via Internet technology. It automates the handling of calls by autonomously 
interacting with users. 

IP phone
A phone that enables you to move multimedia traffic over any network that uses 
Internet protocol (IP).

IP port
In TCP/IP and UDP networks, an endpoint to a logical connection.

IPCC
See IP Contact Center.

IVR
See interactive voice response.

L

LAN
See local area network.

Launch External Application action
An action that starts an external application from within Agent Desktop. 

LCC
See logical contact center.
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LDAP
See lightweight directory access protocol.

LDAP Monitor Service
See Cisco LDAP Monitor Service.

LDAP Service
The service that all other CAD services register with at startup. Clients use this 
service to request information about other CAD components.

License Administration
The application used to update the number of seats purchased in your CAD 
system.

Licensing and Resource Manager Service
See Cisco Licensing and Resource Manager Service.

lightweight directory access protocol (LDAP)
Also known as Directory Services. LDAP defines a standard manner of organizing 
directory hierarchies and a standard interface for clients to access directory 
servers. 

local area network (LAN)
Two or more computers, and other devices, connected by cable, generally within 
the same building or campus.

local extension
See extension.

logical contact center (LCC)
The root of the LDAP tree where CAD applications query for information. It is used 
to segregate logically separate call centers within the LDAP server.

M

macro
A series of prerecorded commands that accomplish a task. 

macro hot key
In Desktop Administrator, the key used to pause the recording of a macro and to 
display the macro recording menu.

macro recorder
The feature in Desktop Administrator used to record a macro.
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N

Normal mode
A display mode in which the interface appears when calls are present and 
minimizes when idle.

P

pane
Section of an application window.

password
A series of alphanumeric characters required to log onto an application or server.

PBX
See private branch exchange.

peripheral ID
The number within the Unified ICM schema that identifies the peripheral device, 
for example, the peripheral interface managers (PIMs) for VRU/IVR, ACD, or 
Unified CM.

phone book
In Agent Desktop, any one of the stored phone directories. Agent Desktop 
contains global phone books as well as an employee phone book.

plain old telephone service (POTS)
The basic service supplying standard telephones, telephone lines, and access to 
the public switched network. 

port
See IP port.

POTS
See plain old telephone service. 

primary server
In a duplex environment, the main server used. If the primary server fails, the 
secondary server takes over.

private branch exchange (PBX)
A private telephone network used within an enterprise. Users of the PBX share a 
certain number of outside lines for making telephone calls external to the PBX. 
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PSTN
See public switched telephone network. 

public network
A network operated by common carriers or telecommunications administrations 
for the provision of circuit switched, packet switched, and leased-line circuits to 
the public.

public switched telephone network (PSTN)
Refers to the world’s collection of interconnected voice-oriented public telephone 
networks, both commercial and government-owned.

R

real-time transport protocol (RTP)
An Internet protocol for transmitting real-time data such as audio and video.

recent call list
A list of an agent’s 100 most recently made phone calls, automatically kept in the 
Dial Pad window. 

Recording & Playback Service
See Cisco Recording & Playback Service.

Recording and Statistics Service
See Cisco Recording and Statistics Service.

Ringing event
The event that occurs when the phone rings. See Event.

RTP
See real-time transport protocol. 

rule
A set of 1–3 data field conditions. If any or all the conditions that constitute the 
rule are evaluated as true, then the rule is met. Rules that are met trigger events 
and actions.

Run Macro action
An action that starts and runs a macro.

scalar variable
An extended call context (ECC) variable that stores a single piece of data.
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screen pop
The delivery of caller-specific information onto the agent’s computer screen 
(“populating” the screen).

S

seat
An instance of Agent Desktop, Supervisor Desktop, or other CAD applications. 

secondary server
In a duplex environment, the backup server. If the primary server fails, the 
secondary server takes over. 

shortcut key
A keyboard key or key combination (also known as a “hotkey” or “keyboard 
accelerator key”) that invokes a particular command that is generally faster to use 
than clicking the mouse through a menu. 

Shutdown event
The event that occurs when Agent Desktop shuts down. See event.

skill
An ability (expertise in a particular type of software, fluency in a foreign language, 
for example) of a contact center agent. Calls can be routed based on agent skills 
(skill-based routing) for better customer service. 

soft phone
A software phone, such as Agent Desktop’s dial pad. 

Startup event
The event that occurs when Agent Desktop starts up. See event. 

status bar
The area on the Agent Desktop or Supervisor Desktop interface that displays the 
status of the agent and of the CAD system.

Stealth mode
A display mode in which an application appears as an icon in the system tray 
unless maximized by the agent.

supervisor
The leader and/or manager of a team of agents.
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Supervisor Desktop
The application used by contact center supervisors to manage agent teams in real 
time.

Sync Service
See Cisco Sync Service.

T

task button
One of a series of up to 10 buttons on the Agent Desktop interface to which 
actions can be assigned. 

team
A group of agents who report to the same supervisor.

Team Performance Message (TPM)
A message the supervisor can create to display in Agent Desktop for a set length 
of time to communicate important information. The TPM can be scrolling or 
non-scrolling, depending on how the supervisor configures it.

threshold
The acceptable amount of time a call can remain at a particular device or call 
center. Caution or warning icons are displayed in the Enterprise Data window 
when thresholds are met or exceeded for a call. 

touch tones
See dual tone multi-frequency. 

TPM
See Team Performance Message.

transfer
A phone switch feature that allows moving a call from one extension to another.

transfer, blind
A transfer in which the active call is transferred to the third party without ensuring 
that the transfer is successful (picked up at the other end).

transfer, supervised
A transfer in which you speak to the third party to whom the call is being 
transferred before connecting the active call, in order to confirm that the transfer 
can be made successfully.
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user ID
An identifier that designates a particular user and that is required to log into an 
application or server.

U

Unified Intelligent Contact Management (Unified ICM)
A Cisco computer telephony integration application that collects data and profiles 
customers from the network to the agent’s desktop, and coordinates the delivery 
of voice and data to a targeted answering resource across the enterprise. Using 
network-provided data, caller-entered digits, and information obtained from a 
customer profile database, Unified ICM determines who is calling and why, and 
routes the call to the appropriate area in the contact center.

user interface
An application’s look and feel to the user. 

V

virtual private network (VPN)
A network created by renting or acquiring some part of someone else’s network (a 
phone company, an Internet provider) and used to communicate between a 
company’s offices.

voice gateway router
A combination of hardware and software that links a POTS telephone network to 
an IP data network. 

voice monitoring
The ability of a supervisor to monitor an agent’s phone conversations without 
being heard and without letting the agent knowing it is happening.

voice over IP (VoIP)
A category of hardware and software that enables people to use Internet protocol 
as the transmission medium for telephone calls.

voice packet
A digitized sample of a voice conversation sent over a network.

voice response unit (VRU)
The computer used to interact verbally via a telephone with a caller. The computer 
plays announcements and questions to the caller, and the caller replies by 
entering information via touch tones, a rotary dial, or by speaking. “VRU” and 
“IVR” are often used interchangeably. See interactive voice response (IVR).
January 16, 2013 253



Cisco Desktop Administrator User Guide
VoIP Monitor Service
See Cisco VoIP Monitor Service.

VoIP
See Cisco VoIP Monitor Service.

VPN
See virtual private network.

VRU
See voice response unit.

W

wild card
Special characters used to represent one or more characters in a string. An 
asterisk (*) represents several characters and a question mark (?) represents a 
single character.

work flow
A sequence of actions that takes place when specific event/rule criteria are met. 

work flow group
A group that shares a common set of work flows. 
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D

Data fields
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E

ECC variables 58
Enterprise Configuration node 55

enterprise data 56
fields 57
layouts 59

VoIP Monitor 62
Enterprise data fields 57

custom fields 58
ECC variables 58

Enterprise data layouts 59
creating new 60
deleting 61
editing 61

Enterprise Data window 102
Call Activity 103
Data 102

F

Feature levels 11

H

High priority chat messages 165

I

Identifying other CDA users 13
Integrated browser. See Browser
Interface 16
IPC receive events 115

IPC Agent Notification action 118
IPC Make Call action 116
IPC Record action 117
IPC Set Variable action 118

L

Login credentials
Agent Desktop 21
Cisco Desktop Administrator 19
Cisco Supervisor Desktop 21

M

Macro actions 153
allowed keystrokes 155
inserting data fields 157, 158
recording a macro 156

recording tips 153
Menu bar 16
Mobile agent monitoring 65
Monitoring

desktop 63
effect of monitoring options 67
mobile agent 65
removing Recording & Playback service 68
removing VoIP Monitor service 68
server 63

Monitoring console 213
how to use 214

N

New features in this release 11
North American dial string format 71

advanced external dialing 76
advanced internal dialing 74
miscellaneous 78
outgoing calls 73
telephone number display 72

O

Outbound Dialer 167

P

Passwords
Agent Desktop 21
Cisco Desktop Administrator 19
Cisco Supervisor Desktop 21

Personnel Configuration node 175
agents 176
supervisors 180
teams 182

Phone books 82
adding entries 84
editing entries 85
enabling/disabling 85
setting up new 84

R

Reason codes 89
assigning global 91
assigning work flow 92
enabling/disabling 92
reserved 90

Record/Monitor notification 98
Recording & Playback service
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removing 68
Remote access 115
Reserved reason codes 90

S

Server monitoring 63
Show Data Fields 110
Starting Cisco Desktop Administrator 13
Supervisors 180

changing password 181
properties 180

Synchronizing Directory Services 53

T

Teams 182
agents 183
skills 184
supervisors 182

Thresholds 103
Toolbar 106

adding and removing buttons 107
associating actions with task buttons 107
changing button hints 108
customizing buttons 108
Desktop Administrator 16
Outbound Dialer 169

U

Unified CCE Configuration node 173
User Interface window 106

Browser setup 113
Miscellaneous tab 112
Remote Access tab 115
Show Data Fields tab 110
Toolbar tab 106

User privileges required 18

V

Variable length dial string format 79
miscellaneous 81
phone number format 80
telephone number display 79

Voice contact work flows 119
data field conditions 123
deleting 126
modifying 125
overview 120
setting up a new work flow 122

voice contact classification 121
wild card searches 125

VoIP Monitor 62
VoIP Monitor service

removing 68

W

Wild card searches 125
Work Flow Configuration node 69
Work flow groups 99

adding 100
deleting 100
renaming 101

Wrap-up data 93
assigning global 96
assigning work flow 96
automatic state changes 97
creating descriptions 94
deleting descriptions 96
editing descriptions 96
enabling/disabling 97
January 16, 2013 257



Cisco Desktop Administrator User Guide
258 January 16, 2013


	Preface
	Introduction
	What’s New in This Release
	Desktop Administrator Feature Levels
	Related CAD Documentation
	Intended Audience


	Getting Started
	Introduction
	Starting Desktop Administrator
	Automated Updates
	The Desktop Administrator Interface
	Toolbars and Menu Bars
	Navigation Tree Pane
	Display Pane Navigation

	User Privileges in Microsoft Windows
	Configuring Passwords
	Configuring a Password in Desktop Administrator
	Client Applications
	Agent Desktop, CAD-BE, and IP Phone Agent User ID, Login Name, and Password
	Supervisor Desktop User ID, Login Name, and Password


	CAD Configuration Setup Utility
	Entering Configuration Data in Initial Mode
	Configuring a Single or Primary Server in a Replicated System
	Configuring a Secondary Server in a Replicated System

	Entering Configuration Data in Update Mode
	CAD Configuration Setup Windows
	CAD-BE Servers
	Unified Communications Manager
	Unified CM SOAP AXL Access
	CTI OS
	CTI OS Security Setup
	CTI Server (Unified CM)
	ICM Admin Workstation Database
	ICM Admin Workstation Distributor
	Recording and Statistics Service Database
	Replication Setup
	Restore Backup Data
	Services Configuration
	SNMP Configuration
	Terminal Services
	VoIP Monitor Service


	Synchronizing Directory Services

	Enterprise Configuration
	Introduction
	Enterprise Data
	Fields
	Layouts
	Custom Layouts


	VoIP Monitor
	Desktop Monitoring
	Cisco VoIP Monitor Service Monitoring
	Devices Displayed in the VoIP Monitor Window

	Mobile Agent Monitoring
	Effect of Monitoring Options on Devices
	Removing the Monitoring or Recording Services from Directory Services


	Work Flow Configuration
	Introduction
	Dial Strings
	North American Dial String Formatting
	Telephone Number Display
	Outgoing Calls
	Advanced Internal Dialing
	Advanced External Dialing
	Miscellaneous

	Variable Length Dial String Formatting
	Telephone Number Display
	Phone Number Format
	Miscellaneous


	Phone Books
	Using the Phone Book Filter
	Creating Phone Books
	Enabling or Disabling Phone Books
	Importing and Exporting Phone Books
	CSV File Format


	Reason Codes
	Assigning Reason Codes
	Enabling or Disabling Reason Codes

	Wrap-up Data
	Creating Wrap-up Data Descriptions
	Assigning Wrap-up Data Descriptions
	Enabling or Disabling Wrap-up Data
	Automatic State Changes

	Record/Monitor Notification
	Work Flow Groups
	Maintaining Work Flow Groups

	Enterprise Data
	Data
	Call Activity

	CAD, CAD-BE, and IP Phone Agent Nodes
	CAD Agent Node
	CAD-BE Agent Node
	IP Phone Agent Node

	User Interface
	Toolbar
	Adding and Removing Toolbar Buttons
	Adding the Cisco Unified Outbound Dialer Toolbar
	Associating Actions with Task Buttons
	Changing a Task Button’s Hint
	Customizing Button Icons

	Show Data Fields
	Configuring and Renaming Data Fields
	Show Duration

	Miscellaneous
	Browser Setup
	Enabling the Integrated Browser
	Enabling Access to Other Websites
	Configuring the Number of Browser Tabs
	Setting Up the Home Page
	Setting Up Work Sites

	Remote Access
	IPC Make Call Action
	IPC High Priority Chat Action
	IPC Record Action
	IPC Agent Notification Action
	IPC Set Variable Action


	Voice Contact Work Flows
	Creating a Voice Contact Work Flow
	Setting Up a New Voice Contact Classification
	Setting Up a New Work Flow
	Data Field Conditions
	Wild Card Searches

	Modifying a Voice Contact Work Flow
	Deleting a Voice Contact Work Flow

	Agent Management Work Flows
	Creating an Agent Management Work Flow

	Creating Actions
	Action Availability
	Adding a New Action
	Editing an Action
	Deleting an Action
	Importing and Exporting Actions
	Creating Agent Notification Actions
	Creating Agent State Actions
	Automated Reason Codes for Agent State Changes

	Creating Call Control Actions
	Creating Delay Actions
	Creating HTTP Actions
	Reserved Characters
	Example of an HTTP Request

	Creating IPC Actions
	Creating Launch External Application Actions
	Creating Run Macro Actions
	Macro Recording Tips
	Allowed Macro Keystrokes
	Recording Macros
	Data Fields

	Creating Set Enterprise Data Actions
	Creating Timer Actions
	Utility Action
	High Priority Chat Messages


	Cisco Unified Outbound Dialer
	Outbound Dialer Actions
	Outbound Dialer Toolbar
	Outbound Dialer Enterprise Data


	Unified CCE Configuration
	Introduction
	Alternate Agent Re-Skilling Websites
	Agent Re-skilling Notes


	Personnel Configuration
	Introduction
	Configuring Agent Properties
	Changing the Agent Login Method
	Configuring the Mobile Agent Mode

	Viewing an Agent’s Properties
	Changing an Agent’s Work Flow Group

	Configuring Supervisor Properties
	Changing a Supervisor’s Password

	Viewing Team Information
	Supervisors
	Agents
	Skills


	Integrating Cisco Unified Presence with CAD
	Introduction
	Accessing Desktop Presence Administrator
	Configuring a Password for Desktop Presence Administrator

	Configuring the Cisco Unified Presence Cluster
	Configuring Contact Lists
	Creating a Contact List
	Finding a Contact List
	Deleting a Contact List
	Editing a Contact List
	Adding SMEs to a Contact List
	Finding Users

	Configuring External Contacts
	Adding External Contacts
	Finding External Contacts
	Editing an External Contact
	Deleting External Contacts

	Configuring Workflow Groups
	Finding a Workflow Group
	Adding a Contact List to a Workflow Group
	Selecting Agents to Appear Offline


	Global Phone Book FAQ
	Cisco Desktop Monitoring Console
	Overview
	Using the Monitoring Console

	Tutorials
	Introduction
	Setting Up an ANI-Based Screen Pop
	Using a Terminal Emulator Package
	Setting Up a Task Button to Transfer to a Specified Number
	Setting Up a Task Button for After-Call Work
	Setting Up a Launch External Application Action
	Using Wild Card Data Conditions

	Glossary
	Index

